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Chapter 1
Overview

The HC(S)08 Build Tools Reference Manual for Microcontrollers describes the compiler
used for the Freescale 8-bit Microcontroller Unit (MCU) chip series. This document
consists of the following sections:

¾ Using Compiler : Describes how to run the compiler
¾ ANSI-C Library Reference : Describes how the compiler uses the ANSI-C library
¾ Appendices : Lists FAQs, global and local configuration file entries, and known C++

issues

NOTE
The technical notes and application notes are placed at the
following location: <CWInstallDir>\MCU\Help\PDF, where,
CWInstallDir is the directory in which the CodeWarrior
software is installed.

This chapter covers the following topics:

¾ Accompanying Documentation
¾ Additional Information Resources

1.1 Accompanying Documentation

The Documentation page describes the documentation included in the CodeWarrior
Development Studio for Microcontrollers v10.x. You can access the Documentation by:

¾ opening the START_HERE.html in <CWInstallDir>\MCU\Help folder,
¾ selecting Help > Documentation from the IDE°s menu bar, or selecting the Start >

Programs > Freescale CodeWarrior > CW for MCU v10.x > Documentation
from the Windows taskbar.
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NOTE
To view the online help for the CodeWarrior tools, first
select Help > Help Contents from the IDE°s menu bar.
Next, select required manual from the Contents list. For
general information about the CodeWarrior IDE and
debugger, refer to the CodeWarrior Common Features
Guide in this folder: <CWInstallDir>\MCU\Help\PDF

1.2 Additional Information Resources

Refer to the documentation listed below for details about the programming languages:

¾ American National Standard for Programming Languages - C, ANSI/ISO 9899-1990
(see ANSI X3.159-1989, X3J11)

¾ The C Programming Language, second edition, Prentice-Hall 1988
¾ C: A Reference Manual, second edition, Prentice-Hall 1987, Harbison and Steele
¾ C Traps and Pitfalls, Andrew Koenig, AT&T Bell Laboratories, Addison-Wesley

Publishing Company, Nov. 1988, ISBN 0-201-17928-8
¾ Data Structures and C Programs, Van Wyk, Addison-Wesley 1988
¾ How to Write Portable Programs in C, Horton, Prentice-Hall 1989
¾ The UNIX Programming Environment, Kernighan and Pike, Prentice-Hall 1984
¾ The C Puzzle Book, Feuer, Prentice-Hall 1982
¾ C Programming Guidelines, Thomas Plum, Plum Hall Inc., Second Edition for

Standard C, 1989, ISBN 0-911537-07-4
¾ DWARF Debugging Information Format, UNIX International, Programming

Languages SIG, Revision 1.1.0 (October 6, 1992), UNIX International, Waterview
Corporate Center, 20 Waterview Boulevard, Parsippany, NJ 07054

¾ DWARF Debugging Information Format, UNIX International, Programming
Languages SIG, Revision 2.0.0 (July 27, 1993), UNIX International, Waterview
Corporate Center, 20 Waterview Boulevard, Parsippany, NJ 07054

¾ System V Application Binary Interface, UNIX System V, 1992, 1991 UNIX Systems
Laboratories, ISBN 0-13-880410-9

¾ Programming Microcontroller in C, Ted Van Sickle, ISBN 1878707140
¾ C Programming for Embedded Systems, Kirk Zurell, ISBN 1929629044
¾ Programming Embedded Systems in C and C ++, Michael Barr, ISBN 1565923545
¾ Embedded C, Michael J. Pont, ISBN 020179523X
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Chapter 2
Using Compiler

This section consists of the following chapters that describe the use and operation of the
compiler:

¾ Introduction : Describes the compiler.
¾ Graphical User Interface : Describes the compiler°s GUI.
¾ Environment : Describes the environment variables.
¾ Files : Describes how the compiler processes input and output files.
¾ Compiler Options : Describes the full set of compiler options.
¾ Compiler Predefined Macros : Lists all predefined macros of the compiler.
¾ Compiler Pragmas : Lists the available pragmas.
¾ ANSI-C Frontend : Describes the ANSI-C implementation.
¾ Generating Compact Code : Describes programming guidelines for the developer to

produce compact and efficient code.
¾ HC(S)08 Backend : Describes code generator and basic type implementation, also

hints about hardware-oriented programming (optimizations and interrupt functions)
specific for HC(S)08.

¾ High-Level Inline Assembler for the HC(S)08 : Describes the HLI assembler for the
HC(S)08 compiler.
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Chapter 3
Introduction
This chapter describes the HC(S)08 Compiler that is part of the CodeWarrior
Development Studio for Microcontrollers V10.x. The Compiler consists of a Frontend,
which is language-dependent, and a Backend, which is hardware-dependent and generates
object code specific to HC08 and HCS08. Chapters one and two describe the
configuration and creation of projects that target HC08 and HCS08 microcontrollers.
Chapter three describes the Compiler in greater detail.

NOTE
The CodeWarrior Development Studio tools actually support
both the HC08 and HCS08 Microcontroller derivatives. For
brevity, this document uses the label HC(S)08 to describe
where the tools support both Microcontrollers derivatives.
Where information is specific to HC08, the label HC08 is used,
and where it is specific to HCS08, the label HCS08 is used.

This chapter consists of the following topics.

¾ Compiler Environment
¾ Designing a Project
¾ Creating and Managing Project Using CodeWarrior IDE
¾ Using Standalone Compiler
¾ Build Tools (Application Programs)
¾ Startup Command-Line Options
¾ Highlights
¾ CodeWarrior Integration of Build Tools
¾ Integration into Microsoft Visual C++ 2008 Express Edition (Version 9.0 or later)
¾ Compiler Modes and Language Extensions
¾ Object-File Formats

3.1 Compiler Environment
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Use the Compiler alone or as a transparent, integral part of the CodeWarrior
Development Studio. Create and compile functional projects in minimal time using the
Eclipse Integrated Development Environment (IDE), or configure the compiler and use it
as a standalone application in a suite of the Build Tool utilities. The Build Tool utilities
include the Linker, Assembler, ROM Burner, Simulator, and Debugger.

In general, a Compiler translates source code, such as C source code files (*.c) and
header (*.h) files, into object code ( *.obj and *.o) files for further processing by a Linker.
The *.c files contain the programming code for the project°s application. The *.h files
either contain data specifically targeted to a particular microcontroller or are function-
interface files. The Linker, under the command of a linker command file, uses the object-
code file to directly generates absolute ( *.abs) files. The Burner uses the *.abs files to
produce S-record ( *.s19 or *.sx) files for programming the ROM.

For information about mixing assembly and C source code in a single project, refer to the
topic, High-Level Inline Assembler for the HC(S)08.

The typical configuration of the Compiler is its association with a project directory and
an editor. The project directory contains all of the environment files required to configure
your development environment and editor allows to write or modify your source files.

NOTE
For information about the other Build Tools, refer to the User
Guides located at <CWInstallDir>\MCU\Help, where CWInstallDir is
the directory in which the CodeWarrior software is installed.

3.2 Designing Project

There are three methods of designing a project:

¾ Use the CodeWarrior IDE to coordinate and manage the entire project ( Creating and
Managing Project Using CodeWarrior IDE ),

¾ Begin project creation with CodeWarrior IDE and use the standalone build tools to
complete the project ( Using Standalone Compiler ), or

¾ Start from scratch, make your project configuration ( *.ini) and layout files for use
with the Build Tools, ( Build Tools (Application Programs) )

NOTE
The Build Tools (including Assembler, Compiler, Linker,
Simulator/Debugger, and others) are a part of the
CodeWarrior Suite and are located in the prog folder in the

Designing Project
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CodeWarrior installation directory. The default location of
this folder is: C:\Freescale\CW MCU V10.x\MCU\prog

3.3 Creating and Managing Project Using CodeWarrior IDE

You can create a Microcontrollers project and generate the basic project files using the
New Bareboard Project wizard in the CodeWarrior IDE.

You can use the CodeWarrior Projects view in the CodeWarrior IDE to manage files in
the project.

This section covers the following topics:

¾ Creating Project using CodeWarrior Project Wizard
¾ Analysis of Groups in CodeWarrior Projects View
¾ Analysis of Files in CodeWarrior Projects View

3.3.1 Creating Project using CodeWarrior Project Wizard

The steps below create an example Microcontrollers project that uses C language for its
source code.

1. Select Start > Programs > Freescale CodeWarrior > CW for MCU v10.x >
CodeWarrior from the WindowsÀ Taskbar.

The Workspace Launcher dialog box appears. The dialog box displays the default
workspace directory. For this example, the default workspace is workspace_MCU.

2. Click OK to accept the default location. To use a workspace different from the
default, click Browse and specify the desired workspace.

The CodeWarrior IDE for Microcontrollers V10.x appears.

3. Select File > New > Bareboard Project from the IDE menu bar.

The Create an MCU Bareboard Project page of the New Bareboard Project
wizard appears.

4. Type the name of the project in the Project name text box. For this example, type
HCS08_project. Click Next.
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The Devices page displaying the supported Microcontrollers appears.

5. Select the desired CPU derivative for the project. For this example, select S08 >
HCS08G Family > MC9S08GT32.

NOTE
Based on the derivative selected in the Devices page, the
step numbering in the page title varies.

6. Click Next.

The Connections page appears.

7. Check the option(s) to specify the hardware probe that you want to use to connect the
workstation to the hardware target. By default, only the P&E USB Multilink
Universal [FX] / USB Multilink is selected.

8. Click Next.

The Languages page appears.

9. Select the programming language options you want to use. For this example, check
the C checkbox.

NOTE
To enable the Absolute Assembly checkbox, clear the C ,
C++ , and Relocatable Assembly checkboxes. This is
because you cannot mix the absolute and relocatable
assembly code in a program. Since the C and C++
compilers generate relocatable assembly, they must be
cleared to allow the use of absolute assembly.

10. Click Next.

The Rapid Application Development page appears.

11. Select the appropriate rapid application development options.
12. Click Next.

The C/C++ Options page appears.

NOTE
As this project uses the C programming language, Small,
None and ANSI startup code options are selected by
default for the memory model, the floating point supported
and the level of startup code, respectively.

13. Select the options appropriate for your project.
14. Click Finish.

Creating and Managing Project Using CodeWarrior IDE
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The wizard automatically generates the startup and initialization files for the specific
microcontroller derivative, and assigns the entry point into your ANSI-C project (the
main() function). The HCS08_project project appears in the CodeWarrior Projects
view in the Workbench window.

NOTE
For detailed descriptions of the options available in the
New Bareboard Project wizard pages, refer to the
Microcontrollers V10.x Targeting Manual.

By default, the project is not built. To do so, select Project > Build Project from the
IDE menu bar. Expand the HCS08_project : FLASH tree control in the CodeWarrior
Projects view to view its supporting directories and files.

NOTE
To configure the IDE, so that it automatically builds the
project when a project is created, select Window >
Preferences to open the Preferences window. Expand the
General node and select Workspace. In the Workspace
panel, check the Build automatically checkbox and click
OK.

Figure 3-1. CodeWarrior Projects View - Displaying HCS08_project

NOTE
The contents of the project directory vary depending upon
the options selected while creating the project.

The view displays the logical arrangement of the files in the HCS08_project project
directory. At this stage, you can safely close the project and reopen it later, if desired.

The following is the list of default groups and files displayed in the CodeWarrior
Projects view.
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¾ Binaries is a link to the generated binary (.abs) files.
¾ FLASH is the directory that contains all of the files used to build the application for

HCS08_project. This includes the source files, the header files, the generated binary
files, the makefiles that manage the build process, and the build settings.

¾ Lib is the directory that contains a C source code file that describes the chosen
Microcontrollers derivative°s registers and the symbols used to access them.

¾ Project_Headers is the directory that contains link to all of the header files (.h) that
support the Microcontrollers derivative, plus any project-specific header files.

¾ Project_Settings group contains the Debugger, Linker_Files and the Startup_Code folders.
The Linker_Files folder stores the linker command file (.prm) and the burner command
file (.bbl). The Startup_Code folder has a C file that initializes the Microcontrollers
stack and critical registers when the program launches. The Debugger folder consists of
any initialization and memory configuration files that prepare the hardware target for
debugging. It also stores the launch configuration used for the debugging session.

¾ Sources contains the source code files for the project. For this example, the wizard has
created only main.c, which contains the main() function.

Examine the project folder that the IDE generates when you create the project. To do so,
right-click the project°s name ( HCS08_project : FLASH) in the CodeWarrior Projects view,
and select Show In Windows Explorer. Windows displays the Eclipse workspace
folder, along with the project folder, HCS08_project, within it.

These are the actual folders and files generated for your project. When working with the
standalone tools, you may need to specify the paths to these files, so you should know
their locations.

There are some files, .project, .cproject, and .cwGeneratedFilesetLog, that store critical
information about the project°s state. The CodeWarrior Projects view does not display
these files, but they should not be deleted.

3.3.2 Analysis of Groups in CodeWarrior Projects View

In the CodeWarrior Projects view, the project files are distributed into five major
groups, each with their own folder within the HCS08_project folder.

The default groups and their usual functions are:

¾ FLASH

The HCS08 group contains all of the files that CodeWarrior uses to build the program.
It also stores any files generated by the build process, such as any binaries ( .o, .obj,
and .abs), and a map file ( .map). CodeWarrior uses this directory to manage the build
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process, so you should not tamper with anything in this directory. This directory°s
name is based on the build configuration, so if you switch to a different build
configuration, its name changes.

¾ Lib

The Lib group contains the C-source code file for the specific Microcontrollers
derivative. For this example, the mc9s08gt32.c file supports the MC9S08GT32 derivative.
This file defines symbols that you use to access the Microcontrollers registers and
bits within a register. It also defines symbols for any on-chip peripherals and their
registers. After the first build, you can expand this file to see all of the symbols that it
defines.

¾ Project_Headers

The Project_Headers group contains the derivative-specific header files required by the
Microcontrollers derivative file in the Lib group.

¾ Project_Settings

The Project_Settings group consists of the following sub-folders:

¾ Debugger

This group contains the files used to manage a debugging session. These are the
debug launch configuration ( .launch), a memory configuration file ( .mem) for the
target hardware, and any TCL script files ( .tcl).

¾ Linker_Files

This group contains the burner file ( .bbl), and the linker command file ( .prm).

¾ Startup_Code

This group contains the source code that manages the Microcontrollers
initialization and startup functions. For HCS08 derivatives, these functions
appear in the source file start08.c.

¾ Sources

This group contains the C source code files. The New Bareboard Project wizard
generates a default main.c file for this group. You can add your own source files to
this folder. You can double-click on these files to open them in the IDE°s editor. You
can right-click the source files and select Resource Configurations > Exclude from
Build to prevent the build tools from compiling them.
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3.3.3 Analysis of Files in CodeWarrior Projects View

Expand the groups in the CodeWarrior Projects view to display all the default files
generated by the New Bareboard Project wizard.

The wizard generates following three C source code files, located in their respective
folders in the project directory:

¾ main.c,

located in <project_directory>\Sources

¾ start08.c, and

located in <project_directory>\Project_Settings\Startup_Code

¾ mc9s08gt32.c

located in <project_directory>\Lib

At this time, the project should be configured correctly and the source code should be
free of the syntactical errors. If the project has been built earlier, you should see a link to
the project°s binary files, and the HCS08 folder in the CodeWarrior Projects view.

To understand what the IDE does while building a project, clean the project and build the
project again:

1. Select Project > Clean from the IDE menu bar.

The Clean dialog box appears.

Figure 3-2. Clean Dialog Box
2. Select the Clean projects selected below option and check the project you want to

build again.
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3. Click OK .

The Binaries link disappears, and the FLASH folder is deleted.

4. To build the project, right-click the project and select Build Project .

The Console view displays the statements that direct the build tools to compile and
link the project. The Binaries link appears, and so does the FLASH folder.

During a project build, the C source code is compiled, the object files are linked together,
and the CPU derivative°s ROM and RAM area are allocated by the linker according to the
settings in the linker command file. When the build is complete, the FLASH folder contains
the HCS08_project.abs file.

The Linker Map file, HCS08_project.map, indicates the memory areas allocated for the
program.

To examine the source file, main.c, do the following:

¾ Double click the main.c file in the Sources group.

The IDE opens the main.c file in the editor area.

Figure 3-3. Default main.c File

Use the integrated editor to write your C source files ( *.c and *.h) and add them to your
project. During development, you can test your source code by building and simulating/
debugging your application.
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3.4 Using Standalone Compiler

You can use the HC(S)08 Compiler as a standalone compiler. In this section, we will
create a new project directory using some of the previously created files, and build the
application.

NOTE
Although it is possible to create and configure a project from
scratch using the standalone Build Tools, it is easier and faster
to create, configure, and manage your project using the
CodeWarrior Projects wizard.

This section covers the following topics:

¾ Configuring the Compiler
¾ Selecting Input Files
¾ Compiling C Source Code Files

3.4.1 Configuring the Compiler

Build tools use a tool directory for configuring and locating their generated files. For the
Microcontrollers V10.x build tools, the tool directory is the prog folder, and is located in
the <CWInstallDir>\MCU folder, where CWInstallDir is the directory in which the CodeWarrior
software is installed.

Build tools require information from the configuration files. There are two types of
configuration data:

¾ Global

Global data is common to all build tools and projects, and includes data for each
build tool, such as the directory path for recent project listings. All tools may store
some global data in a mcutools.ini file. Each tool looks for this file in the tool
directory first, then in the Microsoft Windows installation directory (for example, C:
\WINDOWS). The following listing shows the locations for the global configuration file.

Listing: Locations for Global Configuration File

<CWInstallDir>\MCU\prog\mcutools.ini - #1 priority
C:\WINDOWS\mcutools.ini - used if there is no mcutools.ini file above
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The Compiler uses the initialization file in the prog folder if you start the tool from
the prog folder.

That is, <CWInstallDir>\MCU\prog\mcutools.ini, where, CWInstallDir is the directory in
which the CodeWarrior software is installed.

The Compiler uses the initialization file in the Windows directory if the tool is started
outside the prog folder. That is, C:\WINDOWS\mcutools.ini

NOTE
For information about entries for the global configuration
file, refer to the Global Configuration File Entries in the
Appendices.

¾ Local

Local data files can be used by any build tool for a particular project. These files are
typically stored in a project folder. For information about local configuration file
entries, refer to the Local Configuration File Entries in the Appendices.

To configure the Compiler, proceed as follows:

1. Double-click chc08.exe file, which is located in the <CWInstallDir>\MCU\prog folder.

The HC08 Compiler window appears.

Figure 3-4. HC08 Compiler Window
2. Read the tips, if you want to, and click Close.

The Tip of the Day dialog box closes.

3. Select File > New > Default Configuration from the HC08 Compiler menu bar.

Chapter 3 Introduction

CodeWarrior Development Studio for Microcontrollers V10.x HC(S)08 Build Tools Reference Manual, Rev.
10.6, 01/2014

Freescale Semiconductor, Inc. 65



NOTE
You can also use an existing configuration file. Select File
> Load Configuration to open the existing configuration
file.

4. Select File > Save Configuration (or Save Configuration As ) from the HC08
Compiler menu bar.

The Saving Configuration as dialog box appears.

5. Browse and select the folder where you want to save the configuration. In this
example, folder X15 is used to save the configuration.

Figure 3-5. Saving Configuration as Dialog Box
6. Click Save.

The folder becomes the project directory. The project directory folder is often
referred as current directory.

Figure 3-6. Compiler s Current Directory Switches to your Project Directory
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The project directory folder now contains the newly-created project.ini configuration
file. The project configuration file contains a copy of the [CHC08_Compiler] section
of the project.ini file located in the prog folder. If a build tool modifies any project
option, the changes are specified in appropriate section of the project configuration
file.

NOTE
Option changes made to the project.ini file in the prog
folder apply to all projects. Recall that this file stores the
global tool options.

7. Select Compiler > Options > Options from the HC08 Compiler menu bar.

The HC08 Compiler Option Settings dialog box appears.

Figure 3-7. HC08 Compiler Option Settings Dialog Box
8. Select the Output tab.
9. Check the Generate Listing File checkbox.

10. Check the Object File Format checkbox and select ELF/DWARF 2.0 from the
drop-down list that appears for the Object File Format checkbox.

11. Click OK.

The HC08 Compiler Option Settings dialog box closes.

12. Save the changes to the configuration by either:

Chapter 3 Introduction

CodeWarrior Development Studio for Microcontrollers V10.x HC(S)08 Build Tools Reference Manual, Rev.
10.6, 01/2014

Freescale Semiconductor, Inc. 67



¾ selecting File > Save Configuration (Ctrl + S ), or
¾ clicking Save on the toolbar.

The compiler is configured.

NOTE
For more information about configuring the Compiler options,
refer to the Graphical User Interface chapter.

3.4.2 Selecting Input Files

The project does not contain any source code files at this point. Copy and paste the C
source code (*.c) and header (*.h) files from the previous project, HCS08_project, to save
time.

1. Copy the Sources folder from the HCS08_project folder and paste it into the X15 project
folder.

2. Copy the Project_Headers folder from the HCS08_project folder and paste it into the X15
project folder.

3. Copy and paste the HCS08_project project°s Lib folder into the X15 project folder.
4. In the X15 folder, create a new folder Project_Settings. Copy and paste the Startup_Code

folder from the HCS08_project\Project_Settings folder into the X15\Project_Settings
folder.

Now there are five items in the X15 project folder, as shown in the figure below:

¾ the project.ini configuration file
¾ the Sources folder, which contains the main.c source file
¾ the Project_Headers folder, which contains:

¾ the derivative.h header file, and
¾ the mc9s08gt32.h header file

¾ the Lib folder, which contains the mc9s08gt32.h source file
¾ the Project_settings\Startup_Code folder, which contains the start up and initialization

file, start08.c
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Figure 3-8. Folders and Files in X15 Project Folder

3.4.3 Compiling C Source Code Files

Now compile the start08.c file.

1. Select File > Compile from the HC08 Compiler menu bar.

The Select File to Compile dialog box appears.

Figure 3-9. Select File to Compile Dialog Box
2. Browse to the Project_settings\Startup_Code folder in the project directory.
3. Select the start08.c file.
4. Click Open.

The start08.c file begins compiling, as shown in the following figure. In this case, the
file fails to compile.
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Figure 3-10. Results of Compiling start08.c File

The HC08 Compiler window provides information about the compilation process,
and generates the error messages if the compilation fails. In this case, the C5200:
 FileName° file not found error message appears twice, once for start08.h and once for
non_bank.sgm.

5. Right-click the text above the error message.

A context menu appears.
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Figure 3-11. HC08 Compiler Window - Context Menu
6. Select Help on "<FileName> file not found" from the context menu.

The C5200:  FileName° file not found error message appears.
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Figure 3-12. C5200 Error Message Help

The Tips section in the help for the C5200 error states that the correct paths and
names for the source files must be specified. The following folder contains both the
missing files, start08.h and non_bank.sgm:

<CWInstallDir>\MCU\lib\hc08c\include

NOTE
The #include preprocessor directive for the start08.h file and
the non_bank.sgm file appears on line 21 and 31 of the
start08.c file, respectively.

To resolve the error, modify the compiler configuration so that it can locate the missing
files.

1. Select File > Configuration from the HC08 Compiler menu bar.

The Configuration dialog box appears.
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2. Select the Environment tab in the Configuration dialog box.
3. Select Header File Path and click [...] button.

The Browse for Folder dialog box appears.

NOTE
The environment variable associated with the Header File
Path is the LIBPATH or LIBRARYPATH:  include <File>°
Path variable. The Compiler uses a hierarchy to search for
files. Refer to the File Processing.

4. In the Browse for Folder dialog box, navigate to the missing start08.h file in the
<CWInstallDir>\MCU\lib\hc08c\include folder, where CWInstallDir is the directory in
which the CodeWarrior software is installed.

Figure 3-13. include Subfolder Containing start08.h and non_bank.sgm Files
5. Click OK.
6. Click Add.

The specified path appears in the lower panel.

7. Click OK.

An asterisk ( * ) now appears in the HC08 Compiler window°s title bar, indicating
that the configuration file contains unsaved changes.

8. Click Save on the toolbar to save the configuration modifications. Alternatively,
select File > Save Configuration from the HC08 Compiler menu bar.

NOTE
If you do not save the configuration, the compiler reverts to
the last-saved configuration when the program is
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relaunched. The asterisk ( * ) disappears when the file is
saved.

Now that you have specified the paths to the missing files, you can try again to compile
the start08.c file.

1. Select File > Compile from the HC08 Compiler menu bar.
2. Navigate to the Project_settings\Startup_Code folder in the project directory.
3. Select start08.c.
4. Click Open.

The HC08 Compiler window indicates successful compilation of the start08.c file and
displays following results:

¾ The start08.c file involved the use of four header files.
¾ The Compiler generated an assembler listing file ( start08.lst) for the start08.c file.
¾ The Compiler generated an object file ( start08.o) in the Sources folder, using the

ELF/DWARF 2.0 format.
¾ The Code Size was 149 bytes.
¾ The compiler created six global objects and the Data Size was 6 bytes in RAM.
¾ There were 0 errors, 0 warnings, and 0 information messages.

Tip
Clear the Compiler window at any time by selecting View
> Log > Clear Log from the HC08 Compiler menu bar.

Now compile the main.c file:

1. Select File > Compile from the HC08 Compiler menu bar.
2. Navigate to the Sources folder.
3. Select the main.c file.
4. Click Open.

The C source code file, main.c, fails to compile, as the compiler can locate only three of
the four header files required. It could not find the derivative.h header file and generates
another C5200 error message.

The derivative.h file is in the Project_Headers folder in the X15 project folder, so add
another header path to resolve the error.

1. Select File > Configuration from the HC08 Compiler menu bar.

The Configuration dialog box appears.

2. Select the Environment tab in the Configuration dialog box.
3. Select Header File Path and click the [...] button.
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The Browse for Folder dialog box appears.

4. In the Browse for Folder dialog box, navigate and select the Project_Headers folder.
5. Click OK.

The Browse for Folder dialog box closes.

6. Click Add.

The selected path appears in the lower panel.

7. Click OK.

If there is no other missing header file included in the derivative.h file, you are ready
to compile the main.c file.

8. Select File > Compile from the HC08 Compiler window menu bar.
9. Select main.c in the Sources folder. You can also select a previously compiled C source

code file.
10. Click Open to compile the file.

The message "*** 0 error(s)," indicates that main.c compiles without errors. Save the
changes in the project configuration.

The compiler places the object file in the Sources folder, and generates output listing files
in the project folder. The binary object files and the input modules have identical names
except for the extension used. Any assembly output files generated for each C source
code file is similarly named.

Figure 3-14. Project Directory after Successful Compilation

At this time, only two of the three C source code files have been compiled. Locate the
remaining C source code file, MC9S08GT32.c, in the Lib folder of the current directory, X15.

The compiler places the object-code files it generates in the same folder that contains the
C source code files. However, you can also specify a different location for the object-
code files.
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To redirect the object-code file for the MC9S08GT32.c file to another folder, modify the
compiler configuration so that when the MC9S08GT32.c file is compiled, the object code file
goes into a different folder. For more information, refer to the OBJPATH: Object File
Path).

1. Using Windows Explorer, create a new folder in the current directory and name it
ObjectCode.

2. Select File > Configuration from the HC08 Compiler menu bar.
3. Select the Environment tab and select Object Path.
4. Click Browse.

The Browse for Folder dialog box appears.

5. In the Browse for Folder dialog box, browse for and select the ObjectCode folder.
6. Click OK.

The Browse for Folder dialog box closes.

7. Click Add.

The new object path appears in the lower pane.

Figure 3-15. Adding OBJPATH
8. Click OK.

The Configuration dialog box closes.

9. Press Ctrl + S to save the settings.
10. Select File > Compile from the HC08 Compiler menu bar.
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The Select File to Compile dialog box appears.

11. Browse for the C source code file in the Lib subfolder of the project folder.

Figure 3-16. Compiling Source File in Lib Folder
12. Click Open.

The selected file compiles.

Figure 3-17. Successful Compilation of File in Lib Folder

The Compiler log states that the object code file, MC9S08GT32.o, is created in the ObjectCode
folder, as specified. Save the project configuration again in case you wish to recompile
any of the C source code files in future.

Tip
Move the other two object code files to the ObjectCode folder so
that all object code files for the project are in the same place.
This makes project management easier.
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The haphazard builds of this project are intentionally designed to illustrate what happens
if paths are not configured properly while compiling a project using the Compiler tool.
The header files may be included by either C source or other header files. The lib folder
in the CodeWarrior installation directory contains derivative-specific header and other
files for Microcontrollers projects.

When you build another project with the Build Tool Utilities, make sure that the settings
for the input and output files are done in advance.

Now that the project°s object code files are available, you can use the linker build tool,
linker.exe, together with an appropriate *.prm file, to link these object-code files with the
library files and create an *.abs executable output file.

Refer to the Linker section in the Build Tool Utilities Manual for details. However, the
project set up and configuration is faster and easier using the New Bareboard Project
wizard.

3.5 Build Tools (Application Programs)

The standalone build tools (application programs) can be found in the \prog folder, which
is located within the folder where the CodeWarrior software is installed.

<CWInstallDir>\MCU\prog

where CWInstallDir is the directory in which the CodeWarrior software is installed.

The following table lists the build tools used for C programming and generating an
executable program.

Table 3-1. Build Tools

Build Tool Description

ahc 08.exe Freescale HC(S)08/RS08 assembler

burner.exe Batch and interactive burner application that generates S-
records

chc 08.exe Freescale HC(S)08 compiler

decoder.exe Decoder tool to generate assembly listings

libmaker.exe Librarian tool to build libraries

linker.exe Link tool to build applications (absolute files)

maker.exe Make tool to rebuild the program automatically

piper.exe Utility to redirect messages to stdout
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NOTE
There may be some additional tools in your \prog folder or you
may find some tools missing, depending on your license
configuration.

3.6 Startup Command-Line Options

Startup command-line options are special tool options that are specified at tool startup,
that is while launching the tool. They cannot be specified interactively.

Some of these options open special dialog boxes, such as the Configuration and Message
dialog boxes, for a build tool.

The following table lists the Startup command-line options and their description:

Table 3-2. Startup Command-line Options

Startup Command-line Option Description

-Prod Specifies the current project directory or file. For more
information, refer to the topic, -Prod: Specify Project File at
Startup.

ShowOptionDialog Opens the Option dialog box.

ShowMessageDialog Opens the message dialog box.

ShowConfigurationDialog Opens the File > Configuration dialog box.

ShowBurnerDialog Opens the Burner dialog box.

ShowSmartSliderDialog Opens the CompilerSmart Control dialog box. This is
compiler option.

ShowAboutDialog Opens the About dialog box.

NOTE
For more information on the build tool dialog boxes, refer to
the Graphical User Interface chapter.

Listing: Example of -Prod Command-Line Option
C:\Freescale\CW MCU V10.x\MCU\prog>linker.exe -
Prod=C:\Freescale\demo\myproject.pjt

Listing: Example of Storing Options in Current Project Settings File
C:\Freescale\CW MCU V10.x\MCU\prog>linker.exe -
ShowOptionDialog -Prod=C:\demos\myproject.pjt
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3.7 Highlights

The CodeWarrior build tools provide the following features:

¾ Powerful User Interface
¾ Online Help
¾ Flexible Type Management
¾ Flexible Message Management
¾ 32-bit Application
¾ Support for Encrypted Files
¾ High-Performance Optimizations
¾ Conforms to ANSI/ISO 9899-1990

3.8 CodeWarrior Integration of Build Tools

All required CodeWarrior plug-ins are installed together with the Eclipse IDE. The
program that launches the IDE with the CodeWarrior tools, cwide.exe, is installed in the
eclipse directory (by default, C:\Freescale\CW MCU V10.x\eclipse). The plug-ins are installed
in the eclipse\plugins directory.

This section covers the following topics:

¾ Combined or Separated Installations
¾ HCS08 Compiler Build Settings Panels
¾ CodeWarrior Tips and Tricks

3.8.1 Combined or Separated Installations

The installation script enables you to install several CPUs along one single installation
path. This saves disk space and enables switching from one processor family to another
without leaving the IDE.

NOTE
It is possible to have separate installations on one machine.
There is only one point to consider: The IDE uses COM files,
and for COM the IDE installation path is written into the
Windows Registry. This registration is done in the installation
setup. However, if there is a problem with the COM registration
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using several installations on one machine, the COM
registration is done by starting a small batch file located in the
bin (by default C:\Freescale\CW MCU V10.x\MCU\bin) directory. To
do this, start the regservers.bat batch file.

3.8.2 HCS08 Compiler Build Settings Panels

The following sections describe the settings panels that configure the HC(S)08 Compiler
build tool options. These panels are part of the project°s build properties settings, which
are managed in the Properties window. To access these panels, proceed as follows:

1. Select the project for which you want to set the build properties, in the CodeWarrior
Projects view.

2. Select Project > Properties from the IDE menu bar.

The Properties for <project> dialog box appears.

3. Expand the C/C++ Build tree control and select Settings.

The various settings for the build tools are displayed in the right panel. If not, select
the Tool Settings tab.

The options are grouped by tool, such as Messages , Host , General , Disassembler ,
Linker , Burner , HCS08Compiler , HCS08 Assembler and Preprocessor options.
Depending on the build properties you wish to configure, select the appropriate option in
the Tool Settings tab page.

NOTE
For information about other build properties panels, refer to the
Microcontrollers V10.x Targeting Manual.

The following listed are the build properties panels for the HC(S)08 Compiler.

Table 3-3. Build Properties Panels for HC(S)08 Compiler
Build Tool Build Properties Panels

HCS08 Compiler HCS08 Compiler > Output

HCS08 Compiler > Output > Configure Listing File

HCS08 Compiler > Output > Configuration for list of included
files in make format

HCS08 Compiler > Input

HCS08 Compiler > Language

HCS08 Compiler > Language > CompactC++ features

Table continues on the next page...
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Table 3-3. Build Properties Panels for HC(S)08 Compiler (continued)

Build Tool Build Properties Panels

HCS08 Compiler > Host

HCS08 Compiler > Code Generation

HCS08 Compiler > Messages

HCS08 Compiler > Messages > Disable user messages

HCS08 Compiler > Preprocessor

HCS08 Compiler > Type Sizes

HCS08 Compiler > General

HCS08 Compiler > Optimization

HCS08 Compiler > Optimization > Tree optimizer

HCS08 Compiler > Optimization > Optimize Library Function

HCS08 Compiler > Optimization > Branch Optimizer

HCS08 Compiler > Optimization > Peephole Optimization

3.8.2.1 HCS08 Compiler

Use this panel to specify the command, options, and expert settings for the HC(S)08
compiler. Additionally, the HCS08 Compiler tree control includes the general, include
file search path settings. The following figure shows the HC(S)08 Compiler settings.

Figure 3-18. Tool Settings - HCS08 Compiler

The following table lists the HSC08 Compiler panel options for HC(S)08 Compiler.

Table 3-4. Tool Settings - HCS08 Compiler Options
Option Description

Command Shows the location of the linker executable file. Default value
is: "${HC08Tools}/chc08"

All options Shows the actual command line the compiler will be called
with.

Table continues on the next page...
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Table 3-4. Tool Settings - HCS08 Compiler Options (continued)

Option Description

Expert Settings

Command line pattern

Shows the expert settings command line parameters; default
is ${COMMAND} ${FLAGS}${OUTPUT_FLAG}$
{OUTPUT_PREFIX}${OUTPUT}${INPUTS}

3.8.2.2 HCS08 Compiler > Output

Use this panel to control how the compiler generates the output file, as well as error and
warning messages. You can specify whether to allocate constant objects in ROM,
generate debugging information, and strip file path information. The following figure
shows the Output panel.

Figure 3-19. Tool Settings - HCS08 Compiler > Output

The following table lists the Output panel options for HC(S)08 compiler.

Table 3-5. Tool Settings - HCS08 Compiler > Output Options
Option Description

Allocate CONST objects in ROM (-Cc) Refer to the -Cc: Allocate Const Objects into ROM topic.

Encrypt Files (e.g. %f.e%e) (-Eencrypt) Refer to the -Eencrypt: Encrypt Files topic.

Encryption key (-EKey) Refer to the -Ekey: Encryption Key topic.

Object File Format Refer to the -F (-Fh, -F1, -F1o, -F2, -F2o,-F6, or -F7): Object-
File Format topic.

General Assembler Include File (e.g. %f.inc) (-La) Refer to the -La: Generate Assembler Include File topic.

Generate Listing File (e.g. %n.lst) (-Lasm) Refer to the -Lasm: Generate Listing File topic.

Table continues on the next page...
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Table 3-5. Tool Settings - HCS08 Compiler > Output Options (continued)

Option Description

Log predefined defines to file (e.g. predef.h) (-Ldf) Refer to the -Ldf: Log Predefined Defines to File topic.

List of included files to   .inc° file (-Li) Refer to the -Li: List of Included Files to ".inc" File topic.

Write statistic output to file (e.g. logfile.txt) (-Ll) Refer to the -Ll: Write Statistics Output to File topic.

List of included files in make format (e.g. make.txt ) (-Lm) Refer to the -Lm: List of Included Files in Make Format topic.

Append object file name to list (e.g. obklist.txt ) (-Lo) Refer to the -Lo: Append Object File Name to List (enter
[<files>]) topic.

Preprocessor output ( e.g. %n.pre ) (-Lp) Refer to the -Lp: Preprocessor Output topic.

Strip path information (-NoPath) Refer to the -NoPath: Strip Path Info topic.

3.8.2.3 HCS08 Compiler > Output > Configure Listing File

Use this panel to configure the listing files for HC(S)08 Compiler. The following figure
shows the Configure Listing File panel.

Figure 3-20. Tool Settings - HCS08 Compiler > Output > Configure Listing File

NOTE
For information about the description of the options appearing
in the Configure Listing File panel for HC(S)08 Compiler,
refer to the -Lasmc: Configure Listing File topic.

3.8.2.4 HCS08 Compiler > Output > Configuration for list of included
files in make format
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Use this panel to configure the list of included files in make format for HC(S)08
Compiler to generate the output.

The following figure shows the Configuration for list of included files in make format
panel.

NOTE
For information about the description of the options appearing
in the Configuration for list of included files in make format
panel for HC(S)08 Compiler, refer to the -LmCfg:
Configuration for List of Included Files in Make Format (option
-Lm) topic.

3.8.2.5 HCS08 Compiler > Input

Use this panel to specify file search paths and any additional include files the HCS08
Compiler should use. You can specify multiple search paths and the order in which you
want to perform the search.

The IDE first looks for an include file in the current directory, or the directory that you
specify in the INCLUDE directive. If the IDE does not find the file, it continues searching the
paths shown in this panel. The IDE keeps searching paths until it finds the #include file or
finishes searching the last path at the bottom of the Include File Search Paths list. The
IDE appends to each path the string that you specify in the INCLUDE directive.

NOTE
The IDE displays an error message if a header file is in a
different directory from the referencing source file. Sometimes,
the IDE also displays an error message if a header file is in the
same directory as the referencing source file.

For example, if you see the message Could not open source file myfile.h, you must add the
path for myfile.h to this panel. The following figure shows the Input panel.
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Figure 3-21. Tool Settings - HCS08 Compiler > Input

The following table lists the Input panel options for HC(S)08 Compiler.

Table 3-6. Tool Settings - HCS08 Compiler > Input Options

Option Description

Filenames are clipped to DOS length ( -!) Refer to the -!: Filenames are clipped to DOS Length topic.

Include File Path ( -I) Refer to the -I: Include File Path topic.

Additional Include Files ( -AddIncl) Refer to the -AddIncl: Additional Include File topic.

Include files only once ( -Pio) Refer to the -Pio: Include Files Only Once topic.

The following table lists and describes the toolbar buttons that help work with the file
paths.

Table 3-7. Include File Path (-I) Toolbar Buttons
Button Description

Add - Click to open the Add directory path dialog box and
specify location of the library you want to add.

Delete - Click to delete the selected library path.

Table continues on the next page...
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Table 3-7. Include File Path (-I) Toolbar Buttons (continued)

Button Description

Edit - Click to open the Edit directory path dialog box and
update the selected path.

Move up - Click to move the selected path one position
higher in the list.

Move down - Click to move the selected path one position
lower in the list.

The following figure shows the Add directory path dialog box.

Figure 3-22. Tool Settings - HCS08 Compiler > Input - Add Directory Path Dialog Box

The following figure shows Edit directory path dialog box.

Figure 3-23. Tool Settings - HCS08 Compiler > Input - Edit Directory Path Dialog Box

The buttons in the Add directory path and Edit directory path dialog boxes help work
with the paths.

¾ OK- Click to confirm the action and exit the dialog box.
¾ Cancel- Click to cancel the action and exit the dialog box.
¾ Workspace - Click to display the File selection dialog box and specify the path. The

resulting path, relative to the workspace, appears in the appropriate list.
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¾ File system - Click to display the Browse For Folder dialog box and specify the
path. The resulting path appears in the appropriate list.

¾ Variables - Click to display the Select build variable dialog box. The resulting path
appears in the appropriate list.

The following table lists and describes the toolbar buttons that help work with the search
paths.

Table 3-8. Additional Include Files (-AddIncl) Toolbar Buttons

Button Description

Add - Click to open the Add file path dialog box and specify
location of the library you want to add.

Delete - Click to delete the selected library path.

Edit - Click to open the Edit file path dialog box and update
the selected path.

Move up - Click to move the selected path one position
higher in the list.

Move down - Click to move the selected path one position
lower in the list.

The following figure shows Add file path dialog box.

Figure 3-24. Tool Settings - HCS08 Compiler > Input - Add File Path Dialog Box

The following figure shows Edit file path dialog box.
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Figure 3-25. Tool Settings - HCS08 Compiler > Input - Edit File Path Dialog Box

The buttons in the Add file path and Edit file path dialog boxes help work with the
paths.

¾ OK- Click to confirm the action and exit the dialog box.
¾ Cancel- Click to cancel the action and exit the dialog box.
¾ Workspace - Click to display the File selection dialog box and specify the path. The

resulting path, relative to the workspace, appears in the appropriate list.
¾ File system - Click to display the Open dialog box and specify the path. The

resulting path appears in the appropriate list.
¾ Variables - Click to display the Select build variable dialog box. The resulting

variable appears in the path list.

3.8.2.6 HCS08 Compiler > Language

Use this panel to specify code-generation and symbol-generation options for HC(S)08
Compiler.

The following figure shows the Language panel.

Figure 3-26. Tool Settings - HCS08 Compiler > Language

The following table lists the Language panel options for HC(S)08 Compiler.
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Table 3-9. Tool Settings - HCS08 Compiler > Language Options

Option Description

Strict ANSI ( -Ansi) Refer to the -Ansi: Strict ANSI topic.

C++ Refer to the -C++ (-C++f, -C++e, -C++c): C++ Support topic.

Cosmic compatibility mode for space modifiers @near, @far,
and @tiny ( -Ccx)

Refer to the -Ccx: Cosmic Compatibility Mode for Space
Modifiers and Interrupt Handlers topic.

Bigraph and trigraph support ( -Ci) Refer to the -Ci: Bigraph and Trigraph Support topic.

C++ comments in ANSI-C ( -Cppc) Refer to the -Cppc: C++ Comments in ANSI-C topic.

Propagate const and volatile qualifiers for structs ( -
Cq)

Refer to the -Cq: Propagate const and volatile Qualifiers for
Structs topic.

Conversion from   const T*° to   T*° ( -Ec) Refer to the -Ec: Conversion from °const T*° to °T*° topic.

Do not pre-process escape sequences in strings with
absoluted DOS paths ( -Pe)

Refer to the -Pe: Do Not Preprocess Escape Sequences in
Strings with Absolute DOS Paths topic.

3.8.2.7 HCS08 Compiler > Language > CompactC++ features

Use this panel to specify the options to disable the CompactC++ features for the HC(S)08
Compiler. The following figure shows the CompactC++ features panel.

Figure 3-27. Tool Settings - HCS08 Compiler > Language > CompactC++ Features

NOTE
For information about the description of the options appearing
in the CompactC++ features panel for HC(S)08 Compiler,
refer to the

3.8.2.8 HCS08 Compiler > Host

Use this panel to specify the host options for HC(S)08 Compiler. The following figure
shows the Host panel.
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Figure 3-28. Tool Settings - HCS08 Compiler > Host

The following table lists and describes the options for Host panel.

Table 3-10. Tool Settings - HCS08 Compiler > Host Options

Option Description

Set environment variable ( -Env) Refer to the -Env: Set Environment Variable topic.

Borrow license feature ( -LicBorrow) Refer to the -LicBorrow: Borrow License Feature topic.

Wait until a license is available from floating license server ( -
LicWait)

Refer to the -LicWait: Wait until Floating License is Available
from Floating Li- cense Server topic.

Application Standard Occurrence Refer to the -View: Application Standard Occurrence topic.

3.8.2.9 HCS08 Compiler > Code Generation

Use this panel to specify code-generation and symbol-generation options for the HC(S)08
Compiler. The following figure shows the Code Generation panel.

Figure 3-29. Tool Settings - HCS08 Compiler > Code Generation

The following table lists the Code Generation panel options for HC(S)08 compiler.
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Table 3-11. Tool Settings - HCS08 Compiler > Code Generation Options

Option Description

Bit field byte allocation ( -BfaB[MS|LS]) Refer to the -BfaB: Bitfield Byte Allocation topic.

Bit field gap limit ( -BfaGapLimitBits) Refer to the -BfaGapLimitBits: Bitfield Gap Limit topic.

Bit field type size reduction Refer to the -BfaTSR: Bitfield Type Size Reduction topic.

Maximum load factor for switch tables ( 0-100) ( -
CswMaxLF)

Refer to the -CswMaxLF: Maximum Load Factor for Switch
Tables topic.

Minimum number of labels for switch tables ( -CswMinLB) Refer to the -CswMinLB: Minimum Number of Labels for
Switch Tables topic.

Minimum load factor for switch tables ( 0-100) ( -CswMinLF) Refer to the -CswMinLF: Minimum Load Factor for Switch
Tables topic.

Minimum number of labels for switch search tables ( -
CswMinSLB)

Refer to the -CswMinSLB: Minimum Number of Labels for
Switch Search Tables topic.

Switch off code generation ( -Cx) Refer to the -Cx: Switch Off Code Generation topic.

Do not use CLR for volatile variables in the direct page ( -
NoClrVol)

Refer to the -NoClrVol: Do not use CLR for volatile variables
in the direct page topic.

Qualifier for virtual table pointers ( -Qvtp) Refer to the -Qvtp: Qualifier for Virtual Table Pointers topic.

Use IEEE32 for double (default is IEEE64) Refer to the -Fd: Double is IEEE32 topic.

Assume HLI code saves modified registers Refer to the -Asr: It is Assumed that HLI Code Saves Written
Registers topic.

3.8.2.10 HCS08 Compiler > Messages

Use this panel to specify the messages options for the HC(S)08 Compiler. The following
figure shows the Messages panel.

CodeWarrior Integration of Build Tools

CodeWarrior Development Studio for Microcontrollers V10.x HC(S)08 Build Tools Reference Manual, Rev.
10.6, 01/2014

92 Freescale Semiconductor, Inc.



Figure 3-30. Tool Settings - HCS08 Compiler > Messages

The following table lists and describes the options for Messages panel.

Table 3-12. Tool Settings - HCS08 Compiler > Messages Options
Option Description

Don°t print INFORMATION messages ( -W1) Refer to the -W1: Don°t Print Information Messages topic.

Don°t print INFORMATION or WARNING messages ( -W2) Refer to the -W2: Do not Print INFORMATION or WARNING
Messages topic.

Create err.log Error file Refer to the -WErrFile: Create "err.log" Error File topic.

Cut file names in Microsoft format to 8.3 ( -Wmsg8x3) Refer to the -Wmsg8x3: Cut Filenames in Microsoft Format to
8.3 topic.

Set message file format for batch mode Refer to the -WmsgFb (-WmsgFbv, -WmsgFbm): Set
Message File Format for Batch Mode topic.

Message Format for batch mode (e.g. %"%f%e%"(%l): %K
%d: %m) ( -WmsgFob)

Refer to the -WmsgFob: Message Format for Batch Mode
topic.

Message Format for no file information (e.g. %K %d: %m) ( -
WmsgFonf)

Refer to the -WmsgFonf: Message Format for No File
Information topic.

Message Format for no position information (e.g. %"%f%e%":
%K %d: %m) ( -WmsgFonp)

Refer to the -WmsgFonp: Message Format for No Position
Information topic.

Create Error Listing File Refer to the -WOutFile: Create Error Listing File topic.

Maximum number of error messages ( -WmsgNe) Refer to the -WmsgNe: Maximum Number of Error Messages
(enter <number>) topic.

Maximum number of information messages ( -WmsgNi) Refer to the -WmsgNi: Maximum Number of Information
Messages (enter <number>) topic.

Table continues on the next page...
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Table 3-12. Tool Settings - HCS08 Compiler > Messages Options (continued)

Option Description

Maximum number of warning messages ( -WmsgNw) Refer to the -WmsgNw: Maximum Number of Warning
Messages (enter <number>) topic.

Error for implicit parameter declaration ( -Wpd) Refer to the -Wpd: Error for Implicit Parameter Declaration
topic.

Set messages to Disable Enter the messages that you want to disable.

Set messages to Error Enter the messages that you want to set as error.

Set messages to Information Enter the messages that you want to set as information.

Set messages to Warning Enter the messages that you want to set as warning.

3.8.2.11 HCS08 Compiler > Messages > Disable user messages

Use this panel to specify the options for disabling the user messages for the HC(S)08
Compiler.

The following figure shows the Disable user messages panel.

Figure 3-31. Tool Settings - HCS08 Compiler > Messages > Disable user messages

NOTE
For information about the description of the options available in
the Disable user messages panel of HC(S)08 Compiler, refer to
the -WmsgNu: Disable User Messages topic.

3.8.2.12 HCS08 Compiler > Preprocessor

Use this panel to specify preprocessor behavior. You can specify the file paths and define
macros.

The following figure shows the Preprocessor panel.
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Figure 3-32. Tool Settings - HCS08 Compiler > Preprocessor

The following table lists the Preprocessor panel options for HC(S)08 Compiler.

Table 3-13. Tool Settings - HCS08 Compiler > Preprocessor Options

Option Description

Define preprocessor macros ( -D) Defines, deletes, or rearranges the preprocessor macros. You
can specify multiple macros and change the order in which
the IDE uses the macros. Defines the preprocessor macros
and optionally assign their values. This setting is equivalent to
specifying the -D name[=value] command-line option. To
assign a value, use the equal sign (=) with no white space.
For example, this syntax defines a preprocessor value named
EXTENDED_FEATURE and assigns ON as its value:
EXTENDED_FEATURE=ONNote: If you do not assign a value
to the macro, the shell assigns a default value of 1.
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The following table lists and describes the toolbar buttons that help work with
preprocessor macro definitions.

Table 3-14. Define Preprocessor Macros Toolbar Buttons

Button Description

Add - Click to open the Enter Value dialog box and specify
the path/macro.

Delete - Click to delete the selected path/macro.

Edit - Click to open the Edit Dialog dialog box and update
the selected path/macro.

Move up - Click to move the selected path/macro one
position higher in the list.

Move down - Click to move the selected path/macro one
position lower in the list.

The following figure shows the Enter Value dialog box.

Figure 3-33. Tool Settings - HCS08 Compiler > Preprocessor - Enter Value Dialog Box

The following figure shows the Edit Dialog dialog box.

Figure 3-34. Tool Settings - HCS08 Compiler > Preprocessor - Edit Dialog Box

The buttons in the Enter Value and Edit Dialog dialog boxes help work with the
preprocessor macros.

¾ OK- Click to confirm the action and exit the dialog box.
¾ Cancel- Click to cancel the action and exit the dialog box.
¾ Variables- Click to select the build variable.
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3.8.2.13 HCS08 Compiler > Type Sizes

Use this panel to specify the type sizes for HC(S)08 Compiler. The following figure
shows the Type Sizes panel.

Figure 3-35. Tool Settings - HCS08 Compiler > Type Sizes

NOTE
For information about the description of the options appearing
in the Type Sizes panel for HC(S)08 Compiler, refer to the -T:
Flexible Type Management topic.

3.8.2.14 HCS08 Compiler > General

Use this panel to specify other flags for the HC(S)08 Compiler to use.

The following figure shows the General panel.

Figure 3-36. Tool Settings - HCS08 Compiler > General

The following table lists the General panel options for HC(S)08 compiler.
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Table 3-15. Tool Settings - HCS08 Compiler > General Options

Option Description

Other flags Specifies the additional command line options for the
compiler; type in custom flags that are not otherwise available
in the UI.

3.8.2.15 HCS08 Compiler > Optimization

Use this panel to control compiler optimizations. The compiler°s optimizer can apply any
of its optimizations in either global or non-global optimization mode. You can apply
global optimization at the end of the development cycle, after compiling and optimizing
all source files individually or in groups.

The following figure shows the Optimization panel.

Figure 3-37. Tool Settings - HCS08 Compiler > Optimization

The following table lists the Optimization panel options for HC(S)08 compiler.
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Table 3-16. Tool Settings - HCS08 Compiler > Optimization Options

Option Description

Disable optimization ( -O0) Refer to the -O0 : Disable Optimizations topic.

No integral promotion on characters ( -Cni) Refer to the -Cni: No Integral Promotion on Characters topic.

Loop unrolling ( i[number]) ( -Cu) Refer to the -Cu: Loop Unrolling topic.

Main Optimize Target: Optimize for Refer to the -O(-Os, -Ot): Main Optimization Target topic.

Optimize dead assignments Refer to the -Ous, -Ou, and -Onu: Optimize Dead
Assignments topic.

Create sub-functions with common code Refer to the -Of and-Onf: Create Sub-Functions with Common
Code topic.

Dynamic options configuration for functions ( -OdocF) Refer to the -OdocF: Dynamic Option Configuration for
Functions topic.

Inlining ( C[n] or OFF) ( -Oi) Refer to the -Oi: Inlining topic.

Disable alias checking ( -Ona) Refer to the -Ona: Disable Alias Checking topic.

Do generate copy down information for zero values ( -
OnCopyDown)

Refer to the -OnCopyDown: Do Generate Copy Down
Information for Zero Values topic.

Disable CONST variable by constant replacement ( -
OnCstVar)

Refer to the -OnCstVar: Disable CONST Variable by Constant
Replacement topic.

Disable code generation for NULL Pointer to Member check
( -OnPMNC)

Refer to the -OnPMNC: Disable Code Generation for NULL
Pointer to Member Check topic.

Large return value type Refer to the -Rp (-Rpe, -Rpt): Large Return Value Type topic.

Optimize bitfields and volatile bitfields Refer to the -Obfv: Optimize Bitfields and Volatile Bitfields
topic.

Keep loop induction variables in registers Refer to the -Ol: Try to Keep Loop Induction Variables in
Registers topic.

Disable optimize bitfields Refer to the -Onbf: Disable Optimize Bitfields topic.

Disable ICG level branch tail merging Refer to the -Onbt: Disable ICG Level Branch Tail Merging
topic.

Disable any constant folding Refer to the -Onca: Disable any Constant Folding topic.

Disable constant folding in the case of a new constant Refer to the -Oncn: Disable Constant Folding in Case of a
New Constant topic.

Disable any low level common subexpression elimination Refer to the -One: Disable any Low Level Common
Subexpression Elimination topic.

Allocate local variables into registers Refer to the -Or: Allocate Local Variables into Registers topic.

Disable frame pointer optimization ( -OnX) Refer to the -OnX: Disable Frame Pointer Optimization topic.

3.8.2.16 HCS08 Compiler > Optimization > Tree optimizer

Use this panel to configure the tree optimizer options for the HC(S)08 compiler
optimization.

The following figure shows the Tree optimizer panel.
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Figure 3-38. Tool Settings - HCS08 Compiler > Optimization > Tree optimizer

NOTE
For information about the description of the options appearing
in the Tree optimizer panel for HC(S)08 Compiler, refer to the
-Ont: Disable Tree Optimizer topic.

3.8.2.17 HCS08 Compiler > Optimization > Optimize Library Function

Use this panel to optimize the library functions for the HC(S)08 compiler.

The following figure shows the Optimize Library Function panel.
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Figure 3-39. Tool Settings - HCS08 Compiler > Optimization > Optimize Library Function

NOTE
For information about the description of the options appearing
in the Optimize Library Function panel for HC(S)08
compiler, refer to the -Oilib: Optimize Library Functions topic.

3.8.2.18 HCS08 Compiler > Optimization > Branch Optimizer

Use this panel to configure the branch optimizer for the HC(S)08 compiler. The
following figure shows the Branch Optimizer panel.

Figure 3-40. Tool Settings - HCS08 Compiler > Optimization > Branch Optimizer

NOTE
For information about the description of the options appearing
in the Branch Optimizer panel for HC(S)08 compiler, refer to
the -OnB: Disable Branch Optimizer topic.

3.8.2.19 HCS08 Compiler > Optimization > Peephole Optimization

Use this panel to configure peephole optimization for the HC(S)08 Compiler. The
following figure shows the Peephole Optimization panel.
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Figure 3-41. Tool Settings - HCS08 Compiler > Optimization > Peephole Optimization

NOTE
For information about the description of the options appearing
in the Peephole Optimization panel for HC(S)08 compiler,
refer to the -OnP: Disable Peephole Optimization topic.

3.8.3 CodeWarrior Tips and Tricks

You can use the following listed tips and tricks in the CodeWarrior for Microcontrollers
V10.x:

¾ If Simulator or Debugger cannot be launched, check the project s launch
configuration settings. For more information about the launch configurations and
their settings, refer to the Microcontrollers V10.x Targeting Manual.

NOTE
The project°s launch configurations can be viewed and
modified from the IDE°s Run Configurations or Debug
Configurations dialog boxes. To open these dialog boxes,
select Run > Run Configurations or Run > Debug
Configurations.

¾ If a file cannot be added to the project, its file extension may not be available in the
File Types panel. To resolve the issue, add the file°s extension to the list in the File
Types panel. To access the File Types panel, proceed as follows:
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a. Right-click the desired project and select Properties.

The Properties for <project> dialog box appears.

b. Expand the C/C++ General tree control and select File Types.
c. Select the Use project settings option.
d. Click New.

The C/C++ File Type dialog box appears.

e. Enter the required pattern and select the file type and click OK.

The C/C++ File Type dialog box closes.

f. Click OK to save the changes and close the properties window.

Now, you can add the required file to the project.

3.9 Integration into Microsoft Visual C++ 2008 Express
Edition (Version 9.0 or later)

Use the following procedure to integrate the CodeWarrior tools into the Microsoft Visual
Studio (Visual C++) IDE.

3.9.1 Integration as External Tools

1. Start Visual C++ 2008 Expression Edition.
2. Select Tools > External Tools.

The External Tools dialog box appears.
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Figure 3-42. External Tools Dialog Box
3. Add a new tool by clicking Add.
4. In the Title text box, type the name of the tool to display in the menu, for example,

HCS08 Compiler.
5. In the Command text box, either type the path of the piper tool or browse to Piper.exe

using the Browse button. The location of Piper.exe is <CWInstallDir>\MCU\prog\piper.exe

where CWInstallDir is the directory in which the CodeWarrior software is installed.
Piper.exe redirects I/O so that the HC(S)08 build tools can be operated from within
the Visual Studio UI.

6. In the Arguments text box, type the name of the tool to be launched. You can also
specify any command line options, for example, -Cc, along with the $(ItemPath)Visual
variable.

You can use the pop-up menu to the right of the text box to enter other Visual
variables. The text box should look like this:

<CWInstallDir>\MCU\prog\chc08.exe -Cc $(ItemPath)

where CWInstallDir is the directory in which the CodeWarrior software is installed.

7. In the Initial Directory text box, use the pop-up menu to choose $(ItemDir).
8. Check the Use Output Window checkbox.
9. Confirm that the Prompt for arguments checkbox is clear.

10. Click Apply to save your changes, then close the External Tools dialog box. The
new tool appears in the Tools menu.
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Similarly, you can display other build tools in the Tools menu. Use Build Tools
(Application Programs) to obtain the file names of the other build tools and specify the
file names in the Arguments text box.

This arrangement allows the active (selected) file to be compiled or linked in the Visual
Editor. Tool messages are reported in the Visual Output window. You can double-click
an error message in this window and the offending source code statement is displayed in
the editor.

Figure 3-43. Visual Output Window

3.9.2 Integration with Visual Studio Toolbar

1. Start Visual C++ 2008 Expression Edition.
2. Make sure that all tools are integrated and appear as menu choices in the Tools

menu.
3. Select Tools > Customize .

The Customize window appears.

4. Select the Toolbars tab.
5. Select New and enter a name. For example, Freescale Tools.

A new empty toolbar named Freescale Tools appears on your screen, adjacent to the
Customize window.

6. Select the Commands tab.
7. From the Category drop-down list box, select Tools .
8. The right side of the window displays a list of commands. Search for the commands

labeled External Command x, where x represents a number. This number corresponds to
an entry in the Menu contents text box of the External Tools window. Count down
the list in the External Tools window until you reach the first external tool you
defined. For this example, it is HCS08 Compiler , and was the third choice on the
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menu. Therefore, the desired tool command would be External Command 3. Alternately,
with Tools selected in the Customize window°s Commands tab, click on the Tools
menu and it display the menu choices, with the external commands displayed.

9. Drag the desired command to the Freescale Tools toolbar.

A button labeled External Tool 3 appears on the Freescale Tools toolbar.

Tip
If the button appears dimmed, you have chosen an inactive
external tool entry. Check your count value and try another
external command entry.

10. Continue with this same sequence of steps to add the HCS08 Linker and HCS08
Assembler.

11. All of the default command names, such as External Command 3 , External
Command 4 , and External Command 5 on the toolbar are undescriptive, making it
difficult to know which tool to launch. You must associate a name with them.

12. Right-click on a button in the Freescale Toolbar to open the button°s context menu.
13. Select Name from the context menu.
14. Enter a descriptive name into the text field.
15. Repeat this process for all of the tools that you want to display in the toolbar.
16. Click Close to close the Customize window.

This enables you to start the CodeWarrior tools from the toolbar, as shown in the
following figure.

Figure 3-44. CodeWarrior Tools in Custom Visual Studio Toolbar

3.10 Compiler Modes and Language Extensions

It is possible to have the compiler operate in one of several modes to enforce certain
programming language practices or to support special programming language extensions.
You can:

¾ Force the compiler into a strict ANSI-C compliant mode, or
¾ Use language extensions that are specially designed for more efficient embedded

systems programming.
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3.10.1 C++, EC++, compactC++

The compiler supports the C++ language, if the C++ feature is enabled with a license file.

Some features of the C++ language are not designed for embedded controllers. If they are
used, they may produce large amounts of code and require a lot of processor overhead,
thereby sapping performance.

Avoid this situation by using the compactC++ and EC++ language extensions, which are
subsets of the C++ language. Each subset is adapted for embedded application
programming.

These subsets of the C++ language avoids implicit and explicit overhead of the C++
language (for example, virtual member functions and multiple inheritance). The EC++ is
a restricted subset, while compactC++ includes features which are not in the EC++
definition. This makes it more flexible.

Another key aspect of compactC++ is its flexible configuration of the language (for
example, allowed keywords, code generation behavior, and message management). The
compiler is adapted for the special needs for embedded programming.

The compiler provides the following language settings:

¾ ANSI-C: The compiler behaves as an ANSI-C compiler. It is possible to force the
compiler into a strict ANSI-C compliant mode, or to use language extensions
designed for efficient embedded systems programming.

¾ EC++: The compiler behaves as a C++ compiler. The following features are not
allowed in EC++:

¾ Mutable specifier
¾ Exception handling
¾ Runtime type identification
¾ Namespace
¾ Template
¾ Multiple inheritance
¾ Virtual inheritance
¾ Library support for w_char and long double

¾ cC++, compactC++: In this mode, the compiler behaves as a full C++ compiler that
allows the C++ language to be configured to provide compact code. This enables
developers to enable/disable and configure the following C++ features:

¾ Multiple inheritance
¾ Virtual inheritance
¾ Templates
¾ Trigraph and bigraph
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¾ Compact means:
¾ No mutable qualifier
¾ No exception handling
¾ No runtime type identification
¾ No namespaces
¾ No library support for w_char and long double

¾ C++: The compiler behaves as a full C++ compiler. However, because the C++
language provides some features not usable for embedded systems programming,
such features may be not usable.

NOTE
Currently, for the MCU V10.x release, the Eclipse UI only
allows you to turn C++ language support on or off. The UI
currently does not implement settings for EC++ and
compactC++ language extensions. You must use command
line arguments to specify the compiler°s support for these
language extensions. More details on these arguments can
be found in Compiler Options chapter, under -C++ (-C++f,
-C++e, -C++c): C++ Support.

3.11 Object-File Formats

The compiler supports two different object-file formats: ELF/DWARF and the vendor-
specific HIWARE object-file format. The object-file format specifies the format of the
object files ( *.o), library files ( *.lib), and the absolute files ( *.abs).

NOTE
Do not mix object-file formats. Both the HIWARE and the
ELF/DWARF object files use the same filename extensions.

3.11.1 HIWARE Object-File Format

The HIWARE Object-File Format is a vendor-specific object-file format defined by
HIWARE AG. This compact object-file format produces smaller file sizes than the ELF/
DWARF object files. This enables faster file operations. Third-party tool vendors find
this compact file size easy to support (for example, emulators from Abatron, Lauterbach,
or iSYSTEM). This object-file format supports both ANSI-C and Modula-2.
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However, third-party tool vendors must support this object-file format explicitly. Note
that there is a lack of extensibility, a lack of debug information, and no C++ support. For
example, HIWARE Object-file Format does not support the full flexibility of Compiler
Type Management.

Using the HIWARE object-file format may also result in slower source or debug
information loading. In the HIWARE object-file format, the source position information
is provided as position information (offset in file), and not directly in a file, line, or
column format. The debugger must translate this HIWARE object-file source information
format into a file, line, or column format. This tends to slow down the source file or
debugging information loading process.

3.11.2 ELF/DWARF Object-File Format

The ELF/DWARF object-file format originally comes from the UNIX world. This format
is very flexible and supports extensions.

Many chip vendors define this object-file format as the standard for tool vendors
supporting their devices. This standard allows inter-tool operability making it possible to
use the compiler from one tool vendor, and the linker from another. The developer has
the choice to select the best tools for the tool chain. In addition, other third parties (for
example, emulator vendors) need only support this object file to support a wide range of
tool vendors.

Object-file sizes are larger when compared with the HIWARE object-file format. This
object-file format also supports ANSI-C.

3.11.3 Tools

The CodeWarrior Suite contains the following tools, among others:

¾ Compiler

The same compiler executable supports both object-file formats. Use the -F (-Fh, -
F1, -F1o, -F2, -F2o,-F6, or -F7): Object-File Format compiler option to switch the
object-file format.

Note that not all compiler backends support both ELF/DWARF and the HIWARE
object-file formats. Some only support one of the two.

Chapter 3 Introduction

CodeWarrior Development Studio for Microcontrollers V10.x HC(S)08 Build Tools Reference Manual, Rev.
10.6, 01/2014

Freescale Semiconductor, Inc. 109



¾ Decoder

Use the same executable, decoder.exe, for both the HIWARE and the ELF/DWARF
object-file formats.

¾ Linker

Use the same executable, linker.exe, for both the HIWARE and the ELF/DWARF
object-file formats.

¾ Simulator or Debugger

The simulator and the debugger support both object-file formats.

3.11.4 Mixing Object-File Formats

You cannot mix HIWARE and ELF object files. You can mix ELF object files with
DWARF 1.1 and DWARF 2.0 debug information. However, the final generated
application contains no debug data.
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Chapter 4
Graphical User Interface

Graphical User Interface (GUI) provides a simple yet powerful user interface for the
CodeWarrior build tools. Following are the features of the CodeWarrior build tools GUI:

¾ An interactive mode for those who need an easy way to modify the tool settings
¾ A batch mode that allows the tools to interoperate with a command-line interface

(CLI) and make files
¾ Online Help
¾ Error Feedback
¾ Easy integration into other tools, for example, CodeWarrior IDE, CodeWright,

Microsoft Visual Studio, and WinEdit

This chapter describes the GUI and provides useful hints. Its major topics are:

¾ Launching Compiler
¾ Compiler Main Window
¾ Editor Settings Dialog Box
¾ Save Configuration Dialog Box
¾ Environment Configuration Dialog Box
¾ Standard Types Settings Dialog Box
¾ Option Settings Dialog Box
¾ Smart Control Dialog Box
¾ Message Settings Dialog Box
¾ About Dialog Box
¾ Specifying Input File

4.1 Launching Compiler

You can use either of the ways to launch the HC(S)08 Compiler:
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¾ Navigate to < CWInstallDir>\MCU\prog using Windows Explorer and double-click
chc08.exe, where CWInstallDir is the directory in which the CodeWarrior software is
installed.

¾ Create a shortcut for chc08.exe on the desktop and double-click the shortcut
¾ Create a shortcut for chc08.exe in the Start > Programs menu and select the shortcut
¾ Use batch and com mand files
¾ Use other to ols, such as Editor and Visual Studio

You can launch the compiler in either Interactive Mode or Batch Mode.

4.1.1 Interactive Mode

If you start the compiler with no options and no input files, the tool enters the interactive
mode and the compiler GUI is displayed. This is usually the case if you start the compiler
using the Windows Explorer or an Desktop or Programs menu icon.

The following code specifies an input line associated with a desktop icon for the HC(S)08
compiler:
  chc08.exe -F2 a.c d.c   

4.1.2 Batch Mode

If you are using the command prompt to start the compiler and specify arguments, such
as options and/or input files, the compiler starts in the batch mode. In the batch mode, the
compiler does not open a window or does not display GUI. The taskbar displays the
progress of the compilation processes, such as processing the input.

The following code presents a command to run the HC(S)08 compiler and process two
source files, a.c and d.c, which appear as arguments:
  C:\Freescale\CW MCU v10.x\MCU\prog>chc08.exe - F2 a.c d.c 
  

The compiler redirects message output, stdout using the redirection operator,   >°. The
redirection operation instructs the compiler to write the message output to a file. The
following code redirects command-line message output to a file, myoutput.o:
 C:\Freescale\CW MCU v10.x\MCU\prog>chc08.exe - F2 a.c d.c > myoutput.o   
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The command line process returns after the compiling process starts. It does not wait
until the previous process has terminated. To start a tool and wait for termination , for
example, to synchronize successive operations, use the start command in the WindowsÀ
2000, Windows XP, or Windows VistaÉ operating systems, or use the /wait options
(refer to the Windows Help  help start°). Using start /wait pairs, you can write perfect
batch files. The following code starts a compilation process but waits for the termination
of the prior activities before beginning:
  C:\Freescale\CW MCU v10.x\MCU\prog>start/wait chc08.exe -F2 a.c d.c   

4.2 Compiler Main Window

If you do not specify a filename while starting the Compiler, the CompilerMain
Window is empty on startup.

The Compiler window consists of a window title, a menu bar, a toolbar, a content area,
and a status bar.

Figure 4-1. Compiler Main Window

When the Compiler starts, the Tip of the Day dialog box displaying the latest tips,
appears in the Compiler main window.

¾ The Next Tip button displays the next tip about the Compiler.
¾ To disable the Tip of the Day dialog box from opening automatically when the

application starts, clear the Show Tips on StartUp checkbox.
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NOTE
This configuration entry is stored in the local project file.

¾ To enable automatic display of the Tip of the Day dialog box when the Compiler
starts, select Help > Tip of the Day . The Tip of the Day dialog box opens. Check
the Show Tips on StartUp checkbox.

¾ Click Close to close the Tip of the Day window.

The IDE enables/disables the Tip of the Day as per the option you selected.

This section covers the following topics:

¾ Window Title
¾ Content Area
¾ Toolbar
¾ Status Bar
¾ Compiler Menu Bar
¾ File Menu
¾ Compiler Menu
¾ View Menu
¾ Help Menu

4.2.1 Window Title

The window title displays the Compiler name and the project name. If a project is not
loaded, the Compiler displays Default Configuration in the window title. An asterisk
( *) after the configuration name indicates that some settings have changed. The Compiler
adds an asterisk ( *) whenever an option, the editor configuration, or the window
appearance changes.

4.2.2 Content Area

The content area displays the logging information about the compilation process. This
logging information consists of:

¾ the name of the file being compiled,
¾ the whole name, including full path specifications, of the files processed, such as C

source code files and all of their included header files
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¾ the list of errors, warnings, and information messages
¾ the size of the code generated during the compilation session

When you drag and drop a file into the Compiler window content area, the Compiler
either loads it as a configuration file or compiles the file. It loads the file as configuration
file, if the file has the *.ini extension. Otherwise, the compiler processes the file using the
current option settings.

All of the text in the Compiler window content area can have context information
consisting of two items:

¾ a filename, including a position inside of a file and
¾ a message number

File context information is available for all source and include files, for output messages
that concern a specific file, and for all output that is directed to a text file. If a file context
is available, double-clicking on the text or message opens this file in an editor, as
specified in the Editor Configuration. Also, a right-click in this area opens a context
menu. The context menu contains an Open entry if a file context is available. If a context
menu entry is present but the file cannot be opened, refer to the Global Initialization File
(mcutools.ini).

The message number is available for any message output. There are three ways to open
the corresponding entry in the help file.

¾ Select one line of the message and press F1.

If the selected line does not have a message number, the main help displays.

¾ Press Shift-F1 and then click on the message text.

If the selected line does not have a message number, the main help displays.

¾ Right click the message text and select Help on .

This entry is available only if a message number is available in the HC08 Compiler
Message Settings Dialog Box .
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Figure 4-2. HC08 Compiler Message Settings Dialog Box

4.2.3 Toolbar

The toolbar consists of an array of buttons and a content box, just above the content area.
Starting from left to right, these elements are:

¾ The three left-most buttons in the toolbar correspond to the New ,
LoadConfiguration , and Save Configuration entries of the File menu.

¾ The Help button opens on-line help window.
¾ The Context Help button, when clicked, has the cursor change its form and display a

question mark beside the pointer. Clicking an item calls the help file. Click on
menus, toolbar buttons, or the window area to get information specific to that item.

NOTE
You can also access context help by typing the key
shortcut, Shift-F1.

Figure 4-3. Toolbar
¾ The command line history text box is in the middle of the toolbar and displays the

command line history. It contains a list of the commands executed previously. Once
you select a command or enter it in the history text box, clicking the Compile button
to the right of the command line history executes the command. The F2 keyboard
shortcut key jumps directly to the command line. In addition, a context menu is
associated with the command line.

¾ The Stop button stops the current process session.
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¾ The next four buttons open the Options , Smart Slider , Standard Types , and
Messages dialog boxes. These dialog boxes are used to modify the compiler°s
settings, such as language used, optimization levels, and size of various data types.
The use of the dialog boxes are discussed later in the chapter.

¾ The right-most button clears the content area (Output Window).

Figure 4-4. Command Line Context Menu

4.2.4 Status Bar

The status bar displays the current status of the compiler when it processes a file.When
the compiler is idle, the message area displays a brief description of function of the
button or menu entry when you place the cursor over an item on the toolbar. The
following figure shows the status bar of the compiler.

Figure 4-5. Status Bar

4.2.5 Compiler Menu Bar

The following table lists the menus available in the Compiler menu bar.

Table 4-1. Menu Items in Menu Bar

Menu Item Description

File Menu Manage the Compiler°s configuration files

Compiler Menu Set the Compiler°s options

View Menu Customize the Compiler°s window output

Help Menu Access the standard Windows Help menu
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Figure 4-6. Menu Bar

4.2.6 File Menu

The File menu is used to save or load Compiler configuration files. A Compiler
configuration file contains the following information:

¾ Compiler option settings specified in the settings panels
¾ Message Settings that specify which messages to display and which messages to treat

as error messages
¾ List of the last command lines executed and the current command line being

executed
¾ Window position information
¾ Tip of the Day settings, including the current entry and enabled/disabled status

Figure 4-7. File Menu

Configuration files are text files which have the standard * .ini extension. You can define
as many configuration files as required for the project and can switch among the different
configuration files using the File > Load Configuration , File > Save Configuration
menu entries, or the corresponding toolbar buttons.

The following table lists the File menu options.
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Table 4-2. File Menu Options

Menu Option Description

Compile Displays the Select File to Compile dialog box. Browse to
the desired input file using the dialog box. Select the file and
click OK. The Compiler compiles the selected file.

New/Default Configuration Resets the Compiler option settings to their default values.
The default Compiler options which are activated are
specified in the Compiler Options chapter.

Load Configuration Displays the Loading configuration dialog box. Select the
desired project configuration using the dialog box and click
Open. The configuration data stored in the selected file is
loaded and used in further compilation sessions.

Save Configuration Saves the current settings in the configuration file specified on
the title bar.

Save Configuration As Displays a standard Save As dialog box. Specify the
configuration file in which you want to save the settings and
click OK.

Configuration Opens the Configuration dialog box to specify the editor
used for error feedback and which parts to save with a
configuration. Refer to the topics, Editor Settings Dialog Box
and Save Configuration Dialog Box.

1 project.ini 2 D:\X15\project.ini Recent project configuration files list. This list can be used to
reopen a recently opened project configuration.

Exit Closes the Compiler.

4.2.7 Compiler Menu

Use the Compiler menu to customize the Compiler. It allows you to set certain compiler
options graphically, such as the optimization level. The table below lists the Compiler
menu options.

Figure 4-8. Compiler Menu
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Table 4-3. Comp iler Menu Options

Menu Option Description

Opt ions Customizes the Compiler. You can graphically set or reset the
compiler options.

Standard Types Specifies the size you want to associate with each ANSI C
standard type. (Refer to the topic, Standard Types Settings
Dialog Box.)

Options Defines the options that the compiler uses when processing
an input file. (Refer to the topic, Option Settings Dialog Box.)

Smart Slider Defines the optimization level you want the compiler to use
when processing the input file. (Refer to the topic, Smart
Control Dialog Box.)

Messages Allows you to map the different error, warning, or information
messages to another message class. (Refer Message
Settings Dialog Box.)

Stop Compile Immediately stops the current processing session.

4.2.8 View Menu

Use the View menu to customize the Compiler window, such as display or hide the status
bar or toolbar, set the font used in the window, or clear the window°s content area.The
table below lists the View Menu options.

Figure 4-9. View Menu

Table 4-4. View Menu Options
Menu Option Description

Toolbar Hides or displays the toolbar in the Compiler window.

Status Bar Hides or displays the status bar in the Compiler window.

Log Customize the output in the Compiler°s window content area.
The following entries are available when Log is selected.

Table continues on the next page...
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Table 4-4. View Menu Options (continued)

Menu Option Description

Change Font Opens a standard font selection box. Applies the selected
options to the Compiler°s window content area.

Clear Log Clears the Compiler°s window content area.

4.2.9 Help Menu

Use the Help menu to activate or deactivate the Tip of the Day dialog box at application
startup. In addition, it provides access a standard Windows Help file and an About box.
The table below lists the Help menu options.

Figure 4-10. Help Menu

Table 4-5. Help Menu Options

Menu Option Description

Tip of the Day Activates or deactivates Tip of the Day at startup.

Help Topics Standard Help topics.

About Displays an About dialog box with version and licensing
information.

4.3 Editor Settings Dialog Box

The Editor Settings dialog box has a main selection entry. Depending on the main type
of editor selected, the content below changes.

These are the main entries for the Editor configuration:
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¾ Global Editor (shared by all tools and projects)
¾ Local Editor (shared by all tools)
¾ Editor Started with Command Line
¾ Editor Started with DDE
¾ CodeWarrior (with COM)
¾ Modifiers

4.3.1 Global Editor (shared by all tools and projects)

All tools and projects on one work station share the Global Editor option. The
mcutools.ini global initialization file stores the configuration in the [Editor] section. The
editor command line specifies some Modifiers.

Figure 4-11. Global Editor Configuration Dialog Box

4.3.2 Local Editor (shared by all tools)

All tools using the same project file share the Local Editor option. Modifying an entry of
the Global or Local configuration modifies the behavior of the other tools using the same
entry when these tools are restarted.
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Figure 4-12. Local Editor Configuration Dialog Box

4.3.3 Editor Started with Command Line

Selecting this editor option, as shown in the figure below, associates a separate editor for
error feedback with the application. The configured editor (that is, Global or Local) is not
used for error feedback.

In the Command Line text box, enter the command that starts the editor.

The format of the editor command depends on the syntax. Specify Modifiers in the editor
command line to refer to specific line numbers in the file. (Refer Modifiers.)

The format of the editor command depends upon the syntax that is used to start the editor.
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Figure 4-13. Editor Started with Command Line

4.3.3.1 Examples

For CodeWright V6 editor, use the following command line (with an adapted path to the
cw32.exe file):
  C:\cw32.exe %f -g%l   

For the WinEdit 32-bit version, use the following command line (with an adapted path to
the winedit.exe file):
  C:\WinEdit32\WinEdit.exe %f /#:%l   

4.3.4 Editor Started with DDE

Enter the Service Name , Topic Name , and the Client Command for the DDE
connection to the editor. The Topic Name and Client Command entries can have
modifiers for the filename, line number, and column number as explained in Modifiers.
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Figure 4-14. Editor Started with DDE (Microsoft Developer Studio)

For Microsoft Developer Studio, use the settings in the following listing.

Listing: Microsoft Developer Studio Configuration
Service Name   : 
msdev

Topic Name     : system

Client Command  : [open(%f)]

UltraEdit-32 is a powerful shareware editor. It is available from www.idmcomp.com or
www.ultraedit.com (email idm@idmcomp.com). For UltraEdit, use the settings in the
following listing.

Listing: UltraEdit-32 Editor Settings
Service Name  : UEDIT32
Topic Name    : system

Client Command : [open("%f/%l/%c")]

NOTE
The DDE application (for example, Microsoft Developer Studio
or UltraEdit) must be running, or DDE communications will
fail.
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Figure 4-15. Editor Started with DDE (UltraEdit-32)

4.3.5 CodeWarrior (with COM)

Select CodeWarrior (with COM) to use the CodeWarrior IDE as the editor. This
registers CodeWarrior IDE as the COM server by the installation script.

CAUTION
This panel supports use of the legacy CodeWarrior IDE. It is
not for use with the Eclipse IDE that hosts the CodeWarrior for
Microcontrollers V10.x.
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Figure 4-16. CodeWarrior (with COM)

4.3.6 Modifiers

The configuration must contain modifiers that instruct the editor which file to open and at
which line.

¾ The %f modifier refers to the name of the file (including path) where the message is
detected.

¾ The %l modifier refers to the line number where the message is detected.
¾ The %c modifier refers to the column number where the message is detected.

NOTE
The %l modifier can only be used with an editor which is
started with a line number as a parameter, except when
working with WinEdit version 3.1 or lower or with
Notepad. When working with these editors, start the editor
with the filename as a parameter and then select the menu
entry Go to to jump on the line where the message has been
detected. In that case the editor command looks like: C:
\WINAPPS\WINEDIT\Winedit.EXE %f check the editor manual for
the command line definition for starting the editor.
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4.4 Save Configuration Dialog Box

Select the Save Configuration tab to access the Save Configuration dialog box. Specify
which portions of your configuration to save to the project file.

Figure 4-17. Save Configuration Dialog Box

The Save Configuration dialog box offers the following options:

¾ Options

Check this option to save the current option and message settings when a
configuration is written. By disabling this option, the last-saved content remains
valid.

¾ Editor Configuration

Check this option to save the current editor setting when a configuration is written.
By disabling this option, the last-saved content remains valid.

¾ Appearance

Check this option to save items such as the window position (only loaded at startup
time) and the command line content and history. By disabling this option, the last-
saved content remains valid.

Save Configuration Dialog Box

CodeWarrior Development Studio for Microcontrollers V10.x HC(S)08 Build Tools Reference Manual, Rev.
10.6, 01/2014

128 Freescale Semiconductor, Inc.



¾ Environment Variables

Check this option to save the environment variable changes made in the
Environment configuration dialog box.

NOTE
By clearing specific option, only some parts of a
configuration file are written. For example, clear the
Options checkbox when the best options are found.
Subsequent future save commands no longer modify these
options.

¾ Save on Exit

The application saves the current configuration on exit. No save confirmation dialog
is displayed. If this option is not set, the application will not write the configuration
at exit, even if parts of the configuration have changed. No save confirmation
appears in either case when closing the application.

Most settings are stored in the configuration file only. The only exceptions are:

¾ The recently used configuration list.
¾ All settings in this dialog box.

NOTE
The tool configurations can (and in fact are intended
to) coexist in the same file as the project configuration
of UltraEdit-32. When the shell configures an editor,
the application reads this content out of the project file
( project.ini), if present. This filename is also
suggested (but not required) to be used by the tool.

4.5 Environment Configuration Dialog Box

Open the Environment Configuration dialog box to configure the environment. The
dialog box°s content is read from the [ Environment Variables] section of the actual project
file.

The following listing shows the available environment variables.

Listing: Environment aariables
General Path:      GENPATH 
Object Path:       OBJPATH 
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Text Path:         TEXTPATH 
Absolute Path:     ABSPATH 
Header File Path:  LIBPATH 
Various Environment Variables: other variables not mentioned above.

Figure 4-18. Environment Configuration Dialog Box

The following buttons are available in this dialog box.

Table 4-6. Environment Configuration Dialog Box Button
Functions

Button Function

Add Adds a new line or entry

Change Changes a line or entry

Delete Deletes a line or entry

Up Moves a line or entry up

Down Moves a line or entry down

NOTE
The variables are written to the project file only if you save the
configuration by either, select File > Save Configuration or
press CTRL+S. In addition, you can specify in the Save
Configuration as dialog box if the environment is written to
the project file or not.
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4.6 Standard Types Settings Dialog Box

Use the Standard Types Settings dialog box to define the size to associate with each
ANSI C standard type. You can also use the -T: Flexible Type Management compiler
option to configure ANSI-C standard type sizes.

NOTE
Not all formats may be available for a target. In addition, there
must be at least one type for each size. For example, it is invalid
to specify all types to a size of 32 bits. Also, the HIWARE
Format does not support a size greater than 8 bits for the char
type.

The following listing lists the rules that apply when you modify the size associated with
an ANSI-C standard type:

Listing: Size Relationships for the ANSI-C Standard Types.
sizeof(char)  <= sizeof(short)
sizeof(short) <= sizeof(int)

sizeof(int)   <= sizeof(long)

sizeof(long)  <= sizeof(long long)

sizeof(float) <= sizeof(double)

sizeof(double)<= sizeof(long double)

Enumerations must be smaller than or equal to int.

Use the signed checkbox to specify whether the char or enum type must be considered as
signed or unsigned for your application.

The Defaults button resets the size of the ANSI C standard types to their default values.
The ANSI C standard type default values depend on the target processor.
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Figure 4-19. Standard Types Settings Dialog Box

4.7 Option Settings Dialog Box

Use the Option Settings dialog box) to set or reset tool options. This panel also displays
the possible command line arguments used to invoke these options in the lowest pane.
The available options are arranged into different groups, with separate tabs for each
group. The content of the list box depends on the selected tab. The table below lists the
Option Settings selections.

NOTE
Not all of the option tabs may be available.
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Figure 4-20. Option Settings Dialog Box

Table 4-7. Option Settings Dialog Box Tabs

Tab Description

Optimizations Lists optimization options

Output Lists options related to the output file generation, such as
which kind of file should be generated (list, map file, and so
on)

Input Lists options that direct how the tool handles the input file

Language Lists options related to the programming language features
used (strict ANSI-C, C++, compactC++)

Target Lists options related to the target processor

Host Lists options related to the host operating system

Code Generation Lists options related to code generation (memory models,
floating-point format, target processor)

Messages Lists options that control the generation of error messages

Various Lists options not included in the above options

Checking the application option checkbox sets the option. To obtain more detailed
information about a specific option, click once on the option text to select the option and
press the F1 key or click Help .
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NOTE
When you select options requiring additional parameters, you
can open an edit box or an additional sub-window where the
additional parameters are set.

4.8 Smart Control Dialog Box

Use the Smart Control dialog box to define the optimization level you want to apply
during compilation of the input file. Five sliders are available to adjust how the source
code is optimized, such as for execution speed or compact size. Refer to the table below
for option descriptions.

Figure 4-21. Compiler Smart Control Dialog Box

Table 4-8. Compiler Smart Control Dialog Box Controls
Slider Description

Code Density Displays expected code density level. A high value indicates
highest code efficiency (smallest code size).

Execution Speed Displays expected execution speed level. A high value
indicates fastest execution of the code generated.

Debug Complexity Displays expected debug complexity level. A high value
indicates complex debugging. For example, assembly code
corresponds directly to the high-level language code.

Table continues on the next page...
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Table 4-8. Compiler Smart Control Dialog Box Controls (continued)

Slider Description

Compilation Time Displays expected compilation time level. A higher value
indicates longer compilation time to produce the object file,
often due to the manys optimizations applies to the code.

Information Level Displays level of information messages displayed during
compiler session. A high value indicates a verbose compiler
behavior. For example, it informs with warnings and
information messages.

The first four sliders in this panel are directly linked. That is, moving one slider updates
the positions of the other three, according to the adjustment.

The command line automatically updates with the options set in accordance with the
settings of the different sliders.

4.9 Message Settings Dialog Box

Use the Message Settings dialog box to map messages to a different message class.

Some buttons in the panel may be disabled. (For example, if an option cannot be moved
to an Information message, the Move to: Information button is disabled.) The following
table describes the buttons available in this dialog box.

Chapter 4 Graphical User Interface

CodeWarrior Development Studio for Microcontrollers V10.x HC(S)08 Build Tools Reference Manual, Rev.
10.6, 01/2014

Freescale Semiconductor, Inc. 135



Figure 4-22. Message Settings Dialog Box

Table 4-9. Message Settings Dialog Box Buttons

Button Description

Move to: Disabled Disables selected messages. (Messages no longer occur.)

Move to: Information Changes the selected messages to information messages.

Move to: Warning Changes the selected messages to warning messages.

Move to: Error Changes the selected messages to error messages.

Move to: Default Changes the selected messages to their default message
type.

Reset All Resets all messages to their default message type.

OK Exits this panel and accepts the changes made.

Cancel Exits this panel without accepting the changes made.

Help Displays online help about this panel.

A panel is available for each error message class. The content of the list box depends on
the selected panel. The following table lists the message group definitions.

Table 4-10. Message Group Definitions
Message Group Description

Disabled Lists all disabled messages. Messages displayed in the list
box will not be displayed by the tool.

Information Lists all information messages. Information messages
describe the actions taken by the tool.

Warning Lists all warning messages. When a warning message is
generated, input file processing continues.

Error Lists all error messages. When an error message is
generated, input file processing continues.

Table continues on the next page...
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Table 4-10. Message Group Definitions (continued)

Message Group Description

Fatal Lists all fatal error messages. When a fatal error message is
generated, input file processing stops immediately. Fatal
messages cannot be changed and are only listed to provide
access to context help.

Each message has its own prefix (for example,  C° for Compiler messages,  A° for
Assembler messages,  L° for Linker messages,  M° for Maker messages,  LM° for
Libmaker messages) followed by a 4- or 5-digit number. This number allows an easy
search for the message both in the manual or on-line help.

This section covers the following topics:

¾ Changing Class Associated with Message
¾ Retrieving Information about Error Message

4.9.1 Changing Class Associated with Message

Use the buttons located on the right hand side of the panel to configure your own
message mapping among the different message classes. Each button refers to a message
class. To change the class associated with a message, select the message in the list box
and then click the button associated with the class to which you want to move the
message.

To define a warning message as an error message:

1. Click the Warning panel to display the list of all warning messages in the list box.
2. Select the message you want to change in the list box.
3. Click Error to define this message as an error message.

NOTE
Messages cannot be moved to or from the fatal error class.

NOTE
The Move to buttons are active only when messages that
can be moved are selected. When you select a message
which cannot be moved to a specific group, the
corresponding Move to button for that group is disabled
(grayed).
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To save your changes to the message mappings, click OK to close the Message Settings
panel. Clicking Cancel discards your changes and closes the panel.

4.9.2 Retrieving Information about Error Message

You can access information about each message displayed in the list box. Select the
message in the list box and then click Help or press the F1 key. An information box opens
which contains a more detailed description of the error message, as well as a small
example of code that may have generated the error message. If several messages are
selected, help information for the first is shown. When no message is selected, pressing
the F1 key or the Help button shows the help information for this panel.

4.10 About Dialog Box

Open the About dialog box by selecting Help > About . The About window contains
information regarding your tool. The current directory and the versions of subparts of the
application are also shown. The main version displays separately at the top of the
window.

Use the Extended Information button to get license information about all software
components in the same directory as that of the executable file.

Click OK to close this dialog box.

NOTE
During processing, the Extended Information button cannot
request information regarding software components. This
information displays only if the tool is inactive.

4.11 Specifying Input File

There are different ways to specify the input file. During compilation, the configuration
established in the different dialog boxes sets the options. Before compiling a file, make
sure you have associated a working directory with your editor.

The topics covered here are as follows:
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¾ Methods of Compilation
¾ Message/Error Feedback
¾ Use Information from Compiler Window
¾ Working with User-Defined Editor

4.11.1 Methods of Compilation

There are several different methods for compiling input files. The following table lists
different compilation methods.

Table 4-11. Compilation Methods

Method Description

Use the Command Line in the Toolbar to Compile Use the command line to compile a new file or to open a
previously compiled file.

Compile a New File Enter a new filename and additional compiler options in the
command line. The specified file compiles as soon as you
click Compile in the toolbar or press the Enter key.

Compile an Existing File Display the previously executed command using the arrow on
the right side of the command line. Select a command by
clicking on it. It appears in the command line. The specified
file compiles as soon as you click Compile in the toolbar.

Use File > Compile When you select File > Compile , a standard open file dialog
appears. Use this to browse to the file you want to compile.
The selected file compiles as soon as you click Open.

Use Drag and Drop Drag a filename from an external application (for example the
File Manager/Explorer) and drop it into the compiler window.
The dropped file compiles as soon as you release the mouse
button. Files with the *.ini extension load immediately as
configuration files and do not compile. Use one of the other
methods to compile a C file with the *.c extension.

4.11.2 Message/Error Feedback

Check for errors or warnings after compilation by using one of several methods. The
following listing lists the format of the error messages.

Listing: Format of an Error Message
>> <FileName>, line <line number>, col <column number>, pos <absolute
 position in file>

<Portion of code generating the problem>
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<message class><message number>: <Message string>

The following listing shows a typical error message.

Listing: Example of an Error Message
>> in "C:\DEMO\fibo.c", line 30, col 10, pos 428
   EnableInterrupts

   WHILE (TRUE) {

         (

INFORMATION C4000: Condition always TRUE

Refer also the -WmsgFi (-WmsgFiv, -WmsgFim): Set Message Format for Interactive
Mode and -WmsgFb (-WmsgFbv, -WmsgFbm): Set Message File Format for Batch
Mode compiler options for different message formats.

4.11.3 Use Information from Compiler Window

Once a file compiles, the compiler window content area displays the list of all detected
errors or warnings.

Use your editor to open the source file and correct the errors.

4.11.4 Working with User-Defined Editor

Configure the edito r you want to use for message/error feedback in the Configuration
panel before you begin the compile process. Once a file compiles, double-click on an
error message. The selected editor automatically activates and points to the line
containing the error.

Specifying Input File
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Chapter 5
Environment

This chapter describes all the environment variables that the compiler uses. Some
environment variables are also used by other tools. Consult the tool manuals for specific
variable use information.

The major sections in this chapter are:

Use environment variables to set environment parameters. Specify your environment
using one of the following methods:

¾ (Recommended Method) The current project file with the [ Environment
Configuration ] panel. Specify this file on tool startup using the -Prod option ( -Prod:
Specify Project File at Startup).

¾ An optional default.env file in the current directory. CodeWarrior IDE tools support
backward compatibility for this file. Specify the filename using the ENVIRONMENT
variable ( ENVIRONMENT: Environment File Specification). Using the default.env
file is not recommended.

¾ Setting environment variables on system level (DOS level). This method is not
recommended.

Use the following syntax for setting an environment variable:

  Parameter:  <KeyName>=<ParamDef> 
  

NOTE
Normally no white space is allowed in the definition of an
environment variable.

Listing: Setting the GENPATH Environment Variable
GENPATH=C:\INSTALL\LIB;D:\PROJECTS\TESTS;/usr/local/lib;
/home/me/my_project

Define parameters using one of several methods:

¾ Using system environment variables supported by your operating system.
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¾ Putting the definitions into the actual project file in the [Environment Variables]
section.

¾ Putting the definitions in the default.env file in the default directory.

NOTE
The maximum length of environment variable entries in the
default.env file is 4096 characters.

¾ Putting the definitions in a file given by the value of the ENVIRONMENT system
environment variable.

NOTE
Set the default directory mentioned above using the
DEFAULTDIR system environment variable ( DEFAULTDIR:
Default Current Directory).

When looking for an environment variable, all programs first search the system
environment, then the default.env file, and finally the global environment file defined by
ENVIRONMENT. If no definition is found, the tools assume a default value.

NOTE
You can also change the environment using the -Env option ( -
Env: Set Environment Variable).

NOTE
Make sure that there are no spaces at the end of any
environment variable declaration.

¾ Current Directory
¾ Environment Macros
¾ Global Initialization File (mcutools.ini)
¾ Local Configuration File
¾ Paths
¾ Line Continuation
¾ Environment Variable Details

5.1 Current Directory

The current directory is the base search directory in which the tool begins a search for
files (for example, for the default.env file). Either the operating system or the program
determines the current directory of a tool.

Current Directory
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¾ For UNIX operating systems, the current directory is the directory in which the
binary file is located when launched.

¾ For Microsoft Windows-based operating systems, the current directory is defined as
follows:

¾ If the tool is launched using the File Manager or Explorer, the current directory
is the location of the launched executable.

¾ If the tool is launched using an Icon on the Desktop, the current directory is the
one specified and associated with the Icon.

¾ If the tool is launched by another launching tool with its own current directory
specification (for example, an editor), the current directory is the one specified
by the launching tool (for example, current directory definition).

¾ For the tools, the location of the local project file defines the current directory.
Changing the current project file also changes the current directory if the new project
file is in a different directory.

NOTE
Browsing for a C file does not change the current directory.

Specify a default current directory using the DEFAULTDIR environment variable
( DEFAULTDIR: Default Current Directory).

Display the current directory and other information using the -V compiler option ( -V:
Prints the Compiler Version) or the About dialog.

5.2 Environment Macros

You can use macros in your environment settings, as shown in the following listing.

Listing: Using Macros for Setting Environment Variables
MyVAR=C:\test
TEXTPATH=$(MyVAR)\txt
OBJPATH=${MyVAR}\obj

In the example above, TEXTPATH expands to C:\test\txt and OBJPATH expands to C:\test\obj.
You can use $() or ${}. However, you must define the referenced variable.

You may also use special variables when using macros. Always surround special
variables with brackets {}. Special variables are case-sensitive. In addition, the variable
content contains the directory separator   \°. The special variables are:

¾ { Compiler}
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Path of the executable one directory level up, if the executable file is C:\Freescale\prog
\linker.exe, and the variable is C:\Freescale\.

¾ { Project}

Path of the current project file. Use this special variable if the current project file is C:
\demo\project.ini, and the variable contains C:\demo\.

¾ { System}

Path of your Windows system installation, for example, C:\WINNT\.

5.3 Global Initialization File (mcutools.ini)

All tools store some global data in the mcutools.ini file. The tool first searches for
mcutools.ini in the tool directory (path of the executable). If mcutools.ini is not found in
the tool directory, the tool looks for mcutools.ini in the Microsoft Windows installation
directory (for example, C:\WINDOWS).

Listing: Typical Global Initialization File Locations
C:\WINDOWS\mcutools.ini
D:\INSTALL\prog\mcutools.ini

If you start the tool in the D:\INSTALL\prog directory, the tool uses the project file located in
the same directory as the tool ( D:\INSTALL\prog\mcutools.ini).

If you start the tool some other way, the tool uses the project file in the Windows
directory ( C:\WINDOWS\mcutools.ini).

Global Configuration File Entries documents the sections and entries you can include in
mcutools.ini.

5.4 Local Configuration File

The configuration file stores all configuration properties. Different applications use the
same configuration file.

The shell uses the project.ini configuration file in the current directory. When the shell
uses the same file as the compiler, the shell writes and maintains the Editor Configuration
used by the compiler. Apart from this, the compiler can use any filename for the project

Global Initialization File (mcutools.ini)
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file. The configuration file has the same format as the windows *.ini files. The compiler
stores its own entries with the same section name as those in the global mcutools.ini file.
The compiler backend is encoded into the section name, so that a different compiler
backend can use the same file without any overlapping. Different versions of the same
compiler use the same entries. When you must store options available in only one
compiler version in the configuration file, you must maintain a separate configuration file
for each different compiler version. If no incompatible options are enabled, you may use
the same file for both compiler versions.

Be aware of these rules when changing the directory or making changes to the
configuration file:

¾ The current directory is always the directory in which the configuration file is
located.

¾ Loading a configuration file in a different directory changes the current directory.
¾ Changing the current directory reloads the entire default.env file.
¾ Loading or storing a configuration file reloads the options in the environment

variable COMPOPTIONS and adds the options to the project options. This becomes an
issue when different default.env files, containing incompatible options in the
COMPOPTIONS variable, exist in different directories.

¾ Loading a project using the default.env adds the options in COMPOPTIONS to the
configuration file.

¾ Storing this configuration in a different directory which contains a default.env
with incompatible options adds the options to default.env. The compiler remarks
the inconsistency.

¾ Use the option settings dialog box to remove the option from the configuration
file, or remove the option from the default.env with the shell or a text editor.

At startup, use one of two methods to load a configuration:

¾ Use the -Prod: Specify Project File at Startup command line option
¾ Use the project.ini file in the current directory.

Using the -Prod option uses the directory which contains the project file as the current
directory. Specifying the directory when using the -Prod option loads the project.ini file
in this directory.

Local Configuration File Entries documents the sections and entries you can include in a
project.ini file.

5.5 Paths
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A path list is a list of directory names separated by semicolons. Declare path names using
the following Extended Backus-Naur Form (EBNF) syntax . Most environment variables
contain path lists to direct the compiler to the file location as shown in the Listing:
Environment Variable Path List with Four Possible Paths.

Listing: EBNF Path Syntax
PathList = DirSpec {; DirSpec}.
DirSpec  = [*] DirectoryName.

Listing: Environment Variable Path List with Four Possible Paths
GENPATH=C:\INSTALL\LIB;D:\PROJECTS\TESTS;/usr/local/lib;
/home/me/my_project

An asterisk ( * ) preceding a directory name instructs the program to recursively search
the entire directory tree for a file, not just the given directory itself. The program searches
the directories in the order of appearance in the path list.

Listing: Setting an Environment Variable using Recursive Searching
LIBPATH=*C:\INSTALL\LIB

NOTE
This procedure uses some DOS environment variables (like
GENPATH or LIBPATH).

If you work with the CodeWright editor, you can set the environment using a
<project>.pjt file in your project directory. This enables you to have different projects in
different directories, each with its own environment.

NOTE
When using WinEdit, do not set the system environment
variable DEFAULTDIR: Default Current Directory. If you do
so, and this variable does not contain the project directory given
in WinEdit°s project configuration, files might not be placed
where you expect them to be.

5.6 Line Continuation

Specify an environment variable in an environment file ( default.env) over several lines
using the line continuation character  \° (Refer the following listing).

Listing: Specifying an Environment Variable using Line Continuation Characters
OPTIONS=\ -W2 \ -Wpd

Line Continuation
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This is the same as:
OPTIONS=-W2 -Wpd  

However, this feature may not work well used together with paths. For example, the
following code is a valid use of the continuation character:
GENPATH=.\  

TEXTFILE=.\txt  

However the compiler understands these instructions as:
GENPATH=.TEXTFILE=.\txt  

To avoid such problems, use a semicolon ( ;) at the end of a path if using a continuation
character ( \) at the end of the line, as shown in the following listing.

Listing: Using a Semicolon to Allow a Multiple Line Environment Variable
GENPATH=.\;TEXTFILE=.\txt

5.7 Environment Variable Details

The remainder of this chapter describes each of the possible environment variables. The
following table lists these description topics in their order of appearance for each
environment variable.

Table 5-1. Environment Variables-Documentation Topics

Topic Description

Tools Lists tools that use this variable.

Synonym Lists any synonyms that exist for the environment variable.
Synonyms may be used for older releases of the Compiler
and will be removed in the future. A synonym has lower
precedence than the environment variable.

Syntax Specifies the syntax of the option in EBNF format.

Arguments Describes and lists optional and required arguments for the
variable.

Default Shows the default setting for the variable or none.

Description Provides a detailed description of the option and how to use
it.

Example Gives an example of usage, and the effects of the variable
when possible. The example shows an entry in the
default.env for a PC.

See also Names related sections.

The environment variables included here are as follows:
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¾ COMPOPTIONS: Default Compiler Options
¾ COPYRIGHT: Copyright Entry in Object File
¾ DEFAULTDIR: Default Current Directory
¾ ENVIRONMENT: Environment File Specification
¾ ERRORFILE: Error Filename Specification
¾ GENPATH: #include "File" Path
¾ INCLUDETIME: Creation Time in Object File
¾ LIBRARYPATH:  include <File>° Path
¾ OBJPATH: Object File Path
¾ TEXTPATH: Text File Path
¾ TMP: Temporary Directory
¾ USELIBPATH: Using LIBPATH Environment Variable
¾ USERNAME: User Name in Object File

5.7.1 COMPOPTIONS: Default Compiler Options

Tools

Compiler

Synonym

HICOMPOPTIONS

Syntax

COMPOPTIONS={<option>} 

Arguments

<option>: Compiler command-line option

Default

None

Description

Set this environment variable to instruct the Compiler to append its contents to the
command line each time a file is compiled. Use this environment variable to specify
global options that should always be set. This frees you from having to specify them for
every compilation.

Environment Variable Details
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NOTE
We do not recommend using this environment variable if the
Compiler used is version 5.x, because it adds the specified
options to the options stored in the project.ini file.

Listing: Setting Default Values for Environment Variables (Not Recommended)
COMPOPTIONS=-W2 -Wpd

See also

Compiler Options

5.7.2 COPYRIGHT: Copyright Entry in Object File

Tools

Compiler, Assembler, Linker, or Librarian

Synonym

None

Syntax

  COPYRIGHT=<copyright> 
  

Arguments

< copyright>: copyright entry

Default

None

Description

Each object file contains an entry for a copyright string. The decode retrieves this
information from the object files.

Example

  COPYRIGHT=Copyright by Freescale 
  

See also
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environmental variables :

¾ USERNAME: User Name in Object File
¾ INCLUDETIME: Creation Time in Object File

5.7.3 DEFAULTDIR: Default Current Directory

Tools

Compiler, Assembler, Linker, Decoder, Debugger, Librarian, Maker, or Burner

Synonym

None

Syntax
  DEFAULTDIR=<directory>  

Arguments

< directory>: Directory to be the default current directory

Default

None

Description

Specifies the default directory for all tools. All the tools indicated above take the
specified directory as their current directory instead of the directory defined by the
operating system or launching tool.

NOTE
This is an environment variable on a system level (global
environment variable). It cannot be specified in a default
environment file ( default.env).

Specify the default directory for all tools in the CodeWarrior suite:
  DEFAULTDIR=C:\INSTALL\PROJECT  

See also

Current Directory

Global Initialization File (mcutools.ini)

Environment Variable Details
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5.7.4 ENVIRONMENT: Environment File Specification

Tools

Compiler, Linker, Decoder, Debugger, Librarian, Maker, or Burner

Synonym

HIENVIRONMENT

Syntax
  ENVIRONMENT=<file>  

Arguments

<file>: filename with path specification, without spaces

Default

None

Description

This variable is specified on a system level. The application looks in the current directory
for an environment file named default.env. Use ENVIRONMENT (for example, set in the
autoexec.bat (DOS) or *.cshrc (UNIX)), to specify a different filename.

NOTE
This system level (global) environment variable cannot be
specified in a default environment file ( default.env).

Example

ENVIRONMENT=\Freescale\prog\global.env

5.7.5 ERRORFILE: Error Filename Specification

Tools

Compiler, Assembler, Linker, or Burner

Synonym

None
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Syntax
  ERRORFILE=<filename>   

Arguments

<filename>: filename with possible format specifiers

Description

The ERRORFILE environment variable specifies the name for the error file.

Possible format specifiers are:

%n: Substitute with the filename, without the path.

%p: Substitute with the path of the source file.

%f: Substitute with the full filename, i.e., with the path and name (the same as %p%n).

A notification box displays in the event of an improper error filename.

Examples
  ERRORFILE=MyErrors.err   

Writes all errors into the MyErrors.err file in the current directory.
  ERRORFILE=\tmp\errors   

Writes all errors into the errors file in the \tmp directory.
  ERRORFILE=%f.err  

Writes all errors into a file with the same name as the source file, but with the *.err
extension, into the same directory as the source file. Using this format, compiling a file
named test.c in the sources directory ( \sources\test.c) generates an error list file named
test.err in the sources directory ( \sources\test.err).
  ERRORFILE=\dir1\%n.err   

Writes all errors into a file in the dir1 directory. Compiling a source file named test.c
generates an error list file named \dir1\test.err.
  ERRORFILE=%p\errors.txt   

Writes all errors into a text file in the same directory as the compiled file. Compiling a
source file named \dir1\dir2\test.c generates an error list file with the name
\dir1\dir2\errors.txt.

Unless you set the ERRORFILE environment variable, the compiler writes errors to the EDOUT
file in the current directory.

Environment Variable Details
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5.7.6 GENPATH: #include "File" Path

Tools

Compiler, Linker, Decoder, Debugger, or Burner

Synonym

HIPATH

Syntax
  GENPATH={<path>} 
  

Arguments

<path>: Paths separated by semicolons, without spaces

Default

Current directory

Description

Including a header file with double quotes makes the Compiler search first in the current
directory, then in the directories listed by GENPATH, and finally in the directories listed by
LIBRARYPATH.

NOTE
If a directory specification in this environment variable starts
with an asterisk ( * ), the compiler searches the whole directory
tree recursively depth first, i.e., all subdirectories and their
subdirectories and so on are searched. Search order of the
subdirectories is indeterminate within one level in the tree.

Example
  GENPATH=\sources\include;..\..\headers;\usr\local\lib 
  

See also

LIBRARYPATH:  include <File>° Path environment variable
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5.7.7 INCLUDETIME: Creation Time in Object File

Tools

Compiler, Assembler, Linker, or Librarian

Synonym

None

Syntax
  INCLUDETIME=(ON|OFF)   

Arguments

ON: Include time information into object file

OFF: Do not include time information into object file

Default

ON

Description

Each object file contains a time stamp indicating the creation time and date as strings.
When a tool creates a new file, the file gets a new time stamp entry.

This behavior may be undesired if you must perform a binary file compare for Software
Quality Assurance reasons. Even if the information in two object files is the same, the
files do not match exactly as the time stamps are not identical. To avoid such problems,
set this variable to OFF. When set to OFF, the time-stamp strings in the object file for date
and time are "none" in the object file.

Retrieve the time stamp from the object files using the decoder.

Example

INCLUDETIME=OFF

See also
¾ COPYRIGHT: Copyright Entry in Object File
¾ USERNAME: User Name in Object File

5.7.8 LIBRARYPATH: °include <File>  Path

Environment Variable Details
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Tools

Compiler, Burner, Linker, Decoder

Synonym

LIBPATH

Syntax
  LIBRARYPATH={<path>}  

Arguments

< path>: Paths separated by semicolons, without spaces

Default

Current directory

Description

Including a header file with double quotes makes the Compiler search first in the current
directory, then in the directories given by GENPATH, and finally in the directories given by
LIBRARYPATH (see GENPATH: #include "File" Path LIBRARYPATH:  include <File>°
Path).

NOTE
If a directory specification in this environment variable starts
with an asterisk ( * ), the compiler searches the whole directory
tree recursively depth first, i.e., all subdirectories and their
subdirectories and so on are searched. Search order of the
subdirectories is indeterminate within one level in the tree.

Example

LIBRARYPATH=\sources\include;.\.\headers;\usr\local\lib

See also

GENPATH: #include "File" Path environment variable

USELIBPATH: Using LIBPATH Environment Variable

Input Files

5.7.9 OBJPATH: Object File Path
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Tools

Compiler, Linker, Decoder, Debugger, Burner

Synonym

None

Syntax
  OBJPATH=<path> 
  

Default

Current directory

Arguments

<path>: Path without spaces

Description

The Compiler places generated object files into the directory specified by OBJPATH. If this
environment variable is empty or does not exist, the compiler places the object file in the
same directory as the source code.

If the Compiler tries to generate an object file into the directory specified by this
environment variable but fails (for example, because the file is locked), the Compiler
issues an error message.

If a tool looks for an object file, it first checks for an object file specified by this
environment variable, then in GENPATH, and finally in HIPATH (refer GENPATH: #include
"File" Path, HIPATH).

Example

OBJPATH=\sources\obj

See also

Output Files

5.7.10 TEXTPATH: Text File Path

Tools

Compiler, Linker, Decoder

Environment Variable Details
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Synonym

None

Syntax
  TEXTPATH=<path>   

Arguments

<path>: Path without spaces

Default

Current directory

Description

The Compiler places generated text files into the directory specified by TEXTPATH. If this
environment variable is empty or does not exist, the compiler stores the text file into the
current directory.

Example
  TEXTPATH=\sources\txt   

See also

Output Files

Compiler options :

¾ -Li: List of Included Files to ".inc" File
¾ -Lm: List of Included Files in Make Format
¾ -Lo: Append Object File Name to List (enter [<files>])

5.7.11 TMP: Temporary Directory

Tools

Compiler, Assembler, Linker, Debugger, Librarian

Synonym

None

Syntax
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  TMP=<directory> 
  

Arguments

<directory>: Directory to be used for temporary files

Default

None

Description

The compiler uses the ANSI function, tmpnam(), to create temporary files. This library
function stores the temporary files in the directory specified by the TMP environment
variable. If the variable is empty or does not exist, the compiler uses the current directory.
Check this variable if you get the error message "Cannot create temporary file".

NOTE
This is a system level (global) environment variable. It cannot
be specified in a default environment file ( default.env).

Example

TMP=C:\TEMP

See also

Current Directory

5.7.12 USELIBPATH: Using LIBPATH Environment Variable

Tools

Compiler, Linker, or Debugger

Synonym

None

Syntax
  USELIBPATH=(OFF|ON|NO|YES)   

Arguments

ON, YES: The Compiler uses the environment variable LIBRARYPATH to look for system header
files <*.h>.

Environment Variable Details

CodeWarrior Development Studio for Microcontrollers V10.x HC(S)08 Build Tools Reference Manual, Rev.
10.6, 01/2014

158 Freescale Semiconductor, Inc.



NO, OFF: The Compiler does not use the environment variable LIBRARYPATH.

Default

ON

Description

This environment variable allows a flexible usage of the LIBRARYPATH environment variable
as the LIBRARYPATH variable might be used by other software (for example, version
management PVCS).

Example

USELIBPATH=ON

See also

LIBRARYPATH:  include <File>° Path environment variable

5.7.13 USERNAME: User Name in Object File

Tools

Compiler, Assembler, Linker, Librarian

Synonym

None

Syntax
  USERNAME=<user>   

Arguments

<user>: Name of user

Default

None

Description

Each object file contains an entry identifying the creator the object file. Retrieve this
information from the object files by using the decoder.

Example
  USERNAME=The Master   
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See also

environment variables :

¾ COPYRIGHT: Copyright Entry in Object File
¾ INCLUDETIME: Creation Time in Object File

Environment Variable Details
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Chapter 6
Files

This chapter describes the input and output files that the Compiler uses, and file
processing. It has the following sections:

¾ Input Files
¾ Output Files
¾ File Processing

6.1 Input Files

This section describes the following input files:

¾ Source Files
¾ Include Files

6.1.1 Source Files

The compiler°s frontend takes any file as input. It does not require the filename to have a
special extension. However, it is suggested that all your source filenames use the *.c
extension and that all header files use the *.h extension. The Compiler searches for so
urce files first in theCurrent Directory and then in the GENPATH directory (refer
GENPATH: #include "File" Path).

6.1.2 Include Files
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The search for include files is governed by two environment variables: GENPATH: #include
"File" Path and LIBRARYPATH:  include <File>° Path. Include files are included using
double quotes or angle brackets.

When you use double quotes to include files ( #include "test.h"), the compiler searches
first in the current directory, then in the directory specified by the -I option (refer -I:
Include File Path), then in the directories given in the GENPATH environment variable (refer
GENPATH: #include "File" Path), and finally in those listed in the LIBPATH or LIBRARYPATH:
  include <File>° Path environment variable. Set the current directory using the IDE, the
Program Manager, or the DEFAULTDIR environment variable (refer DEFAULTDIR: Default
Current Directory).

When you use angle brackets to include files ( #include <stdio.h>), the compiler searches
first in the current directory, then in the directory specified by the -I option, and then in
the directories given in LIBPATH or LIBRARYPATH. Set the current directory using the IDE, the
Program Manager, or the DEFAULTDIR environment variable.

6.2 Output Files

This section describes the following output files:

¾ Object Files
¾ Error Listing

6.2.1 Object Files

After successful compilation, the Compiler generates an object file containing the target
code as well as some debugging information. The compiler writes this file to the
directory listed in the OBJPATH environment variable (refer OBJPATH: Object File Path). If
that variable contains more than one path, the compiler writes the object file in the first
listed directory. If this variable is not set, the compiler writes the object file in the same
directory as the source code file. Object files always get the extension *.o.

6.2.2 Error Listing

Output Files
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If the Compiler detects any errors, it creates an error listing file named err.txt instead of
an object file. The compiler generates this file in the same directory as the source code
file (refer ERRORFILE: Error Filename Specification).

The open Compiler window displays the full path of all header files read. After
successful compilation the window also displays the number of code bytes generated and
the number of global objects written to the object file.

If you start the Compiler from an IDE (with °%f° given on the command line) or
CodeWright (with °%b%e° given on the command line), the Compiler does not produce the
err.txt error file. Instead, the Compiler writes the error messages in a special format in a
file called EDOUT using the default Microsoft format. You may use the CodeWrights° Find
Next Error command to display both the error positions and the error messages.

6.2.2.1 Interactive Mode (Compiler Window Open)

If you set ERRORFILE, the Compiler creates a message file named as specified in this
environment variable.

If you do not set ERRORFILE, the Compiler generates a default file named err.txt in the
current directory.

6.2.2.2 Batch Mode (Compiler Window Not Open)

If you set ERRORFILE, the Compiler creates a message file named as specified in this
environment variable.

If you do not set ERRORFILE, the Compiler generates a default file named EDOUT in the
current directory.

6.3 File Processing

The following figure shows how file processing occurs with the Compiler:
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Figure 6-1. Files Used with the Compiler

File Processing
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Chapter 7
Compiler Options

This chapter describes the arguments that modify how the compiler reads source files,
processes them, and outputs object code. It consists of the following major sections:

¾ Option Recommendations : Suggests some compiler settings that produce efficient
code or make it easier to debug.

¾ Compiler Option Details : Describes the layout and format of the compiler
command-line options covered in the remainder of the chapter.

The Compiler provides a number of options that control its operation. Options consist of
a minus sign or dash ( - ) prefix, followed by one or more letters or digits. The Compiler
treats anything lacking the prefix as a source file to compile. You can specify Compiler
options on the command line or in the COMPOPTIONS variable. Specify each Compiler option
only once per compilation.

Command line options are not case-sensitive, for example, "- Li" is the same as "-li".

NOTE
It is not possible to combine options from different groups. For
example, "- Cc - Li" cannot be abbreviated by the terms "- Cci"
or "- CcLi".

You can also use the GUI to set the Compiler options, as shown in the following figure.

NOTE
If you use the GUI to set the Compiler options, do not use the
COMPOPTIONS environment variable. The Compiler stores the
options in the project.ini file, not in the default.env file.
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Figure 7-1. HC08 Compiler Option Settings Dialog Box

Use the Message Settings dialog box, shown in the following figure, to move messages
( -Wmsg options).

Figure 7-2. Message Settings Dialog Box

7.1 Option Recommendations
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Depending on the compiled source code files, each Compiler option has advantages or
disadvantages. We recommend the following:

¾ When using the HIWARE Object-file Format and the -Cc: Allocate Const Objects
into ROM compiler option, specify ROM_VAR in the Linker parameter file.

¾ -Wpd: Error for Implicit Parameter Declaration
¾ -Or: Register Optimization whenever available or possible

The default configuration enables most options in the Compiler. If the default options
cause problems in your code (for example, they make the code hard to debug), disable the
options (these options usually have the -On prefix). Candidates for such options are
peephole options.

Some options produce more code for some functions than for others (for example, -Oi:
Inlining or -Cu: Loop Unrolling). On the other hand, inlining functions, while producing
more code, also make it execute faster because there°s not overhead in performing a
function call. Vary your option choices to find the best result for each function.

To get the best results for each function, compile each module with the -OdocF option
(refer -OdocF: Dynamic Option Configuration for Functions). An example of this option
is -OdocF="-Or".

For compilers with the ICG optimization engine, the following option combination
provides the best results:
  -Ona -OdocF="-Onca|-One|-Or"   

7.2 Compiler Option Details

This section describes the option groups in detail, plus the layout and format of each
option. This section covers the following topics:

¾ Option Groups
¾ Option Scopes
¾ Option Detail Description

7.2.1 Option Groups

Compiler options are grouped by:

¾ HOST
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¾ LANGUAGE
¾ OPTIMIZATIONS
¾ CODE GENERATION
¾ OUTPUT
¾ INPUT
¾ MESSAGES
¾ VARIOUS
¾ STARTUP

NOTE
The option in the Various group do not appear in the HC08
Compiler Option Settings dialog box, however the
options are displayed as a part of the compiler option list
when using the -H option.

Refer to the following table for description of each of the groups.

Specify options in the STARTUP group on the command line to start the tool. Options in
the STARTUP group cannot be specified interactively.

Table 7-1. Compiler Option Groups

Group Description

HOST Lists options related to the host

LANGUAGE Lists options related to the programming language (for
example, ANSI-C)

OPTIMIZATIONS Lists optimization options

OUTPUT Lists options related to the output files generation (i.e., which
kind of file to generate)

INPUT Lists options related to the input file

CODE GENERATION Lists options related to code generation (memory models,
float format, etc.)

MESSAGES Lists options controlling error message generation

VARIOUS Lists various options

STARTUP Lists options specified only on tool startup

Each group corresponds to the property sheets of the graphical option settings.

NOTE
Not all command line options are accessible through the
property sheets as they have a special graphical setting (for
example, the option to set the type sizes).

Compiler Option Details

CodeWarrior Development Studio for Microcontrollers V10.x HC(S)08 Build Tools Reference Manual, Rev.
10.6, 01/2014

168 Freescale Semiconductor, Inc.



7.2.2 Option Scopes

Each option has a scope. Refer the following table.

Table 7-2. Option Scopes

Scope Description

Application Set the option for all files (Compilation Units) of an
application. A typical example is an option to set the memory
model. Mixing object files has unpredictable results.

Compilation Unit Set this option differently for each compilation unit for an
application. Mixing objects in an application is possible.

Function Set the option differently for each function. Use a function
option with the option: -OdocF= "<option>".

None The option scope is not related to a specific code part. Typical
examples are the message management options.

The available options are arranged into different groups. Each group has its own sheet.
The content of the list box depends on the selected sheets.

7.2.3 Option Detail Description

The remainder of this section describes the Compiler options in alphabetical order. The
following table describes the information available for each option.

NOTE
Not all tools options have been defined for this release. All
descriptions will be available in an upcoming release.

Table 7-3. Compiler Option-Documentation Topics
Topic Description

Group Specifies HOST, LANGUAGE, OPTIMIZATIONS, OUTPUT,
INPUT, CODE GENERATION, MESSAGES or VARIOUS.

Scope Specifies Application, Compilation Unit, Function or None

Syntax Specifies the syntax of the option in an EBNF format

Arguments Describes and lists optional and required arguments for the
option

Default Shows the default setting for the option

Defines Lists defines related to the compiler option

Pragma Lists pragmas related to the compiler option

Description Provides a detailed description of the option and how to use it

Table continues on the next page...
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Table 7-3. Compiler Option-Documentation Topics (continued)

Topic Description

Example Gives an example of usage and effects of the option where
possible. Displays compiler settings, source code and Linker
PRM files when applicable. The example shows an entry in
the default.env for a PC.

See also Names related options

7.2.3.1 Using Special Modifiers

You can use special modifiers with some options. However, some modifiers may not
make sense for all options. This section describes those modifiers.

The following table lists the supported modifiers:

Table 7-4. Compiler Option Modifiers

Modifier Description

%p Path including file separator

%N Filename in strict 8.3 format

%n Filename without extension

%E Extension in strict 8.3 format

%e Extension

%f Path + filename without extension

%" A double quote (") if the filename, the path or the extension
contains a space

%° A single quote ( ) if the filename, the path or the extension
contains a space

%(ENV) Use the contents of an environment variable

%% Generates a single  %°

7.2.3.1.1 Example

For the following examples, the actual base filename for the modifiers is: C:\Freescale\my
demo\TheWholeThing.myExt.

The %p modifier gives the path only with a file separator:
     C:\Freescale\my demo\  
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Using the %N modifier results in a filename in 8.3 format (that is, the name with only eight
characters):
     TheWhole  

The %n modifier returns the whole the filename without extension:
     TheWholeThing  

The %E modifier gives the extension in 8.3 format (that is, the extension with only three
characters):
     myE  

Use the %e modifier to get the whole extension:
     myExt  

The %f modifier gives the path plus the filename:
     C:\Freescale\my demo\TheWholeThing  

When the path contains a space, we recommend using %" or %°. Thus, %"%f%" gives (using
double quotes):
     "C:\Freescale\my demo\TheWholeThing"  

Using %°%f%° gives (using single quotes):
      C:\Freescale\my demo\TheWholeThing°  

The modifier %(envVariable) uses an environment variable. The Compiler ignores a file
separator following %(envVariable) if the environment variable is empty or non-existent. In
other words, if you set TEXTPATH to:
     TEXTPATH=C:\Freescale\txt,   

the Compiler replaces:
     %(TEXTPATH)\myfile.txt   

with:
     C:\Freescale\txt\myfile.txt  

But if TEXTPATH is empty or non-existent, the Compiler replaces:
    %(TEXTPATH)\myfile.txt  

with:
     myfile.txt  

Use the %% modifier to print a percent sign. Using %e%% gives:
     myExt%  
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The following table lists the command-line options for the HCS08 compiler:

Table 7-5. Compiler Command-line Options
-!: Filenames are clipped to DOS Length

-AddIncl: Additional Include File

-Ansi: Strict ANSI

-ArgFile: Specify a file from which additional command line options will be read

-Asr: It is Assumed that HLI Code Saves Written Registers

-BfaB: Bitfield Byte Allocation

-BfaGapLimitBits: Bitfield Gap Limit

-BfaTSR: Bitfield Type Size Reduction

-C++ (-C++f, -C++e, -C++c): C++ Support

-Cc: Allocate Const Objects into ROM

-Ccx: Cosmic Compatibility Mode for Space Modifiers and Interrupt Handlers

-Ci: Bigraph and Trigraph Support

-Cn[={Vf|Tpl|Ptm...}]: Disable compactC++ features

-Cni: No Integral Promotion on Characters

-Cppc: C++ Comments in ANSI-C

-Cq: Propagate const and volatile Qualifiers for Structs

-C[s08|08]: Generate Code for Specific HC08 Families

-CswMaxLF: Maximum Load Factor for Switch Tables

-CswMinLB: Minimum Number of Labels for Switch Tables

-CswMinLF: Minimum Load Factor for Switch Tables

-CswMinSLB: Minimum Number of Labels for Switch Search Tables

-Cu: Loop Unrolling

-Cx: Switch Off Code Generation

-D: Macro Definition

-Ec: Conversion from °const T*° to °T*°

-Eencrypt: Encrypt Files

-Ekey: Encryption Key

-Env: Set Environment Variable

-F (-Fh, -F1, -F1o, -F2, -F2o,-F6, or -F7): Object-File Format

-Fd: Double is IEEE32

-H: Short Help

-I: Include File Path

-La: Generate Assembler Include File

-Lasm: Generate Listing File

-Lasmc: Configure Listing File

-Ldf: Log Predefined Defines to File

-Li: List of Included Files to ".inc" File

-Lic: License Information

-LicA: License Information about Every Feature in Directory

Table continues on the next page...
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Table 7-5. Compiler Command-line Options (continued)
-LicBorrow: Borrow License Feature

-LicWait: Wait until Floating License is Available from Floating Li- cense Server

-Ll: Write Statistics Output to File

-Lm: List of Included Files in Make Format

-LmCfg: Configuration for List of Included Files in Make Format (option -Lm)

-Lo: Append Object File Name to List (enter [<files>])

-Lp: Preprocessor Output

-LpCfg: Preprocessor Output Configuration

-LpX: Stop after Preprocessor

-M (-Mb, -Ms, -Mt): Memory Model

-MMU: Enable Memory Management Unit (MMU) Support

-N: Show Notification Box in Case of Errors

-NoBeep: No Beep in Case of an Error

-NoClrVol: Do not use CLR for volatile variables in the direct page

-NoDebugInfo: Do not Generate Debug Information

-NoEnv: Do Not Use Environment

-NoPath: Strip Path Info

-O(-Os, -Ot): Main Optimization Target

-O0 : Disable Optimizations

-Obfv: Optimize Bitfields and Volatile Bitfields

-ObjN: Object File Name Specification

-Oc: Common Subexpression Elimination (CSE)

-OdocF: Dynamic Option Configuration for Functions

-Of and-Onf: Create Sub-Functions with Common Code

-Oi: Inlining

-Oilib: Optimize Library Functions

-Ol: Try to Keep Loop Induction Variables in Registers

-Ona: Disable Alias Checking

-OnB: Disable Branch Optimizer

-Onbf: Disable Optimize Bitfields

-Onbt: Disable ICG Level Branch Tail Merging

-Onca: Disable any Constant Folding

-Oncn: Disable Constant Folding in Case of a New Constant

-OnCopyDown: Do Generate Copy Down Information for Zero Values

-OnCstVar: Disable CONST Variable by Constant Replacement

-One: Disable any Low Level Common Subexpression Elimination

-OnP: Disable Peephole Optimization

-OnPMNC: Disable Code Generation for NULL Pointer to Member Check

-Ont: Disable Tree Optimizer

-OnX: Disable Frame Pointer Optimization

Table continues on the next page...
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Table 7-5. Compiler Command-line Options (continued)
-Or: Allocate Local Variables into Registers

-Ous, -Ou, and -Onu: Optimize Dead Assignments

-Pe: Do Not Preprocess Escape Sequences in Strings with Absolute DOS Paths

-Pio: Include Files Only Once

-Prod: Specify Project File at Startup

-Qvtp: Qualifier for Virtual Table Pointers

-Rp (-Rpe, -Rpt): Large Return Value Type

-T: Flexible Type Management

-V: Prints the Compiler Version

-View: Application Standard Occurrence

-WErrFile: Create "err.log" Error File

-Wmsg8x3: Cut Filenames in Microsoft Format to 8.3

-WmsgCE: RGB Color for Error Messages

-WmsgCF: RGB Color for Fatal Messages

-WmsgCI: RGB Color for Information Messages

-WmsgCU: RGB Color for User Messages

-WmsgCW: RGB Color for Warning Messages

-WmsgFb (-WmsgFbv, -WmsgFbm): Set Message File Format for Batch Mode

-WmsgFi (-WmsgFiv, -WmsgFim): Set Message Format for Interactive Mode

-WmsgFob: Message Format for Batch Mode

-WmsgFoi: Message Format for Interactive Mode

-WmsgFonf: Message Format for No File Information

-WmsgFonp: Message Format for No Position Information

-WmsgNe: Maximum Number of Error Messages (enter <number>)

-WmsgNi: Maximum Number of Information Messages (enter <number>)

-WmsgNu: Disable User Messages

-WmsgNw: Maximum Number of Warning Messages (enter <number>)

-WmsgSd: Setting a Message to Disable

-WmsgSe: Setting a Message to Error

-WmsgSi: Setting a Message to Information

-WmsgSw: Setting a Message to Warning

-WOutFile: Create Error Listing File

-Wpd: Error for Implicit Parameter Declaration

-WStdout: Write to Standard Output

-W1: Don°t Print Information Messages

-W2: Do not Print INFORMATION or WARNING Messages

7.2.3.1.2 -!: Filenames are clipped to DOS Length
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Group

INPUT

Scope

Compilation Unit

Syntax

  -!
  
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description

Use this option, called cut, when compiling files copied from an MS-DOS file system.
Filenames are clipped to eight characters ( DOS length). The cut option truncates the
filename in the following include directive:

Listing: Example of the Cut Option (-!)

#include "mylongfilename.h"
to:

#include "mylongfi.h"

7.2.3.1.3 -AddIncl: Additional Include File

Group

INPUT

Scope
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Compilation Unit

Syntax

-AddIncl"<fileName>" 

Arguments

<fileName>: name of file to include

Default

None

Defines

None

Pragmas

None

Description

This option includes the specified file at the beginning of the compilation unit. It has the
same effect as writing the file at the beginning of the compilation unit using double
quotes (".."):

#include "my headerfile.h"

Refer the following listing for the -AddIncl compiler option syntax to include the above
header file.

Listing: Syntax Example for Including a Header File
-AddIncl"my headerfile.h"

See also

-I: Include File Path compiler option

7.2.3.1.4 -Ansi: Strict ANSI

Group

LANGUAGE

Scope
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Function

Syntax

  -Ansi
  
  

Arguments

None

Default

None

Defines

__STDC__

Pragmas

None

Description

The -Ansi option forces the Compiler to follow strict ANSI C language conversions.
When you specify -Ansi, the Compiler refuses all non-ANSI-compliant keywords (for
example, __asm, __far and __near), and generates an error.

The ANSI-C compiler also does not allow C++ style comments (those started with //).
To allow C++ comments, even with -Ansi set, set the -Cppc: C++ Comments in ANSI-C
compiler option.

The asm keyword is also not allowed when -Ansi is set. To use inline assembly, even with
-Ansi set, use __asm instead of asm.

The Compiler defines __STDC__ as 1 if this option is set, or as 0 if this option is not set.

7.2.3.1.5 -ArgFile: Specify a file from which additional command line
options will be read

Group

HOST

Scope

Function
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Syntax

-ArgFile<filename>

Arguments

<filename>: Specify the file containing the options to be passed in the command line.

Description

The options present in the file are appended to existing command line options.

Example

Considering that a file named option.txt is used and that it contains the "-Mt" option then
chc08.exe -ArgFileoption.txt command line will be equivalent to chc08.exe -Mt.

7.2.3.1.6 -Asr: It is Assumed that HLI Code Saves Written Registers

Group

CODE GENERATION

Scope

Function

Syntax

  -Asr
  
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description
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With this option set, the compiler assumes that registers touched in HLI are saved or
restored in the HLI code as well. If this option is not set, the compiler saves and restores
the registers as needed.

Listing: Sample Source Code for the Two Following Examples

void bar(char);
char PORT;

void myfun(void) {

  PORT = 4;

  asm {

    lda   #4

    sta   PORT

  }

  bar(4);

}

Listing: Code Sample Without the -Asr Option

  4:    PORT = 4;
0000 a604             LDA   #4

0002 c70000           STA   PORT

  5:    __asm {

  6:    lda   #4

0005 a604             LDA   #4

  7:    sta   PORT

0007 c70000           STA   PORT

  8:  }

  9:    bar(4);

000a a604             LDA   #4

000c cc0000           JMP   bar

With the -Asr option set (as shown in the following listing), the compiler assumes that the
A register is the same as before the __asm block. However, in our example we do NOT
save or restore the A register, so the compiler generates incorrect code.

Listing: Code Sample With the -Asr Option

  4:    PORT = 4;
0000 a604             LDA   #4
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0002 c70000           STA   PORT

  5:    __asm {

  6:      lda #4

0005 a604             LDA   #4

  7:      sta PORT

0007 c70000           STA   PORT

  8:   }

  9:   bar(4);

000a cc0000           JMP   bar

7.2.3.1.7 -BfaB: Bitfield Byte Allocation

Group

CODE GENERATION

Scope

Function

Syntax

-BfaB(MS|LS) 

Arguments

MS: Most significant bit in byte first (left to right)

LS: Least significant bit in byte first (right to left)

Default

HC08: -BfaBLS 

Defines

__BITFIELD_MSWORD_FIRST__

__BITFIELD_LSWORD_FIRST__

__BITFIELD_MSBYTE_FIRST__

__BITFIELD_LSBYTE_FIRST__

__BITFIELD_MSBIT_FIRST__
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__BITFIELD_LSBIT_FIRST__

Pragmas

None

Description

Normally, bit allocation in byte bitfields proceeds from the least significant bit to the
most significant bit. This produces less code overhead in the case of partially-allocated
byte bitfields.

Example

The following listing uses the default condition and uses the three least significant bits.

Listing: Changing the Allocation Order Example

struct {unsigned char b: 3; } B;   // the default is using the 3 least significant bits 

This allows a mask operation without any shift to access the bitfield.

To change this allocation order, use the -BfaBMS or -BfaBLS options shown in the following
listing.

Listing: Changing the Allocation Order Example

struct {
  char b1:1;

  char b2:1;

  char b3:1;

  char b4:1;

  char b5:1;

} myBitfield;

  7                   0

  --------------------

  |b1|b2|b3|b4|b5|####|  (-BfaBMS)

  --------------------

  7                  0

  --------------------

  |####|b5|b4|b3|b2|b1|  (-BfaBLS)

  --------------------

See also

Chapter 7 Compiler Options

CodeWarrior Development Studio for Microcontrollers V10.x HC(S)08 Build Tools Reference Manual, Rev.
10.6, 01/2014

Freescale Semiconductor, Inc. 181



Bitfield Allocation

7.2.3.1.8 -BfaGapLimitBits: Bitfield Gap Limit

Group

CODE GENERATION

Scope

Function

Syntax

  -BfaGapLimitBits<number> 
  

Arguments

<number>: positive number, there should be less than <number> bits in the gap (that is, at
most <number>-1 bits)

Default

1

Defines

None

Pragmas

None

Description

The bitfield allocation tries to avoid crossing a byte boundary whenever possible. To
achieve optimized accesses, the compiler may insert some padding or gap bits to reach
this. This option enables you to affect the maximum number of gap bits allowed.

Example

In the example shown in the listing below, assume that you have specified a 3-bit
maximum gap, that is, -BfaGapLimitBits3.

Listing: Bitfield Allocation

struct {
  unsigned char a: 7;
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  unsigned char b: 5;

  
unsigned char c: 4;

} B;

The compiler allocates struct B with 3 bytes. First, the compiler allocates the 7 bits of a.
Then the compiler tries to allocate the 5 bits of b, but this would cross a byte boundary.
Because the gap of 1 bit is smaller than the specified gap of 3 bits, b is allocated in the
next byte. Then the allocation starts for c. After the allocation of b there are 3 bits left.
Because the gap is 3 bits, c is allocated in the next byte. If the maximum gap size were
specified to 0, all 16 bits of B would be allocated in two bytes. Since the gap limit is set
to 3, and the gap required for allocating c in the next byte is also 3, the compiler will use
a 16-bit word as allocation unit. Both b and c will be allocated within this word.

Assuming we initialize an instance of B as below:

B s = {2, 7, 5},

we get the following memory layouts:

-BfaGapLimitBits1 : 53 82

- BfaGapLimitBits3 : 02 00 A7

-BfaGapLimitBits4 : 02 07 05

See also

Bitfield Allocation

7.2.3.1.9 -BfaTSR: Bitfield Type Size Reduction

Group

CODE GENERATION

Scope

Function

Syntax

-BfaTSR[ON|OFF] 

Arguments

ON: Bit Field Type Size Reduction enabled
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OFF: Bit Field Type-Size Reduction disabled

Default

HC08: -BfaTSRON 

Defines

 __BITFIELD_TYPE_SIZE_REDUCTION__ 

 __BITFIELD_NO_TYPE_SIZE_REDUCTION__ 

Pragmas

None

Description

This option is available whether or not the compiler uses type-size reduction for bitfields.
Type-size reduction means that the compiler reduces the type of an int bitfield to a char
bitfield if the int bitfield fits into a character. Type-size reduction allows the compiler to
allocate memory only for one byte instead of for an integer.

Examples

The following listings demonstrate the effects of -BfaTSRoff and -BfaTSRon, respectively.

Listing: -BfaTSRoff

struct{
  long b1:4;

  long b2:4;

} myBitfield;

31                       7  3  0

--------------------------------

|########################|b2|b1| -BfaTSRoff

--------------------------------

Listing: -BfaTSRon

7   3    0
----------

|b2 | b1 | -BfaTSRon

----------
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Example

-BfaTSRon 

See also

Bitfield Type Reduction

7.2.3.1.10 -C++ (-C++f, -C++e, -C++c): C++ Support

Group

LANGUAGE

Scope

Compilation Unit

Syntax

  -C++ (f|e|c)

  

Arguments

f : Full ANSI Draft C++ support

e : Embedded C++ support (EC++)

c : compactC++ support (cC++)

Default

None

Defines

  __cplusplus

  

Pragmas

None

Description

With this option enabled, the Compiler behaves as a C++ Compiler. You can choose
between three different types of C++:
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¾ Full ANSI Draft C++ supports the whole C++ language.
¾ Embedded C++ (EC++) supports a constant subset of the C++ language. EC++ does

not support inefficient items like templates, multiple inheritance, virtual base classes
and exception handling.

¾ compactC++ (cC++) supports a configurable subset of the C++ language. You can
configure this subset with the option -Cn.

If the option is not set, the Compiler behaves as an ANSI-C Compiler.

If the option is enabled and the source file name extension is *.c, the Compiler behaves as
a C++ Compiler.

If the option is not set, but the source-filename extension is *.cpp or *.cxx, the Compiler
behaves as if the -C++f option is set.

Example

  COMPOPTIONS=-C++f

  

7.2.3.1.11 -Cc: Allocate Const Objects into ROM

Group

OUTPUT

Scope

Compilation Unit

Syntax

  -Cc 
  

Arguments

None

Default

None

Defines

None

Pragmas
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#pragma INTO_ROM: Put Next Variable Definition into ROM

Description

The -Cc command line option puts const objects into the ROM_VAR segment, which the
Linker parameter file assigns to a ROM section (refer Linker section in the Build Tool
Utilities Reference Manual).

NOTE
Use this option only for HIWARE object-file formats. In the
ELF/DWARF object-file format, the Compiler allocates
constants into the .rodata section.

The Linker does not initialize objects allocated into a read-only section. The startup code
does not have to copy the constant data.

You may also put variables into the ROM_VAR segment by using the segment pragma (refer
Linker section in the Build Tool Utilities manual). Using the #pragma CONST_SECTION for
constant-segment allocation, the Compiler allocates const variables into the ROM_VAR
segment.

If the current data segment is not the default segment, const objects remain in the user-
defined segment. If the data segment contains onlyconst objects, the Compiler may
allocate the segment to a ROM memory section (refer to the Linker section in the Build
Tool Utilities Reference Manual for more information).

NOTE
The Compiler uses the default addressing mode for the
constants specified by the memory model.

Example

The following listing shows how the -Cc compiler option affects the SECTIONS segment of a
PRM file (HIWARE object-file format only).

Listing: Constant Objects into ROM

SECTIONS
  MY_ROM  READ_ONLY     0x1000 TO 0x2000

PLACEMENT

  DEFAULT_ROM, ROM_VAR  INTO MY_ROM

See also

Segmentation

Linker Manual
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-F (-Fh, -F1, -F1o, -F2, -F2o,-F6, or -F7): Object-File Format option

#pragma INTO_ROM: Put Next Variable Definition into ROM

7.2.3.1.12 -Ccx: Cosmic Compatibility Mode for Space Modifiers and
Interrupt Handlers

Group

LANGUAGE

Scope

Compilation Unit

Syntax

  -Ccx 
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description

This option allows you to use Cosmic style @near, @far and @tiny space modifiers as well
as @interrupt in your C code. You must switch the -ANSI option off before using this
option. It is not necessary to remove the Cosmic space modifiers from your application
code. You do not need to place the objects in sections addressable by the Cosmic space
modifiers.

When the Compiler parses a Cosmic modifier, the following occurs:

¾ The Compiler always allocates the declared objects in a special Cosmic compatibility
( _CX...) section, regardless of which section pragmas are set. The target compatibility
section used depends on the space modifier, the const qualifier, and whether the code
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line is a function or a variable. Refer to the following table for object placement
information.

¾ Space modifiers on the left hand side of a pointer declaration specify the pointer type
and pointer size, depending on the target.

Refer example in the following listing for a PRM file showing section placement for the
sections in the following table.

Table 7-6. Cosmic Modifier Handling

Definition Placement to _CX section

@tiny int my_var _CX_DATA_TINY

@near int my_var _CX_DATA_NEAR

@far int my_var _CX_DATA_FAR

const @tiny int my_cvar _CX_CONST_TINY

const @near int my_cvar _CX_CONST_NEAR

const @far int my_cvar _CX_CONST_FAR

@tiny void my_fun(void) _CX_CODE_TINY

@near void my_fun(void) _CX_CODE_NEAR

@far void my_fun(void) _CX_CODE_FAR

@interrupt void my_fun(void) _CX_CODE_INTERRUPT

For further information about porting applications from Cosmic to CodeWarrior IDE
refer to technical note TN234 located at <CodeWarrior for Microcontrollers V6.x
Installation>\Help\PDF. The following table gives an overview of HC(S)08 space-
modifier mapping.

Table 7-7. Cosmic Space Modifier Mapping for HC(S)08

Definition Keyword Mapping

@tiny __near

@near __far

@far __far

Refer the following listing for an example of the -Ccx compiler option.

Listing: Cosmic Space Modifiers

volatile @tiny char tiny_ch;
extern @far const int table[100];

static @tiny char * @near ptr_tab[10];

typedef @far int (*@far funptr)(void);

funptr my_fun;  /* banked and __far calling conv. */
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char @tiny *tptr = &tiny_ch;

char @far  *fptr = (char @far *)&tiny_ch;

Example for a prm file: 

(16- and 24-bit addressable ROM;

 8-, 16- and 24-bit addressable RAM)

SEGMENTS

  MY_ROM   READ_ONLY     0x2000   TO 0x7FFF;

  MY_BANK  READ_ONLY     0x508000 TO 0x50BFFF;

  MY_ZP    READ_WRITE    0xC0     TO 0xFF;

  MY_RAM   READ_WRITE    0xC000   TO 0xCFFF;

  MY_DBANK READ_WRITE    0x108000 TO 0x10BFFF;

END

PLACEMENT

  DEFAULT_ROM, ROM_VAR, 

  _CX_CODE_NEAR, _CX_CODE_TINY, _CX_CONST_TINY,

  _CX_CONST_NEAR               INTO MY_ROM;

  _CX_CODE_FAR, _CX_CONST_FAR  INTO MY_BANK;

  DEFAULT_RAM, _CX_DATA_NEAR   INTO MY_RAM;

  _CX_DATA_FAR                 INTO MY_DBANK;

  _ZEROPAGE, _CX_DATA_TINY     INTO MY_ZP;

END

See also

Cosmic Manuals, Build Tools Utilities Reference Manual, TN234

7.2.3.1.13 -Ci: Bigraph and Trigraph Support

Group

LANGUAGE

Scope

Function

Syntax

  -Ci 
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Arguments

None

Default

None

Defines

  __TRIGRAPHS__ 
  

Pragmas

None

Description

If certain tokens are not available on your keyboard, replace them with the keywords
shown in the following table.

Table 7-8. Keyword Alternatives for Unavailable Tokens

Bigraph Keyword Token Replaced Trigraph
Keyword

Token Replaced Additional
Keyword

Token Replaced

<% } ??= # and &&

%> } ??/ \ and_eq &=

<: [ ??° ^ bitand &

:> ] ??( [ bitor |

%: # ??) ] compl ~

%:%: ## ??! | not !

??< { or ||

??> } or_eq |=

??- ~ xor ^

xor_eq ^=

not_eq !=

NOTE
Additional keywords are not allowed as identifiers if this option
is enabled.

Example

  -Ci 
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The example in the following listing shows the use of trigraphs, bigraphs and the
additional keywords with the corresponding  normal° C source code.

Listing: Trigraphs, Bigraphs, and Additional Keywords
int Trigraphs(int argc, char * argv??(??)) ??<
  if (argc<1 ??!??! *argv??(1??)==°??/0°) return 0;

  printf("Hello, %s??/n", argv??(1??));

??>

%:define TEST_NEW_THIS 5

%:define cat(a,b) a%:%:b

??=define arraycheck(a,b,c) a??(i??) ??!??! b??(i??)

int i;

int cat(a,b);

char a<:10:>;

char b<:10:>;

void Trigraph2(void) <%

  if (i and ab) <%

    i and_eq TEST_NEW_THIS;

    i = i bitand 0x03;

    i = i bitor 0x8;

    i = compl i;

    i = not i;

  %> else if (ab or i) <%

    i or_eq 0x5;

    i = i xor 0x12;

    i xor_eq 99;

  %> else if (i not_eq 5) <%

    cat(a,b) = 5;

    if (a??(i??) || b[i])<%%>

    if (arraycheck(a,b,i)) <%

      i = 0;

    %>

  %>

%>

/* is the same as ... */ 

int Trigraphs(int argc, char * argv[]) {
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  if (argc<1 || *argv[1]==°\0°) return 0;

  printf("Hello, %s\n", argv[1]);

}

#define TEST_NEW_THIS 5

#define cat(a,b) a##b

#define arraycheck(a,b,c) a[i] || b[i]

int i;

int cat(a,b);

char a[10];

char b[10];

void Trigraph2(void){

  if (i && ab) {

    i &= TEST_NEW_THIS;

    i = i & 0x03;

    i = i | 0x8;

    i = ~i;

    i = !i;

  } else if (ab || i) {

    i |= 0x5;

    i = i ^ 0x12;

    i ^= 99;

  } else if (i != 5) {

    cat(a,b) = 5;

    if (a[i] || b[i]){}

    if (arraycheck(a,b,i)) {

      i = 0;

    }

  }

}

7.2.3.1.14 -Cn[={Vf|Tpl|Ptm...}]: Disable compactC++ features

Group

LANGUAGE
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Scope

Function

Description

Use this option to disable compactC++ fetaures.

7.2.3.1.15 -Cni: No Integral Promotion on Characters

Group

OPTIMIZATIONS

Scope

Function

Syntax

  -Cni 
  

Arguments

None

Default

None

Defines

__CNI__

Pragmas

None

Description

The -Cni option enhances character operation code density by omitting integral
promotion. This option enables behavior that is not ANSI-C compliant.

In ANSI-C operations with data types, anything smaller than int must be promoted to int
(integral promotion). With this rule, adding two unsigned character variables causes the
Compiler to zero-extend each character operand, and add them as int operands. Integral
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promotion is unnecessary when the result will be stored as a character. Using this option,
the Compiler avoids promotion when possible. Performing operations on a character base
instead of an integer base may decrease code size.

In most expressions, ANSI-C requires char type variables to be extended to the next
larger type int, which requires a 16-bit size, according to ANSI standard. The -Cni option
suppresses this ANSI-C behavior and thus allows the use of °characters° and °character-
sized constants° in expressions.

NOTE
Code generated with this option set does not conform to ANSI
standards. Code compiled with this option is not portable.
Using this option is not recommended in most cases.

The ANSI standard requires that old-style function declarations using the char parameter
be extended to int. The -Cni option disables this extension and saves additional RAM.

Example

Refer the following listing.

Listing: Definition of an Old Style Function using a char Parameter

old_style_func (a, b, c)
  char a, b, c;

{

  ...

}

The space reserved for a, b, and c is one byte each, instead of two.

For expressions containing different types of variables, the following conversion rules
apply:

¾ If both variables are of type signed char, the expression is evaluated signed.
¾ If one of two variables is of type unsigned char, the expression is evaluated unsigned,

regardless of whether the other variable is of type signed or unsigned char.
¾ If one operand is of another type than signed or unsigned char, the usual ANSI-C

arithmetic conversions are applied.
¾ If constants are in the character range, they are treated as characters. Remember that

the char type is signed and applies to the constants -128 to 127. All constants greater
than 127 are treated as integers. To treat them as characters, cast them as characters
(as shown in the following listing).
Listing: Casting Integers to Signed char
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signed char a, b;
if (a > b * (signed char)129)

NOTE
This option is ignored when the - Ansi Compiler switch is
active.

7.2.3.1.16 -Cppc: C++ Comments in ANSI-C

Group

LANGUAGE

Scope

Function

Syntax

  -Cppc 
  

Arguments

None

Default

By default, the Compiler does not allow C++ comments if the -Ansi: Strict ANSI
compiler option is set.

Defines

None

Pragmas

None

Description

The -Ansi option forces the compiler to conform to the ANSI-C standard. Because a strict
ANSI-C compiler rejects any C++ comments (started with //), use this option to allow C
++ comments (as shown in the following listing).

Listing: Using -Cppc to Allow C++ Comments
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-Cppc /* This allows the code containing C++ comments to be compiled with

   the 
-Ansi option set */

void myfun(void) // this is a C++ comment

See also

-Ansi: Strict ANSI compiler option

7.2.3.1.17 -Cq: Propagate const and volatile Qualifiers for Structs

Group

LANGUAGE

Scope

Application

Syntax

  -Cq
  
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description

This option propagates const and volatile qualifiers for structures. That means if all
members of a structure are constant, the structure itself is constant as well. The same
happens with the volatile qualifier. If the structure is declared as constant or volatile, all
members are constant or volatile.

Example
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The source code in the following listing declares two structs, each of which has a const
member.

Listing: Declaring Two structs

struct {
  const field;

} s1, s2;

void myfun(void) {

  s1 = s2; // struct copy

  s1.field = 3; // error: modifiable lvalue expected

}

In the above example, the field in the struct is constant, but not the struct itself. Thus the
struct copy  s1 = s2° is legal, even if the field of the struct is constant. But a write access
to the struct field causes an error message. Using the -Cq option propagates the
qualification ( const) of the fields to the whole struct or array. In the above example, the
struct copy causes an error message.

7.2.3.1.18 -C[s08|08]: Generate Code for Specific HC08 Families

Group

CODE GENERATION

Scope

Compilation Unit

Syntax

  -Cs08
  
  

Arguments

s08: HCS08 family

08: HC08 family

Default

-C08

Defines
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__HCS08__

Pragmas

None

Description

Setting this option generates code for the HC(S)08 family. In addition, using this option
allows all new HC(S)08 operation-operand combinations in the HLI.

Example

  __asm LDHX 2,X;

  

7.2.3.1.19 -CswMaxLF: Maximum Load Factor for Switch Tables

Group

CODE GENERATION

Scope

Function

Syntax

  -CswMaxLF<number> 
  

Arguments

<number>: a number in the range of 0 to 100 denoting the maximum load factor.

Default

Backend-dependent.

Defines

None

Pragmas

None

Description
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Using this option changes the default strategy of the Compiler to use tables for switch
statements.

NOTE
This option is only available if the compiler supports switch
tables.

Normally the Compiler uses a table for switches with more than about eight labels,
provided the table is between 80% (minimum load factor of 80) and 100% (maximum
load factor of 100) full. If there are not enough labels for a table or the table is not filled,
the Compiler generates a branch tree (tree of if-else-if-else). This branch tree, like an
 unrolled° binary search in a table, quickly evaluates the associated label for a switch
expression.

Using a branch tree instead of a table improves code execution speed, but may increase
code size. In addition, because the branch tree itself uses no special runtime routine for
switch expression evaluation, debugging may be more seamless.

Specifying a load factor means that tables generate in specific  fuel° status:

Listing: Specifying Table Load Factor

switch(i) {
  case 0: ...

  case 1: ...

  case 2: ...

  case 3: ...

  case 4: ...

//  case 5: ...

  case 6: ...

  case 7: ...

  case 8: ...

  case 9: ...

  default

}

The above table is filled to 90% (labels for  0° to  9°, except for  5°). Setting the minimum
load factor to 50% and the maximum load factor for the above case to 80%, a branch tree
generates instead a table. But setting the maximum load factor to 95% produces a table.

To guarantee that tables generated for full switch tables only, set the table minimum and
maximum load factors to 100:
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-CswMinLF100 -CswMaxLF100.

See also

Compiler options:

¾ -CswMinLB: Minimum Number of Labels for Switch Tables
¾ Option -CswMinSLB: Minimum Number of Labels for Switch Search Tables
¾ -CswMinLF: Minimum Load Factor for Switch Tables

7.2.3.1.20 -CswMinLB: Minimum Number of Labels for Switch Tables

Group

CODE GENERATION

Scope

Function

Syntax

  -CswMinLB<number> 
  

Arguments

<number>: a positive number denoting the number of labels.

Default

Backend-dependent

Defines

None

Pragmas

None

Description

Using this option changes the default strategy of the Compiler to use tables for switch
statements.

NOTE
This option is only available if the compiler supports switch
tables.
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Normally the Compiler uses a table for switches with more than about eight labels. When
there are not enough labels for a table, the Compiler generates a branch tree (tree of if-
else-if-else). This branch tree, like an  unrolled° binary search in a table, quickly
evaluates the associated label for a switch expression.

Using a branch tree instead of a table may increase the code execution speed, but
probably increases the code size also. In addition, because the branch tree itself uses no
special runtime routine for switch expression evaluation, debugging may be much easier.

To disable any tables for switch statements, set the minimum number of labels needed for
a table to a high value (for example, 9999):

-CswMinLB9999 -CswMinSLB9999.

When disabling simple tables it usually makes sense also to disable search tables with the
-CswMinSLB option.

See also

Compiler options :

¾ -CswMinLF: Minimum Load Factor for Switch Tables
¾ -CswMinSLB: Minimum Number of Labels for Switch Search Tables
¾ -CswMaxLF: Maximum Load Factor for Switch Tables

7.2.3.1.21 -CswMinLF: Minimum Load Factor for Switch Tables

Group

CODE GENERATION

Scope

Function

Syntax

  -CswMinLF<number> 
  

Arguments

<number>: a number in the range of 0 - 100 denoting the minimum load factor

Default

Backend-dependent
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Defines

None

Pragmas

None

Description

Allows the Compiler to use tables for switch statements.

NOTE
This option is only available if the compiler supports switch
tables.

Normally the Compiler uses a table for switches with more than about eight labels,
provided the table is between 80% (minimum load factor of 80) and 100% (maximum
load factor of 100) full. If there are not enough labels for a table or the table is not full,
the Compiler generates a branch tree (tree of if-else-if-else). This branch tree, like an
 unrolled° binary search in a table, quickly evaluates the associated label for a switch
expression.

Using a branch tree instead of a table improves code execution speed, but may increase
code size. In addition, because the branch tree itself uses no special runtime routine for
switch expression evaluation, debugging is more seamless.

Specifying a load factor means that tables generate in specific  fuel° status:

Listing: Specifying Table Load Factor

switch(i) {
  case 0: ...

  case 1: ...

  case 2: ...

  case 3: ...

  case 4: ...

  //  case 5: ...

  case 6: ...

  case 7: ...

  case 8: ...

  case 9: ...

  default

}
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The above table is 90% full (labels for  0° to  9°, except for  5°). Setting the maximum
load factor to 100% and the minimum load factor for the above case to 90%, this still
generates a table. But setting the minimum load factor to 95% produces a branch tree.

To guarantee that tables generate for full switch tables only, set the minimum and
maximum table load factors to 100:

-CswMinLF100 -CswMaxLF100.

See also

Compiler options :

¾ -CswMinLB: Minimum Number of Labels for Switch Tables
¾ -CswMinSLB: Minimum Number of Labels for Switch Search Tables
¾ -CswMaxLF: Maximum Load Factor for Switch Tables

7.2.3.1.22 -CswMinSLB: Minimum Number of Labels for Switch Search
Tables

Group

CODE GENERATION

Scope

Function

Syntax

  -CswMinSLB<number> 
  

Arguments

<number>: a positive number denoting the number of labels

Default

Backend-dependent

Defines

None

Pragmas

None
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Description

Allows the Compiler to use tables for switch statements.

NOTE
This option is only available if the compiler supports search
tables.

The Compiler implements switch tables in different ways. When almost all case entries in
some range are given, the Compiler uses a table containing only branch targets. Densely
populated branch target tables improve efficiency because the Compiler accesses only the
correct entry. When large holes exist in some areas, a table form can still be used.

Encoding the case entry and its corresponding branch target into a table creates a search
table. Accessing a search table requires a complex runtime routine to check all entries
until it finds the matching one. Search tables execute slowly.

Using a search table improves code density, but the execution time increases. Every data
request from a search table requires checking every entry until the correct entry is
located. For a dense table, the compiler computes the right offset and accesses the table.
In addition, note that all backends that implement search tables use a complex runtime
routine. This complicates debugging.

To disable search tables for switch statements, set the minimum number of labels needed
for a table to a high value (for example, 9999): -CswMinSLB9999.

See also

Compiler options :

¾ -CswMinLB: Minimum Number of Labels for Switch Tables
¾ -CswMinLF: Minimum Load Factor for Switch Tables
¾ -CswMaxLF: Maximum Load Factor for Switch Tables

7.2.3.1.23 -Cu: Loop Unrolling

Group

OPTIMIZATIONS

Scope

Function

Syntax

-Cu[=i<number>] 
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Arguments

<number>: number of iterations for unrolling, between 0 and 1024

Default

None

Defines

None

Pragmas

#pragma LOOP_UNROLL: Force Loop Unrolling

#pragma NO_LOOP_UNROLL: Disable Loop Unrolling

Description

Enables loop unrolling with the following restrictions:

¾ Only simple for statements are unrolled, for example,

for (i=0; i<10; i++)

¾ Initialization and test of the loop counter must be done with a constant.
¾ Only <, >, <=, >= are permitted in a condition.
¾ Only ++ or -- are allowed for the loop variable increment or decrement.
¾ The loop counter must be integral.
¾ No change of the loop counter is allowed within the loop.
¾ The loop counter must not be used on the left side of an assignment.
¾ No address operator (&) is allowed on the loop counter within the loop.
¾ Only small loops are unrolled:

¾ Loops with few statements within the loop.
¾ Loops with fewer than 16 increments or decrements of the loop counter. The

bound may be changed with the optional argument = i<number>. The -Cu=i20
option unrolls loops with a maximum of 20 iterations.

Examples
Listing: for Loop

-Cu int i, j;

j = 0;

for (i=0; i<3; i++) {

  j += i;

}
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With the -Cu compiler option given, the Compiler issues an information message
°Unrolling loop° and transforms this loop as shown in the following listing.

Listing: for Loop

j += 1;
j += 2;

i  = 3;

The Compiler also transforms some special loops, i.e., loops with a constant condition or
loops with only one pass:

Listing: Example for Loop with a Constant Condition

for (i=1; i>3; i++) {
  j += i;

}

The Compiler issues an information message °Constant condition found, removing loop°
and transforms the loop into a simple assignment, because the loop body is never
executed:

i=1;

Listing: Example for Loop with Only One Pass

for (i=1; i<2; i++) {
  j += i;

}

Because the loop body is executed only once, the Compiler issues a warning °Unrolling
loop° and transforms the for loop into:

j += 1;

i  = 2;

7.2.3.1.24 -Cx: Switch Off Code Generation

Group

CODE GENERATION
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Scope

Compilation Unit

Syntax

  -Cx
  
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description

The -Cx Compiler option disables the code generation process of the Compiler. The
Compiler generates no object code, although the Compiler performs a syntactical check
of the source code. This allows you to check your source code for errors without
generating object code.

7.2.3.1.25 -D: Macro Definition

Group

LANGUAGE

Scope

Compilation Unit

Syntax

  -D<identifier>[=<value>]
  
  

Arguments
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<identifier>: identifier to be defined

<value>: value for <identifier>, anything except "-" and blank

Default

None

Defines

None

Pragmas

None

Description

The Compiler allows the definition of a macro on the command line. The effect is the
same as having a # define directive at the very beginning of the source file.

Listing: DEBUG Macro Definition

-DDEBUG=0
This is the same as writing:

#define DEBUG 0

in the source file.

To include strings with blanks in your macro definition, either use an escape sequence or
use double quotes.

  -dPath="Path\40with\40spaces"
  
  

  -d"Path=""Path with spaces"""
  
  

NOTE
Blanks are not allowed after the -D option; the first blank
terminates this option. Also, macro parameters are not
supported.

7.2.3.1.26 -Ec: Conversion from  const T*  to  T* 

Group

Chapter 7 Compiler Options

CodeWarrior Development Studio for Microcontrollers V10.x HC(S)08 Build Tools Reference Manual, Rev.
10.6, 01/2014

Freescale Semiconductor, Inc. 209



LANGUAGE

Scope

Function

Syntax

  -Ec
  
  

Arguments

None

Default

None

Description

Enabling this non-ANSI compliant extension allows the compiler to treat a pointer to a
constant type like a pointer to the non-constant equivalent of the type. Earlier Compilers
did not check a store to a constant object through a pointer. This option is useful when
compiling older source code.

Listing: Converting  const T*° to  T*°

void f() {
  int *i;

  const int *j;

  i=j; /* C++ illegal, but with -Ec ok! */

}

struct A {

  int i;

};

void g() {

  const struct A *a;

  a->i=3; /* ANSI C/C++ illegal, but with -Ec ok! */

}

void h() {

  const int *i;

  *i=23; /* ANSI-C/C++ illegal, but with -Ec ok! */
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}

Defines

None

Pragmas

None

Listing: Example

-Ec
void myfun(const int *p){

  *p = 0; // some Compilers do not issue an error

7.2.3.1.27 -Eencrypt: Encrypt Files

Group

OUTPUT

Scope

Compilation Unit

Syntax

  -Eencrypt[=<filename>] 
  

Arguments

<filename>: The name of the file to be generated

It may contain special modifiers (refer Using Special Modifiers).

Default

The default filename is %f.e%e. A file named   myfun.c° creates an encrypted file named  
myfun.ec°.

Description

This option encrypts all files passed together with this option, using the given key with
the -Ekey option (refer -Ekey: Encryption Key).

Chapter 7 Compiler Options

CodeWarrior Development Studio for Microcontrollers V10.x HC(S)08 Build Tools Reference Manual, Rev.
10.6, 01/2014

Freescale Semiconductor, Inc. 211



NOTE
This option is only available or operative with a license for the
following feature: HIxxxx30, where xxxx is the feature number of
the compiler for a specific target.

Defines

None

Pragmas

None

Example

  myfun.c myfun.h -Ekey1234567 -Eencrypt=%n.e%e 
  

This encrypts the   myfun.c° file using the 1234567 key to the   myfun.ec° file and the   myfun.h°
file to the   myfun.eh° file.

The encrypted myfun.ec and myfun.eh files may be passed to a client. The client can compile
the encrypted files without the key by compiling the following file:

myfun.ec

See also

-Ekey: Encryption Key

7.2.3.1.28 -Ekey: Encryption Key

Group

OUTPUT

Scope

Compilation Unit

Syntax

  -Ekey<keyNumber> 
  

Arguments

<keyNumber>

Default
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The default encryption key is  0°. Using this default is not recommended.

Description

Use this option to encrypt files with the given key number ( -Eencrypt option).

NOTE
This option is only available or operative with a license for the
following feature: HIxxxx30, where xxxx is the feature number of
the compiler for a specific target.

Defines

None

Pragmas

None

Example

  myfun.c -Ekey1234567 -Eencrypt=%n.e%e

  

This encrypts the   myfun.c° file using the 1234567 key.

See also

-Eencrypt: Encrypt Files

7.2.3.1.29 -Env: Set Environment Variable

Group

HOST

Scope

Compilation Unit

Syntax

  -Env<Environment Variable>=<Variable Setting> 
  

Arguments

<Environment Variable>: Environment variable to be set

Chapter 7 Compiler Options

CodeWarrior Development Studio for Microcontrollers V10.x HC(S)08 Build Tools Reference Manual, Rev.
10.6, 01/2014

Freescale Semiconductor, Inc. 213



<Variable Setting>: Setting of the environment variable

Default

None

Description

This option sets an environment variable. Use this environment variable in the maker, or
use to overwrite system environment variables.

Defines

None

Pragmas

None

Example

  -EnvOBJPATH=\sources\obj 
  

This is the same as:

  OBJPATH=\sources\obj

  

in the default.env file.

Use the following syntax to use an environment variable that uses filenames with spaces:

  -Env"OBJPATH=\program files"

  

See also

Environment

7.2.3.1.30 -F (-Fh, -F1, -F1o, -F2, -F2o,-F6, or -F7): Object-File Format

Group

OUTPUT

Scope

Application
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Syntax

  -F(1|1o|2|2o|6|7|h)
  
  

Arguments

h: HIWARE object-file format

1: ELF/DWARF 1.1 object-file format

1o: compatible ELF/DWARF 1.1 object-file format

2: ELF/DWARF 2.0 object-file format

2o: compatible ELF/DWARF 2.0 object-file format

6: strict HIWARE V2.6 object-file format

7: strict HIWARE V2.7 object-file format

NOTE
Not all object-file formats may be available for a target.

Default

  -Fh
  
  

Defines

  
  __HIWARE_OBJECT_FILE_FORMAT__
  
  

__ELF_OBJECT_FILE_FORMAT__

Pragmas

None

Description

The Compiler writes the code and debugging info into an object file after compilation.

The Compiler uses a HIWARE-proprietary object-file format when the -Fh, -F6 or -F7
options are set.

The HIWARE Object-file Format ( -Fh) has the following limitations:

¾ The type char is limited to a size of 1 byte.
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¾ Symbolic debugging for enumerations is limited to 16-bit signed enumerations.
¾ No zero bytes in strings are allowed (a zero byte marks the end of the string).

The HIWARE V2.7 Object-file Format (option -F7) has some limitations:

¾ The type char is limited to a size of 1 byte.
¾ Enumerations are limited to a size of 2 bytes and must be signed.
¾ No symbolic debugging for enumerations.
¾ The standard type short is encoded as int in the object-file format.
¾ No zero bytes in strings allowed (a zero byte marks the end of the string).

The Compiler produces an ELF/DWARF object file when the -F1 or -F2 options are set.
This object-file format may also be supported by other Compiler vendors.

In the Compiler ELF/DWARF 2.0 output, some constructs written in previous versions
did not conform to the ELF standard because the standard was not clear enough in this
area. Because old versions of the simulator or debugger (V5.2 or earlier) are not able to
load the corrected format, the old behavior can still be produced by using -f2o instead of -
f2. Some old versions of the debugger (simulator or debugger V5.2 or earlier) generate a
GPF when a new absolute file is loaded. To use the older versions, use -f2o instead of -f2.
New versions of the debugger can load both formats correctly. Also, some older ELF/
DWARF object file loaders from emulator vendors may require you to set the -F2o option.

The -F1o option is only supported if the target supports the ELF/DWARF 1.1 format. This
option is only used with older debugger versions as a compatibility option. This option
may be discontinued in the future. We recommend that you use -F1 instead.

We recommend that you use the ELF/DWARF 2.0 format instead of the ELF/DWARF
1.1. The 2.0 format is much more generic. In addition, it supports multiple include files
plus modifications of the basic generic types (for example, floating point format). Debug
information is also more robust.

7.2.3.1.31 -Fd: Double is IEEE32

Group

CODE GENERATION

Scope

Application

Syntax

Compiler Option Details

CodeWarrior Development Studio for Microcontrollers V10.x HC(S)08 Build Tools Reference Manual, Rev.
10.6, 01/2014

216 Freescale Semiconductor, Inc.



  -Fd
  
  

Arguments

None

Default

None

Defines

Refer -T: Flexible Type Management

Pragmas

See -T

Description

Allows you to change the float or double format. By default, float is IEEE32 and doubles
are IEEE64.

When you set this option, all doubles are in IEEE32 instead of IEEE64.

Floating point formats may be also changed with the -T option.

7.2.3.1.32 -H: Short Help

Group

VARIOUS

Scope

None

Syntax
  -H   

Arguments

None

Default

None

Defines
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None

Pragmas

None

Description

The -H option causes the Compiler to display a short help list of available options within
the Compiler window. Options are grouped into HOST, LANGUAGE,
OPTIMIZATIONS, OUTPUT, INPUT, CODE GENERATION, MESSAGES, and
VARIOUS.

Do not specify any other option or source file when the invoking -H option.

Example

The following listing shows the short list options.

Listing: Short Help Options
-H may produce the following list:
INPUT:

-!     Filenames are clipped to DOS length

-I     Include file path

VARIOUS:

-H     Prints this list of options

-V     Prints the Compiler version

7.2.3.1.33 -I: Include File Path

Group

INPUT

Scope

Compilation Unit

Syntax

  -I<path> 
  

Arguments

<path>: path, terminated by a space or end-of-line
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Default

None

Defines

None

Pragmas

None

Description

Allows you to set include paths in addition to the LIBPATH, LIBRARYPATH, and GENPATH
environment variables (refer LIBRARYPATH:  include <File>° Path and GENPATH:
#include "File" Path). Paths specified with this option have precedence over includes in
the current directory, and over paths specified in GENPATH, LIBPATH, and LIBRARYPATH.

Example

  -I. -I..\h -I\src\include 
  

This directs the Compiler to search for header files first in the current directory ( . ), then
relative from the current directory in °..\h°, and then in °\src\include°. If the file is not
found, the search continues with GENPATH, LIBPATH and LIBRARYPATH for header files in double
quotes ( #include"headerfile.h"), and with LIBPATH and LIBRARYPATH for header files in angular
brackets ( #include <stdio.h>).

See also

Input Files

-AddIncl: Additional Include File

LIBRARYPATH:  include <File>° Path

GENPATH: #include "File" Path

7.2.3.1.34 -La: Generate Assembler Include File

Group

OUTPUT

Scope

Function
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Syntax

  -La[=<filename>] 
  

Arguments

<filename>: The name of the file to be generated

It may contain special modifiers (refer Using Special Modifiers)

Default

No file created

Defines

None

Pragmas

None

Description

The -La option causes the Compiler to generate an assembler include file when the
CREATE_ASM_LISTING pragma occurs. This option specifies the name of the created file. If no
name is specified, the compiler takes a default of %f.inc. To put the file into the directory
specified by the TEXTPATH: Text File Path environment variable, use the option -la=
%n.inc. The %f option already contains the path of the source file. When you use %f, the
compiler puts the generated file in the same directory as the source file.

The content of all modifiers refers to the main input file and not to the actual header file.
The main input file is the one specified on the command line.

Example

-La=asm.inc

See also

#pragma CREATE_ASM_LISTING: Create an Assembler Include File Listing

TEXTPATH: Text File Path

7.2.3.1.35 -Lasm: Generate Listing File

Group
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OUTPUT

Scope

Function

Syntax

  -Lasm[=<filename>] 
  

Arguments

<filename>: The name of the file to be generated.

It may contain special modifiers (refer Using Special Modifiers).

Default

No file created.

Defines

None

Pragmas

None

Description

The -Lasm option causes the Compiler to generate an assembler listing file directly. The
Compiler also prints all assembler-generated instructions to this file. The option specifies
the name of the file. If you do not specify a name, the Compiler takes a default of %n.lst.
If the resulting filename contains no path information the Compiler uses the TEXTPATH
environment variable (refer TEXTPATH: Text File Path).

The syntax does not always conform with the inline assembler or the assembler syntax.
Therefore, use this option only to review the generated code. It cannot currently be used
to generate a file for assembly.

Example

-Lasm=asm.lst

See also

-Lasmc: Configure Listing File
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7.2.3.1.36 -Lasmc: Configure Listing File

Group

OUTPUT

Scope

Function

Syntax

-Lasmc[={a|c|i|s|h|p|e|v|y}]

Arguments

a: Do not write the address in front of every instruction

c: Do not write the hex bytes of the instructions

i: Do not write the decoded instructions

s: Do not write the source code

h: Do not write the function header

p: Do not write the source prolog

e: Do not write the source epilog

v: Do not write the compiler version

y: Do not write cycle information

Default

All printed together with the source

Defines

None

Pragmas

None

Description

The -Lasmc option configures the output format of the listing file generated with the -
Lasm: Generate Listing File option. The addresses, the hex bytes, and the instructions are
selectively switched off.
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The format of the listing file uses the layout shown in the following listing. The letters in
brackets ([]) indicate which suboption to use to switch the instruction off.

Listing: -Lasm Configuration Options

[v] ANSI-C/cC++ Compiler V-5.0.1
[v]

[p]    1:

[p]    2:  void myfun(void) {

[h]

[h] Function: myfun

[h] Source  : C:\Freescale\test.c

[h] Options : -Lasm=%n.lst

[h]

[s]    3:  }

[a]  0000 [c] 3d         [i]  RTS 

[e]    4:

[e]    5:  // comments

[e]    6:

Example

  -Lasmc=ac
  
  

7.2.3.1.37 -Ldf: Log Predefined Defines to File

Group

OUTPUT

Scope

Compilation Unit

Syntax

  -Ldf[=<file>] 
  

Arguments
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<file>: filename for the log file, default is predef.h.

Default

Default <file> is predef.h.

Defines

None

Pragmas

None

Description

The -Ldf option causes the Compiler to generate a text file that contains a list of the
compiler-defined #define. The default filename of predef.h may be changed (for example,
-Ldf="myfile.h"). The Compiler generates the file in the directory specified by the
TEXTPATH environment variable (refer TEXTPATH: Text File Path). The defines
written to this file depend on the actual Compiler option settings (such as type size
settings or ANSI compliance).

NOTE
The defines specified by the command line ( -D: Macro
Definition option) are not included.

This option may be very useful for SQA. With this option it is possible to document
every #define used to compile all sources.

NOTE
This option only has an effect when a file is compiled,
otherwise it has no meaning.

Example

The following listing lists the contents of a file containing define directives.

Listing: Displays the Contents of a File Containing Define Directives

-Ldf This generates the  predef.h° filewith the following content:

/* resolved by preprocessor: __LINE__ */

/* resolved by preprocessor: __FILE__ */

/* resolved by preprocessor: __DATE__ */

/* resolved by preprocessor: __TIME__ */

#define __STDC__ 0
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#define __VERSION__ 5004

#define __VERSION_STR__ "V-5.0.4"

#define __SMALL__

#define __PTR_SIZE_2__

#define __BITFIELD_LSBIT_FIRST__

#define __BITFIELD_MSBYTE_FIRST__

...

See also

-D: Macro Definition

7.2.3.1.38 -Li: List of Included Files to ".inc" File

Group

OUTPUT

Scope

Compilation Unit

Syntax

  -Li 
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description
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The -Li option causes the Compiler to generate a text file which contains a list of the
#include files specified in the source. This text file shares the same name as the source file
but with the extension * .inc. The Compiler stores the file in the path specified by the
TEXTPATH: Text File Path environment variable. The generated file may be used in
make files.

Example

The following listing uses the -Li compiler option to display a file°s contents when that
file contains an included directive.

Listing: Display Contents of a File Containing Include Directives

-Li If the source file is:  C:\myFiles\b.c°:

/* C:\myFiles\b.c */

#include <string.h>

Then the generated file is:

C:\myFiles\b.c :\

C:\Freescale\lib\targetc\include\string.h \

C:\Freescale\lib\targetc\include\libdefs.h \

C:\Freescale\lib\targetc\include\hidef.h \

C:\Freescale\lib\targetc\include\stddef.h \

C:\Freescale\lib\targetc\include\stdtypes.h 

See also

-Lm: List of Included Files in Make Format compiler option

7.2.3.1.39 -Lic: License Information

Group

VARIOUS

Scope

None

Syntax
  -Lic   

Arguments
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None

Default

None

Defines

None

Pragmas

None

Description

The -Lic option prints the current license information. This information also appears in
the About window.

Example

-Lic

See also

Compiler options :

-LicA: License Information about Every Feature in Directory

-LicBorrow: Borrow License Feature

-LicWait: Wait until Floating License is Available from Floating Li- cense Server

7.2.3.1.40 -LicA: License Information about Every Feature in Directory

Group

VARIOUS

Scope

None

Syntax
  -LicA   

Arguments

None

Default
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None

Defines

None

Pragmas

None

Description

The -LicA option prints the license information about every tool or *.dll in the same
directory with the executable file. This takes some time as the option analyzes every file
in the directory.

Example
  -LicA   

See also

Compiler options :

-Lic: License Information

-LicBorrow: Borrow License Feature

-LicWait: Wait until Floating License is Available from Floating Li- cense Server

7.2.3.1.41 -LicBorrow: Borrow License Feature

Group

HOST

Scope

None

Syntax

  -LicBorrow<feature>[;<version>]:<Date> 
  

Arguments

<feature>: the feature name to be borrowed (for example, HI100100).

<version>: optional version of the feature to be borrowed (for example, 3.000).
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<date>: date with optional time specifying when the feature must be returned (for
example, 15-Mar-2005:18:35).

Default

None

Defines

None

Pragmas

None

Description

This option allows you to borrow a license feature until a given date or time. Borrowing
allows you to use a floating license even if disconnected from the floating license server.

Specify the feature name and the date you will return the feature. If the feature you want
to borrow belongs to the tool with which you use this option, then you do not need to
specify the feature version. However, to borrow any other feature, specify the feature
version as well.

Check the status of currently borrowed features in the tool About window.

NOTE
You can only borrow features if you have a floating license
enabled for borrowing. Refer FLEXlm documentation for
details on borrowing.

Example

-LicBorrowHI100100;3.000:12-Mar-2006:18:25

See also

Compiler options:

-LicA: License Information about Every Feature in Directory

-Lic: License Information

-LicWait: Wait until Floating License is Available from Floating Li- cense Server

7.2.3.1.42 -LicWait: Wait until Floating License is Available from Floating
Li- cense Server
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Group

HOST

Scope

None

Syntax

  -LicWait 
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description

By default, if a license is not available from the floating license server, then the
application returns immediately. With -LicWait set, the application waits (blocking) until a
license is available from the floating license server.

Example

  -LicWait

  

See also

Compiler options:

-Lic: License Information

-LicA: License Information about Every Feature in Directory

-LicBorrow: Borrow License Feature
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7.2.3.1.43 -Ll: Write Statistics Output to File

Group

OUTPUT

Scope

Compilation Unit

Syntax

  -Ll[=<filename>]
  
  

Arguments

<filename>: file to be used for the output

Default

The default output filename is logfile.txt

Defines

None

Pragmas

None

Description

Using the -Ll option, the Compiler appends statistical information about the compilation
session to the specified file. The information includes Compiler options, code size (in
bytes), stack usage (in bytes) and compilation time (in seconds) for each procedure of the
compiled file. The Compiler appends the information to the specified filename (or the file
make.txt, if no argument given). Set the TEXTPATH environment variable (refer TEXTPATH:
Text File Path) to store the file into the path specified by the environment variable.
Otherwise the Compiler stores the file in the current directory.

Example

The following listing uses the -L1 compiler options to add statistical information to the
end of an output listing file.

Listing: Statistical Information Appended to Assembler Listing
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-Ll=mylog.txt
/* myfun.c */

int Func1(int b) {

  int a = b+3;

  return a+2;

}

void Func2(void) {

}

Appends the following two lines into mylog.txt:

myfun.c Func1 -Ll=mylog.txt   11  4 0.055000

myfun.c Func2 -Ll=mylog.txt       1  0 0.001000

7.2.3.1.44 -Lm: List of Included Files in Make Format

Group

OUTPUT

Scope

Compilation Unit

Syntax

  -Lm[=<filename>] 
  

Arguments

<filename>: file to be used for the output

Default

The default filename is Make.txt

Defines

None

Pragmas

None

Description
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Using the -Lm option, the Compiler generates a text file containing a list of the #include
files specified in the source. Use the -Lm option when creating make files. The output
from several source files may be copied and grouped into one make file. The generated
list is in the make format. The filename does not include the path. After each entry, an
empty line is added. The Compiler appends the information to the specified filename (or
the file make.txt, if no argument is given). Set the TEXTPATH environment variable (refer
TEXTPATH: Text File Path) to store the file into the path specified by the environment
variable. Otherwise the Compiler stores the file in the current directory.

Example

The example in the following listing shows that the Compiler uses the -Lm option to
generate a make file containing include directives.

Listing: Make File Construction

COMPOTIONS=-Lm=mymake.txt 
Compiling the following sources °myfun.c° and °second.c°:

/* myfun.c */

#include <stddef.h>

#include "myheader.h"

...

/* second.c */

#include "inc.h"

#include "header.h"

...

This adds the following entries in the °mymake.txt°:

myfun.o :     myfun.c stddef.h myheader.h

seconde.o : second.c inc.h header.h

See also

-Li: List of Included Files to ".inc" File

-Lo: Append Object File Name to List (enter [<files>])

Make Utility

7.2.3.1.45 -LmCfg: Configuration for List of Included Files in Make Format
(option -Lm)

Group
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OUTPUT

Scope

Compilation Unit

Syntax

  -LmCfg[={i|l|m|o|u}] 
  

Arguments

i: Write path of included files

l: Use line continuation

m: Write path of main file

o: Write path of object file

u: Update information

x: Unix style paths

Default

None

Defines

None

Pragmas

None

Description

Use this option when configuring the -Lm option (refer -Lm: List of Included Files in
Make Format). -LmCfg operates only when also using the -Lm option. The -Lm option
produces the  dependency° information for a make file. Each dependency information
grouping is structured as shown:

  <main object file>: <main source file> {<included file>}

  

Example

Compile a file named b.c which includes stdio.h. The -Lm option produces the following:

Compiler Option Details

CodeWarrior Development Studio for Microcontrollers V10.x HC(S)08 Build Tools Reference Manual, Rev.
10.6, 01/2014

234 Freescale Semiconductor, Inc.



  b.o: b.c stdio.h stddef.h stdarg.h string.h

  

The suboption,   l°, uses line continuation for each single entry in the dependency list.
This improves readability as shown in the following listing.

Listing: Using Line Continuations for Clarity

b.o: \
  b.c \

  stdio.h \

  stddef.h \

  stdarg.h \

  string.h

Use the suboption   m° to write the full path of the compiled file. This is necessary when
there are files with the same name in different directories:

  b.o: C:\test\b.c stdio.h stddef.h stdarg.h string.h

  

The suboption   o° writes the full name of the target object file:

  C:\test\obj\b.o: b.c stdio.h stddef.h stdarg.h string.h

  

The suboption   i° writes the full path of all included files in the dependency list:

  b.o: b.c C:\Freescale\lib\include\stdio.h 
  C:\Freescale\lib\include\stddef.h 
  C:\Freescale\lib\include\stdarg.h 
  C:\Freescale\lib\include\ 
  C:\Freescale\lib\include\string.h

  

The suboption   u° updates the information in the output file. If the file does not exist, the
Compiler creates the file. If the file exists and the current information is not yet in the
file, the Compiler appends the information to the file. If the information is already
present, the Compiler updates the information. This allows you to specify this suboption
for each compilation ensuring that the make dependency file is always up to date.

Example

  COMPOPTIONS=-LmCfg=u 
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See also

-Li: List of Included Files to ".inc" File

-Lo: Append Object File Name to List (enter [<files>])

-Lm: List of Included Files in Make Format

Make Utility

7.2.3.1.46 -Lo: Append Object File Name to List (enter [<files>])

Group

OUTPUT

Scope

Compilation Unit

Syntax

  -Lo[=<filename>] 
  

Arguments

<filename>: file to be used for the output

Default

The default filename is objlist.txt

Defines

None

Pragmas

None

Description

Using the -Lo option, the Compiler appends the object filename to the list in the specified
file. The Compiler appends the information to the specified filename (or the file make.txt,
if no argument given). Set the TEXTPATH environment variable (refer TEXTPATH: Text
File Path) to store the file into the path specified by the environment variable. Otherwise,
the Compiler stores the file in the current directory.

See also
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-Li: List of Included Files to ".inc" File

-Lm: List of Included Files in Make Format

7.2.3.1.47 -Lp: Preprocessor Output

Group

OUTPUT

Scope

Compilation Unit

Syntax

  -Lp[=<filename>] 
  

Arguments

<filename>: The name of the file to be generated.

It may contain special modifiers (refer Using Special Modifiers).

Default

No file created

Defines

None

Pragmas

None

Description

Using the -Lp option, the Compiler generates a text file containing the preprocessor°s
output. If no filename is specified, the text file shares the same name as the source file
but with the extension, * .PRE ( %n.pre). The Compiler uses the TEXTPATH environment
variable to store the preprocessor file.

The resultant file is a form of the source file, with all preprocessor commands (such as
#include, #define, and #ifdef) resolved. Only source code is listed with line numbers.

See also

-LpX: Stop after Preprocessor
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-LpCfg: Preprocessor Output Configuration

7.2.3.1.48 -LpCfg: Preprocessor Output Configuration

Group

OUTPUT

Scope

Compilation Unit

Syntax

  -LpCfg[={c|e|f|l|m|n|q|s}] 
  

Arguments

s: Reconstruct spaces

q: Handle single quote [°] as normal token

n: No string concatenation

m: Do not emit file names

l: Emit #line directives in preprocessor output

f: Filenames with path

e: Emit empty lines

c: Do not emit line comments

NOTE
It is necessary to use q option when invoking the preprocessor
on linker parameter files ( .prm), because such files may contain
linear address specifiers, for example 0x014000°F.

Default

If -LpCfg is specified, all suboptions (arguments) are enabled

Defines

None

Pragmas
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None

Description

The -LpCfg option specifies source file and -line information formatting in the
preprocessor output. Switching -LpCfg off formats the output as in former compiler
versions. Refer the following table for a list of argument effects.

Table 7-9. Effects of Source and Line Information Format Control Arguments

Argument On Off

c typedef unsigned int
size_t ;typedef signed int
ptrdiff_t ;

/* 22 */ typedef unsignedint
size_t ;/* 35 */ typedef
signedint ptrdiff_t ;

e int j;int i; int j;int i;

f /**** FILE °<CWInstallDir>\MCU
\lib\hc08c\include\hidef.h° */

/**** FILE °hidef.h° */

l #line 1 "hidef.h" /**** FILE °hidef.h° */

n /* 9 */ foo ( "abc" "def" ) ; /* 9 */ foo ( "abcdef" ) ;

m /**** FILE °hidef.h° */

s /* 22 */ typedefunsigned int
size_t;/* 35 */ typedef
signedint ptrdiff_t;/* 44 */
typedefunsigned char wchar_t;

/* 22 */ typedef unsignedint
size_t ;/* 35 */ typedef
signedint ptrdiff_t ;/* 44 */
typedef unsignedchar wchar_t ;

all #line 1 "<CWInstallDir>\MCU
\lib\hc08c\include\hidef.h"

/**** FILE °hidef.h° *//* 20
*/

NOTE
CWInstallDir is the directory in which the CodeWarrior software
is installed.

Example

  -Lpcfg 
  

  -Lpcfg=lfs

  

See also

-Lp: Preprocessor Output

7.2.3.1.49 -LpX: Stop after Preprocessor

Group
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OUTPUT

Scope

Compilation Unit

Syntax

  -LpX 
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description

Without this option, the compiler always translates the preprocessor output as C code. To
do only preprocessing, use this option together with the -Lp option. No object file is
generated.

Example

  -LpX 
  

See also

-Lp: Preprocessor Output

7.2.3.1.50 -M (-Mb, -Ms, -Mt): Memory Model

Group

CODE GENERATION

Scope
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Application

Syntax

  -M(b|s|t)
  
  

Arguments

b: banked memory model

s: small memory model

t: tiny memory model

Default

-Ms

Defines

  __BANKED__
  
  

  
  __SMALL__
  
  

  __TINY__
  
  

Pragmas

#pragma CODE_SEG: Code Segment Definition

Description

The Compiler defaults to the small memory model. The small memory model assumes
that all pointers and functions have 16-bit addresses, and requires code and data to be
located in the 64-kilobyte address space. Specifying the small memory model when -MMU
is enabled causes the Compiler to consider any __far function accessible only through the
code banking mechanism (i.e., using a CALL instruction). The tiny memory model assumes
that data pointers have 8-bit addresses unless explicitly specified with the keyword __far.
The banked memory model is available only when -MMU is enabled. Memory banking
allows you to place program code into at most 256 pages of 16 kilobytes each, but does
not affect data allocation. When using banked mode, the compiler considers all functions
paged functions unless otherwise specified. Refer Memory Models.
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7.2.3.1.51 -MMU: Enable Memory Management Unit (MMU) Support

Group

CODE GENERATION

Scope

Compilation Unit

Syntax

  -MMU
  
  

Arguments

None

Default

None

Defines

  __MMU__

  

Pragmas

None

Description

Setting this option informs the compiler that CALL and RTC instructions are available,
enabling code banking, and that the current architecture has extended data access
capabilities, enabling support for __linear data types. This option can be used only when -
Cs08 is enabled.

Example

  __asm CALL myfun;

  

7.2.3.1.52 -N: Show Notification Box in Case of Errors
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Group

MESSAGES

Scope

Function

Syntax

-N

Arguments

None

Default

None

Defines

None

Pragmas

None

Description

Using this option makes the Compiler display an Alert if an error occurs during
compilation. This is useful when running a make file (refer Make Utility) because the
Compiler waits for you to acknowledge the message, thus suspending make file
processing.

This feature is useful for halting and aborting a build using the Make Utility.

Example

  -N
  
  

If an error occurs during compilation, a dialog similar to the following figure appears.

Figure 7-3. Alert Dialog
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7.2.3.1.53 -NoBeep: No Beep in Case of an Error

Group

MESSAGES

Scope

Function

Syntax

  -NoBeep
  
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description

Use this option to implement a  beep° notification at the end of processing if an error
occurs. To implement a silent error, use this option to switch the beep off.

Example

  -NoBeep
  
  

7.2.3.1.54 -NoClrVol: Do not use CLR for volatile variables in the direct
page

Group

CODE GENERATION
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Syntax

-NoClrVol

Arguments

None

Description

Inhibits the use of CLR for volatile variables in the direct page. The CLR instruction on
HC08 has a read cycle. This may lead to unwanted lateral effects (e.g. if the variable is
mapped over a hardware register).

7.2.3.1.55 -NoDebugInfo: Do not Generate Debug Information

Group

OUTPUT

Scope

None

Syntax

  -NoDebugInfo 
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description

The compiler generates debug information by default. Use this option to prevent
generation of debug information.
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NOTE
To generate an application without debug information in ELF,
the linker provides an option to strip the debug information. By
calling the linker twice, you can generate two versions of the
application: one with and one without debug information. Use
this compiler option only if object files or libraries are to be
distributed without debug info.

NOTE
This option does not affect the generated code. Only the debug
information is excluded.

See also

Compiler options:

-F (-Fh, -F1, -F1o, -F2, -F2o,-F6, or -F7): Object-File Format

-NoPath: Strip Path Info

7.2.3.1.56 -NoEnv: Do Not Use Environment

Group

STARTUP. This option cannot be specified interactively.

Scope

None

Syntax
  -NoEnv   

Arguments

None

Default

None

Defines

None

Pragmas

None
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Description

You can only specify this option at the command line while starting the application. It
cannot be specified in any other way, including via the default.env file, the command line,
or processes.

When you use this option, the application has no environment ( default.env, project.ini, or
tips file) data.

Example
  <compiler>.exe -NoEnv   

Use the compiler executable file name instead of <compiler>.

See also

Local Configuration File

7.2.3.1.57 -NoPath: Strip Path Info

Group

OUTPUT

Scope

Compilation Unit

Syntax

  -NoPath 
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description
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Using this option, you can avoid any path information in object files. This is useful if you
want to move object files to another file location, or hide your path structure.

See also

-NoDebugInfo: Do not Generate Debug Information

7.2.3.1.58 -O(-Os, -Ot): Main Optimization Target

Group

OPTIMIZATIONS

Scope

Function

Syntax

  -O(s|t)
  
  

Arguments

s: Optimize for code size (default)

t: Optimize for execution speed

Default

  -Os
  
  

Defines

  __OPTIMIZE_FOR_SIZE__
  
  

  
  __OPTIMIZE_FOR_TIME__
  
  

Pragmas

None

Description
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At times the Compiler must choose between generating fast, large code, or slow, small
code.

The Compiler generally optimizes on code size. It often decides between a runtime
routine or expanded code. The programmer can decide whether to choose the slower and
shorter or the faster and longer code sequence by setting a command line switch.

The -Os option directs the Compiler to optimize the code for smaller code size. The
Compiler trades faster/larger code for slower/smaller code.

The -Ot option directs the Compiler to optimize the code for faster execution time. The
Compiler trades slower/smaller code for faster/larger code.

NOTE
This option only affects some special code sequences. Set this
option together with other optimization options (such as register
optimization) to get best results.

Example

  -Os

  

7.2.3.1.59 -O0 : Disable Optimizations

Group

OPTIMIZATIONS

Scope

Function

Description

Use this option to disable all optimizations.

7.2.3.1.60 -Obfv: Optimize Bitfields and Volatile Bitfields

Group

OPTIMIZATIONS

Scope
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Function

Syntax

  -Obfv
  
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description

Use this option to optimize bitfields and volatile bitfields. The compiler changes the
access order or combines many accesses into one, even if the bitfields are declared as
volatile.

Example

The following listing contains bitfields to be optimized with the -Obfv compiler option.

Listing: Bitfields Example

volatile struct {
  unsigned int b0:1;

  unsigned int b1:1;

  unsigned int b2:1;

} bf;

void myfun(void) {

  bf.b0 = 1;  bf.b1 = 1;  bf.b2 = 1;

}

Using the -Obfv option, bitfield access looks like:
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  BSET  bf,#7
  
  

Without using the -Obfv option, bitfield access looks like:

  BSET  bf,#1
  
  

  BSET  bf,#2
  
  

  BSET  bf,#4
  
  

7.2.3.1.61 -ObjN: Object File Name Specification

Group

OUTPUT

Scope

Compilation Unit

Syntax

  -ObjN=<file> 
  

Arguments

<file>: Object filename

Default

-ObjN=%(OBJPATH)\%n.o

Defines

None

Pragmas

None

Description
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The object file uses the same name as the processed source file, but with the extension
"*.o". This option allows flexible object filename definition. It may contain special
modifiers (refer Using Special Modifiers). When <file> in the option contains a path
(absolute or relative), the Compiler ignores the OBJPATH environment variable.

Example

  -ObjN=a.out 
  

This example names the resulting object file a.out. Setting the OBJPATH environment
variable to \src\obj results in an object file called \src\obj\a.out.

  fibo.c -ObjN=%n.obj

  

This results in an object file called fibo.obj.

  myfile.c -ObjN=..\objects\_%n.obj

  

The Compiler names the object file relative to the current directory, which results in an
object file called ..\objects\_myfile.obj. The Compiler ignores the OBJPATH environment
variable because the <file> contains a path.

See also

OBJPATH: Object File Path environment variable

7.2.3.1.62 -Oc: Common Subexpression Elimination (CSE)

Group

OPTIMIZATIONS

Scope

Function

Syntax

  -Oc
  
  

Arguments
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None

Default

None

Defines

None

Pragmas

None

Description

This option is disabled and present only for compatibility reasons for the HC(S)08.

Performs common subexpression elimination (CSE). The Compiler generates the code
for common subexpressions and assignments only once and reuses the result. Depending
on available registers, a common subexpression may produce more code due to multiple
spills.

NOTE
When the CSE is switched on, variable changes by aliases may
generate incorrect optimizations.

Example

  -Oc
  
  

In the following listing using the CSE option causes incorrect optimizations. This option
is disabled for the HC(S)08.

Listing: Example of Using CSE and Producing Incorrect Results

void main(void) {
  int x; 

  int *p;

  x = 7;  /* here the value of x is set to 7 */

  p = &x;

  *p = 6;  /* here x is set to 6 by the alias *p */

  /* here x is assumed to be equal to 7 and

     Error is called */

  if(x != 6) Error();
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}

NOTE
This error does not occur if you declare x as volatile.

7.2.3.1.63 -OdocF: Dynamic Option Configuration for Functions

Group

OPTIMIZATIONS

Scope

Function

Syntax

-OdocF="<option>"

Arguments

<option>: Set of options, separated by  |°> to be evaluated for each single function.

Default

None

Defines

None

Pragmas

None

Description

Normally, you must set a specific set of Compiler switches for each compilation unit (file
to be compiled). For some files, a specific set of options may decrease the code size, but
for other files, the same set of Compiler options may produce more code depending on
the sources.

Some optimizations may reduce the code size for some functions, but may increase the
code size for other functions in the same compilation unit. Normally it is impossible to
vary options over different functions, or to find the best combination of options.
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This option allows the Compiler to choose from a set of options to reach the smallest
code size for every function. Without this feature, you must set fixed Compiler switches
over the whole compilation unit. With this feature, the Compiler finds the best option
combination from a user-defined set for every function.

Standard merging rules apply for this option:

-Or -OdocF="-Ocu|-Cu"

This is the same as:

-OrDOCF="-Ouc|-Cu"

The Compiler attempts to find the best combination of the specified options and evaluates
all possible combinations of all specified sets, for example, for the option shown in the
followingthe following listing.

Listing: Example of Dynamic Option Configuration
-W2 -OdocF="-Or|-Cni -Cu|-Oc"

The Compiler evaluates code sizes for the following option combinations:

1. -W2

2. -W2  -Or

3. -W2      -Cni -Cu

4. -W2  -Or -Cni -Cu

5. -W2               -Oc

6. -W2  -Or          -Oc

7. -W2      -Cni -Cu     -Oc

8. -W2  -Or -Cni -Cu       -Oc
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The Compiler evaluates all combinations. Thus, specifying more sets takes more
evaluation time (for example, for five sets 32 evaluations).

NOTE
Do not specify options with scope Application or Compilation
Unit (as memory model, float or double format, or object-file
format) or options for the whole compilation unit (like inlining
or macro definition) in this option. The generated functions
may be incompatible for linking and executing.

Limitations :

¾ The maximum set of options set is limited to five, for example,

-OdocF="-Or -Ou|-Cni|-Cu|-Oic2|-W2 -Ob"

¾ The maximum length of the option is 64 characters.
¾ The feature is available only for functions and function-compatible options.

Example

-Odocf="-Or|-Cni"

7.2.3.1.64 -Of and-Onf: Create Sub-Functions with Common Code

Group

OPTIMIZATIONS

Scope

Function

Syntax

  -O[nf|f]
  
  

Arguments

nf: Disable

f: Enable

Default

-Of default or with -Os, -Onf with -Ot
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Defines

None

Pragmas

None

Description

This option performs the reverse of inlining. It detects common code parts in the
generated code. The Compiler moves the common code to a different place and replaces
all occurrences with a JSR to the moved code. At the end of the common code, the
Compiler inserts an RTS instruction. The Compiler increases all SP uses by an address size.
This optimization takes care of stack allocation, control flow, and functions having
arguments on the stack.

NOTE
Inline assembler code is never treated as common code.

Example

Consider this function:

  void f(int);

  

  void g(void);

  

  void h(void);

  

  void main(void) {

  

    f(1);  f(2);  f(3);

  

    h();

  

    f(1);  f(2);   f(3);
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    g();

  

    f(1);  f(2);

  

  }

  

The compiler first detects that "f(1); f(2); f(3);" occurs twice and places this code
separately. Then the Compiler replaces the two code patterns by a call to the moved code.

The non-C pseudo code (C does not support local functions) in the following code
presents a similar scenario:

  void main(void) {

  

    void tmp0(void) {

  

      f(1);  f(2);  f(3);

  

    }

  

    tmp0();

  

    h();

  

    tmp0();

  

    g();

  

    f(1);  f(2);
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  }

  

In a next step, the compiler detects that the code "f(1); f(2);" occurs twice. The Compiler
generates a second local function:

  void main(void) {

  

    void tmp1(void) {

  

      f(1);  f(2);

  

    }

  

    void tmp0(void) {

  

      tmp1();  f(3);

  

    }

  

    tmp0();

  

    h();

  

    tmp0();

  

    g();

  

    tmp1();
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  }

  

main () calls tmp1 once directly and once indirectly using tmp0. These two call chains use a
different amount of stack. Because of this situation, it is not always possible to generate
correct debug information. For the local function tmp1, the compiler cannot state both
possible SP values, and therefore only states one of them. While debugging the other
state, the debugger declares local variables and the call chain invalid.

Tip
Switch off this optimization to debug your application. The
common code complicates the control flow. Also, the debugger
cannot distinguish between two distinct usages of the same
code. Setting a breakpoint in common code stops the
application and every use of it. It also stops the local variables
and the call frame if not displayed correctly, as explained
above.

Tip
Switch off this optimization to get faster code. For code
density, there are only a few cases that produce slower code.
This situation only occurs when other optimizations (such as
branch tail merging or peepholing) do not find a pattern.

7.2.3.1.65 -Oi: Inlining

Group

OPTIMIZATIONS

Scope

Compilation unit

Syntax

  -Oi[=(c<code Size>|OFF)]
  
  

Arguments

<code Size>: Limit for inlining in code size

OFF: switching off inlining

Compiler Option Details

CodeWarrior Development Studio for Microcontrollers V10.x HC(S)08 Build Tools Reference Manual, Rev.
10.6, 01/2014

260 Freescale Semiconductor, Inc.



Default

None. If no <code Size> is specified, the compiler uses a default code size of 40 bytes.

Defines

None

Pragmas

  #pragma INLINE
  
  

Description

This option enables inline expansion. If there is a #pragma INLINE before a function
definition, the Compiler replaces all calls of this function by the code of this function, if
possible.

Using the option -Oi=c0 switches off inlining. Functions marked with the #pragma INLINE
are still inlined. To disable inlining, use the -Oi=OFF option.

Example

  -Oi
  
  

  #pragma INLINE

  

  static void f(int i) {

  

    /* all calls of function f() are inlined */

  

    /* ... */

  

  }

  

The [ =c<n>] option extension inlines all functions with a size smaller than <n>. For
example, compiling with the option -oi=c100 enables inline expansion for all functions
with a size smaller than 100 bytes.
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Restrictions

The following functions are not inlined:

¾ Functions with default arguments
¾ Functions with labels inside
¾ Functions with an open parameter list (" void f(int i,...);")
¾ Functions with inline assembly statements
¾ Functions using local static objects

7.2.3.1.66 -Oilib: Optimize Library Functions

Group

OPTIMIZATIONS

Scope

Function

Syntax

-Oilib[=<arguments>] 

Arguments

<arguments> are one or several of the following suboptions:

b: inline calls to strlen()

d: inline calls to fabs() or fabsf()

e: inline calls to memset()

f: inline calls to memcpy()

g: replace shifts left of 1 by array lookup

Default

None

Defines

None

Pragmas

None
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Description

This option enables the compiler to optimize specific known library functions to reduce
execution time. The Compiler frequently uses small functions such as strcpy(), strcmp(),
and so forth. The following functions are optimized:

¾ strcpy() (only available for ICG-based backends)
¾ strlen() (for example, strlen("abc"))
¾ abs() or fabs() (for example,  f = fabs(f);°)
¾ memset()

memset() is optimized only if:

¾ the result is not used
¾ memset() is used to zero out
¾ the size for the zero out is in the range 1 to 0xff
¾ the ANSI library header file <string.h> is included

The following code optimizes memset ()

(void)memset(&buf, 0, 50);

In this case, _memset_clear_8bitCount, present in the ANSI library (string.c),
replaces the call to memset().

¾ memcpy()

memcpy() is optimized only if:

¾ the result is not used,
¾ the size for the copy out is in the range 0 - 0xff,
¾ the ANSI library header file <string.h> is included.

The following code optimizes memcpy ()

(void)memcpy(&buf, &buf2, 30);

In this case, _memcpy_8bitCount, present in the ANSI library (string.c), replaces the
call to memcpy().

_PowOfTwo_8[val] replaces (char)1 << val if _PowOfTwo_8 is known at compile time. Similarly,
for 16-bit and for 32-bit shifts, the arrays _PowOfTwo_16 and _PowOfTwo_32 are used. These
constant arrays contain the values 1, 2, 4, 8.... They are declared in hidef.h. The compiler
performs this optimization only when optimizing for time.

Using-Oilib without arguments optimizes calls to all supported library functions.

Example
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The example code below compiles the function f with the -Oilib=a option (only available
for ICG-based backends)

void f(void) {

  char *s = strcpy(s, ct);

}

This translates in a similar fashion to the following function:

void g(void) {

  s2 = s;

  while(*s2++ = *ct++);

}

See also

-Oi: Inlining

Message C5920

7.2.3.1.67 -Ol: Try to Keep Loop Induction Variables in Registers

Group

OPTIMIZATIONS

Scope

Function

Syntax

  -Ol<number>
  
  

Arguments
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<number>: number of registers to be used for induction variables

Default

None

Defines

None

Pragmas

None

Description

This option limits the number of loop induction variables the Compiler keeps in registers.
Specify any number down to zero (no loop induction variables). The compiler reads and
writes loop induction variables within the loop (for example, loop counter), and attempts
to keep the variables in registers to reduce execution time and code size. The Compiler
takes the optimal number (code density) when this option is not specified. Specifying a
high number of loop induction variables may increase code size, particularly for spill and
merge code.

NOTE
Disable this option (with -Ol0) if problems occur while
debugging. This optimization may increase code complexity
when using High-Level Languages, making debugging more
difficult.

Listing: With the -Ol0 Option (No Optimization, Pseudo Code) and Listing: Without
Option (Optimized, Pseudo Assembler) use the example in Listing: Example (Abstract
Code).

Listing: Example (Abstract Code)

void main(char *s) {
  do {

    *s = 0;

  } while (*++s);

}

The following listing shows pseudo disassembly with the -Ol0 option:

Listing: With the -Ol0 Option (No Optimization, Pseudo Code)
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loop:
  LD  s, Reg0

  ST  #0, [Reg0]

  INC Reg0

  ST  Reg0, s

  CMP [Reg0],#0

  BNE loop

The following listing shows pseudo disassembly without the -Ol option (i.e., optimized).
Loads and stores from or to variable s disappear.

Listing: Without Option (Optimized, Pseudo Assembler)

loop:
  ST  #0, s

  INC s

  CMP s,#0

  BNE loop

Example

  -Ol1
  
  

7.2.3.1.68 -Ona: Disable Alias Checking

Group

OPTIMIZATIONS

Scope

Function

Syntax

  -Ona
  
  

Arguments

None

Default
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None

Defines

None

Pragmas

None

Description

After optimization, the Compiler redefines variables that may be written by a pointer
indirection or an array access. This option prevents the Compiler from redefining these
variables, which allows you to reuse already-loaded variables or equivalent constants.
Use this option only when you are sure no real writes of aliases to a variable memory
location will occur.

Example

Do not compile with -Ona.

  void main(void) {

  

    int a = 0, *p = &a;

  

    *p = 1; // real write by the alias *p

  

    if(a == 0) Error(); // if -Ona is specified,

  

    // Error() is called!

  

  }

  

7.2.3.1.69 -OnB: Disable Branch Optimizer

Group
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OPTIMIZATIONS

Scope

Function

Syntax

  -OnB[=<option Char>{<option Char>}]
  
  

Arguments

Use one of the following arguments for <option Char>:

a: Disable short BRA optimization

b: Disable Branch JSR to BSR optimization

d: Disable dead code optimization

l: Disable long branch optimization

r: Disable Branch to RTS optimization

t: Disable Branch tail optimization

Default

None

Defines

None

Pragmas

None

Description

See Backend for details

Example

  -OnB
  
  

Disables all branch optimizations

Seealso
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Branch Optimizations

7.2.3.1.70 -Onbf: Disable Optimize Bitfields

Group

OPTIMIZATIONS

Scope

Function

Syntax

  -Onbf
  
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description

This option prevents the Compiler from combining sequences of bitfield assignments
containing constants. This simplifies debugging and makes the code more readable.

Example
Listing: Example Bitfield Definition

struct {
  b0:1;

  b1:1;

  b2:1;

} bf;

void main(void) {
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  bf.b0 = 0;

  bf.b1 = 0;

  bf.b2 = 0;

}

Without -Onbf (pseudo intermediate code):

  BITCLR  bf, #7  // all 3 bits (the mask is 7)

  

                  // are cleared

  

With -Onbf (pseudo intermediate code):

  BITCLR  bf, #1  // clear bit 1 (mask 1)

  

  BITCLR  bf, #2  // clear bit 2 (mask 2)

  

  BITCLR  bf, #4  // clear bit 3 (mask 4)

  

Example

  -Onbf
  
  

7.2.3.1.71 -Onbt: Disable ICG Level Branch Tail Merging

Group

OPTIMIZATIONS

Scope

Function

Syntax

  -Onbt
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Arguments

None

Default

None

Defines

None

Pragmas

None

Description

This option switches the ICG level branch tail merging off. This simplifies debugging
and produces more readable code.

The example in the following listing disassembles to the following pseudocode.

Listing: Example Function

void main(void) {
  if(x > 0) {

    y = 4;

  } else {

    y = 9;

  }

}

Without -Onbt, the above example disassembles as shown in the following listing.

Listing: Case (1) Without -Onbt: (Pseudo Intermediate Code)

             CMP   x, 0
             BLE   else_label

             LOAD  reg, #4

             BRA   branch_tail

else_label:  LOAD  reg, #9

branch_tail: STORE y, reg

go_on:        ...
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With the -Obnt compiler option, Listing: Example Function listing disassembles as in the
following listing.

Listing: Case (2) with -Onbt: (Pseudo Intermediate Code)

             CMP   x, 0
             BLE   else_label

             LOAD  reg, #4

             STORE y, reg

             BRA   go_on

else_label:  LOAD  reg, #9

             STORE y, reg

go_on:       ...

Example

  -Onbt
  
  

7.2.3.1.72 -Onca: Disable any Constant Folding

Group

OPTIMIZATIONS

Scope

Function

Syntax

  -Onca
  
  

Arguments

None

Default

None

Defines

None
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Pragmas

None

Description

This option prevents the Compiler from folding constants over statement boundaries. All
arithmetical operations are coded. This option must be set when using the library
functions setjmp() and longjmp(), or the Compiler makes wrong assumptions (refer the
following listing).

Listing: Example with If Condition Always True

void main(void) {
  jmp_buf env;

  int k = 0;

  if (setjmp(env) == 0) {

    k = 1;

    longjmp(env, 0);

    Err(1);

  } else if (k != 1) {/* assumed always TRUE */

    Err(0);

  }

}

Example

  -Onca
  
  

7.2.3.1.73 -Oncn: Disable Constant Folding in Case of a New Constant

Group

OPTIMIZATIONS

Scope

Function

Syntax
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  -Oncn
  
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description

This option prevents the Compiler from folding constants when the resulting constant is
new. The option affects only those processors where constants are difficult to load (for
example, RISC processors). On other processors this option makes no change.

Listing: Example (Pseudo Code)

void main(void) {
  int a = 1, b = 2, c, d;

  c = a + b;

  d = a * b;

}

Case (1) without the -Oncn option (pseudo code):

  a MOVE  1

  

  b MOVE  2

  

  c MOVE  3

  

  d MOVE  2
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Case (2) with the -Oncn option (pseudo code):

  a MOVE  1

  

  b MOVE  2

  

  c ADD   a,b

  

  d MOVE  2

  

The constant 3 is a new constant that does not appear in the source. The constant 2 is
already present, so it is still propagated.

Example

  -Oncn
  
  

7.2.3.1.74 -OnCopyDown: Do Generate Copy Down Information for Zero
Values

Group

OPTIMIZATIONS

Scope

Compilation unit

Syntax

  -OnCopyDown
  
  

Arguments

None

Default

None
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Defines

None

Pragmas

None

Description

Startup code usually clears all global variables to zero (zero out) and copies any non-zero
initialization values to the variables (copy down). Because of this, it is not necessary to
copy zero values unless the usual startup code is modified. If a modified startup code
contains a copy down but not a zero out, use this option to prevent the compiler from
removing the initialization.

NOTE
The case of a copy down without a zero out is unusual. Because
the copy down needs much more space than the zero out, code
usually contains copy down and zero out, zero out alone, or
neither.

In the HIWARE format, the object-file format permits the Compiler to remove single
assignments in a structure or array initialization. In the ELF format, the Compiler
optimizes only when the whole array or structure is initialized with zero.

NOTE
This option controls the optimizations done in the compiler.
However, the linker might further optimize the copy down or
the zero out.

Example

  int i=0;

  

  int arr[10]={1,0,0,0,0,0,0,0,0,0};

  

Using this option, the compiler does not generate a copy down for i.

The initialization with zero optimization shown for the arr array only works in the
HIWARE format. The ELF format requires initializing the whole array to zero.

7.2.3.1.75 -OnCstVar: Disable CONST Variable by Constant Replacement
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Group

OPTIMIZATIONS

Scope

Compilation Unit

Syntax

  -OnCstVar
  
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description

This option allows you to switch OFF the replacement of CONST variable by the constant
value.

Example

  const int MyConst = 5;

  

  int i;

  

  void myfun(void) {

  

    i = MyConst;
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  }

  

Without the -OnStVar option, the compiler replaces each occurrence of MyConst with its
constant value 5; that is, i = MyConst becomes i = 5;. The Compiler optimizes the Memory
or ROM needed for the MyConst constant variable as well. Setting the -OnCstVar option
avoids this optimization. Use this option only if you want unoptimized code.

7.2.3.1.76 -One: Disable any Low Level Common Subexpression
Elimination

Group

OPTIMIZATIONS

Scope

Function

Syntax

  -One
  
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description

This option prevents the Compiler from reusing common subexpressions, such as array
indexes and array base addresses. The code size may increase. The low-level CSE does
not have the alias problems of the frontend CSE and is therefore switched on by default.

The two CSE optimizations do not cover the same cases. The low-level CSE has a finer
granularity but does not handle all cases of the frontend CSE.
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Use this option only to generate more readable code for debugging.

Listing: Example (Abstract Code)

void main(int i) {
  int a[10];

  a[i] = a[i-1];

}

Listing: Case (1) Without Option (Optimized) listing shows a case that does not use -One
and Listing: Case (2) -One (Not Optimized, Readable) shows a case that uses -One.

Listing: Case (1) Without Option (Optimized)

tmp1    LD    i
tmp2    LSL   tmp1,#1

tmp3    SUB   tmp2,#2

tmp4    ADR   a

tmp5    ADD   tmp3, tmp4

tmp6    LD    (tmp5)

2(tmp5) ST    tmp6

Listing: Case (2) -One (Not Optimized, Readable)

tmp1    LD    i
tmp2    LSL   tmp1,#1

tmp3    SUB   tmp2,#2

tmp4    ADR   a

tmp5    ADD   tmp3,tmp4

tmp6    LSL   tmp1,#1   ;calculated twice

tmp7    ADR   a         ;calculated twice

tmp8    ADD   tmp6,tmp7

tmp9    LD    (tmp5)

(tmp8)  ST    tmp9

Example

-One

7.2.3.1.77 -OnP: Disable Peephole Optimization
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Group

OPTIMIZATIONS

Scope

Function

Syntax

  -OnP[=<option Char>{<option Char>}]
  
  

Arguments

Use one of the following arguments for <option Char>:

a: Disable peephole combine AI(S|X) optimization

b: Disable peephole handle constant argument optimization

c: Disable peephole PSH/PUL instead AIS optimization

d: Disable peephole combine bit operations optimization

e: Disable peephole combine bit set/clr optimization

f: Disable peephole PSH PUL optimization

g: Disable peephole RTS RTS optimization

h: Disable peephole unused loads optimization

i: Disable peephole unused stores optimization

j: Disable peephole unused compares optimization

k: Disable peephole unnecessary tests optimization

l: Disable peephole unnecessary transfers optimization

m: Disable peephole JSR to JMP optimization

n: Disable peephole CMP #1 optimization

o: Disable peephole simple inline assembler optimizations

x: Disable peephole load immediate to HX [HCS08 only]

Default

None
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Defines

None

Pragmas

None

Description

If -OnP is specified, the Compiler disables the whole peephole optimizer. To disable only a
single peephole optimization, use the optional syntax -OnP=<char>. For example:

Suboption -OnP=m (Disable peephole JSR to JMP optimization)

The compiler replaces a JSR- RTS sequence with a single JMP instruction. This saves single-
byte code and 2-byte stack spaces. To avoid this optimization, use the -onp=m option.

With -onp=m:

    ...

  

    JSR   Subroutine

  

    RTS

  

Without -onp=m:

    ...

  

    JMP   Subroutine

  

Example

  -OnP=m
  
  

Disables the peephole optimization m
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7.2.3.1.78 -OnPMNC: Disable Code Generation for NULL Pointer to
Member Check

Group

OPTIMIZATIONS

Scope

Compilation Unit

Syntax

  -OnPMNC
  
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description

Before assigning a pointer to a member in C++, you must ensure that the pointer to the
member is not NULL in order to generate correct and safe code. In embedded systems
development, the difficulty becomes generating the denser code while avoiding overhead
whenever possible (this NULL check code is a good example). This option enables you to
switch off the code generation for the NULL check.

Example

  -OnPMNC
  
  

7.2.3.1.79 -Ont: Disable Tree Optimizer
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Group

OPTIMIZATIONS

Scope

Function

Syntax

  -Ont[={%|&|*|+|-|/|0|1|7|8|9|?|^|a|b|c|d|e| f|h|i|l|m|n|o|p|q|r|s|t|u|v|w|||~}] 
  

Arguments

%: Disable mod optimization

&: Disable bit and optimization

*: Disable mul optimization

+: Disable plus optimization

-: Disable minus optimization

/: Disable div optimization

0: Disable and optimization

1: Disable or optimization

7: Disable extend optimization

8: Disable switch optimization

9: Disable assign optimization

?: Disable test optimization

a: Disable statement optimization

b: Disable constant folding optimization

c: Disable compare optimization

d: Disable binary operation optimization

e: Disable constant swap optimization

f: Disable condition optimization

g: Disable compare size optimization

h: Disable unary minus optimization
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i: Disable address optimization

j: Disable transformations for inlining

l: Disable label optimization

m: Disable left shift optimization

n: Disable right shift optimization

o: Disable cast optimization

p: Disable cut optimization

q: Disable 16-32 compare optimization

r: Disable 16-32 relative optimization

s: Disable indirect optimization

t: Disable for optimization

u: Disable while optimization

v: Disable do optimization

w: Disable if optimization

^: Disable exor optimization

|: Disable bit or optimization

~: Disable bit neg optimization

Default

Specifying -Ont with no arguments disables all optimizations

Defines

None

Pragmas

None

Description

The Compiler contains a special optimizer which optimizes the internal tree data
structure. This tree data structure holds the semantic of the program and represents the
parsed statements and expressions.
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This option disables the tree optimizer. Use this option for debugging and to force the
Compiler to produce  straightforward° code. Note that the optimizations below are just
examples for the classes of optimizations.

Using this option with the arguments below disables the optimizations.

-Ont=~ disables optimization of  ~~i° into  i°

-Ont=| disables optimization of   i|0xffff° into   0xffff°

-Ont=w disables optimization of   if (1) i = 0;° into  i = 0;°

-Ont=v disables optimization of   do ... while(0)° into  ...°

-Ont=u disables optimization of Ìwhile (cond) break;° into Ìcond;°, provided there are no
labels within the °while° statement list.

-Ont=t disables optimization of   for(;;) ...° into   while(1) ...°

-Ont=s disables optimization of   *&i° into   i°

-Ont=r disables optimization of   L<=4° into 16-bit compares

-Ont=q disables reduction of long compares into int compares. For example:

if (uL == 0) optimizes into:

if ((int)(uL>>16) == 0 && (int)uL == 0)

-Ont=p disables optimization of   (char)(long)i° into   (char)i°

-Ont=o disables optimization of   (short)(int)L° into   (short)L° if short and int have the
same size.

-Ont=n and -Ont=m disable optimization of shift optimizations (<<, >>, -Ont=n or -Ont= m):

Reduction of shift counts to unsigned char:

uL = uL1 >> uL2; optimizes into:

uL = uL1 >> (unsigned char)uL2;

Optimization of zero shift counts:

uL = uL1 >> 0; optimizes into:

uL = uL1;

Optimization of shift counts greater than the object to be shifted:

uL = uL1 >> 40; optimizes into:

uL = 0L;
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Strength reduction for operations followed by a cut operation:

ch = uL1 * uL2; optimizes into:

ch = (char)uL1 * (char)uL2;

Replacing shift operations by load or store:

i = uL >> 16; optimizes into:

i = *(int *)(&uL);

Shift count reductions:

ch = uL >> 17; optimizes into:

ch = (*(char *)(&uL)+1)>>1;

Optimization of shift combined with binary and:

ch = (uL >> 25) & 0x10; optimizes into:

ch = ((*(char *)(&uL))>>1) & 0x10;

-Ont=l disables optimization removal of labels if not used

-Ont=i disables optimization of   &*p° into   p°

-Ont=j transforms the syntax tree into an equivalent form which allows more inlining
cases. Enable inlining to use this option.

-Ont=h disables optimization of   -(-i)° into   i°

-Ont=f disables optimization of   (a==0)° into   (!a)°

-Ont=e disables optimization of   2*i° into   i*2°

-Ont=d disables optimization of   us & ui° into   us& (unsigned short)ui°

-Ont=c disables optimization of   if ((long)i)° into   if (i)°

-Ont=b disables optimization of   3+7° into   10°

-Ont=a disables optimization of last statement in function if result is not used

-Ont=^ disables optimization of   i^0° into   i°

-Ont=? disables optimization of   i = (int)(cond ? L1:L2);° into   i = cond ? (int)L1:(int)L2;°

-Ont=9 disables optimization of   i=i;°

-Ont=8 disables optimization of empty switch statement

-Ont=7 disables optimization of   (long)(char)L° into   L°
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-Ont=1 disables optimization of   a || 0° into   a°

-Ont=0 disables optimization of   a && 1° into   a°

-Ont=/ disables optimization of   a/1° into   a°

-Ont=- disables optimization of   a-0° into   a°

-Ont=+ disables optimization of   a+0° into   a°

-Ont=* disables optimization of   a*1° into   a°

-Ont=& disables optimization of   a&0° into   0°

-Ont=% disables optimization of   a%1° into   0°

Example

  fibo.c -Ont 
  

7.2.3.1.80 -OnX: Disable Frame Pointer Optimization

Group

OPTIMIZATIONS

Scope

Function

Syntax

  -OnX
  
  

Arguments

None

Default

None

Defines

None

Pragmas
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None

Description

Using this option prevents the Compiler from converting stack pointer-relative accesses
into X-relative accesses. The frame optimizer tries to convert all SP-relative accesses
(local variables, spills) into shorter and faster X-relative accesses. In addition, the
Compiler traces the value of H:X and removes useless TSX and AIX instructions. Using -OnX
to switch the frame optimizer off facilitates debugging.

Example

  -OnX
  
  

Disables frame pointer optimizations

7.2.3.1.81 -Or: Allocate Local Variables into Registers

Group

OPTIMIZATIONS

Scope

Function

Syntax

  -Or
  
  

Arguments

None

Default

None

Defines

__OPTIMIZE_REG__

Pragmas

None
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Description

Allocate local variables ( char or int) in registers. The number of local variables allocated
in registers depends on the number of available registers. Use this option when using
variables as loop counters or switch selectors or when the processor requires register
operands for multiple operations (for example, RISC processors). Compiling with this
option may increase your code size (spill and merge code).

NOTE
This optimization may increase code complexity when using
High-Level Languages, making debugging more difficult.

NOTE
For some backends this option has no effect and code does not
change.

Listing: Allocate Local Variables into Registers Example

-Or
int main(void) {

  int a,b;

  return a + b;

}

Case (1) without option -Or (pseudo code):

tmp1 LD    a

tmp2 LD    b

tmp3 ADD   tmp1,tmp2

     RET   tmp3

Case (2)with option -Or (pseudo code):

tmp1 ADD a,b

RET tmp1

7.2.3.1.82 -Ous, -Ou, and -Onu: Optimize Dead Assignments

Group

OPTIMIZATIONS

Scope

Function
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Syntax

  -O(us|u|nu)
  
  

Arguments

us: yes, but never if HLI present in function (default)

u: always (even if HLI is present in function)

nu: never

Default

-Ous: Optimization enabled for functions containing no inline assembler code

Defines

None

Pragmas

None

Description

Optimizes dead assignments. The Compiler removes assignments to unused local
variables.

There are three possible settings for this option: -Ou is given, -Onu is given, or -Ous is
given:

-Ou: Always optimize dead assignments (even if HLI is present in current function). The
Compiler does not consider inline assembler accesses.

NOTE
This option is unsafe when inline assembler code contains
accesses to local variables.

-Onu: No optimization occurs. This generates the best possible debug information, and
produces larger and slower code.

-Ous: Optimize dead assignments if HLI is not present in the current function.

NOTE
The compiler is not aware of longjmp() or setjmp() calls. These
and similar functions may generate a control flow which the
Compiler does not recognize. Therefore, either do not use local
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variables in functions using longjmp() or setjmp() or use -Onu to
switch this optimization off.

NOTE
Dead assignments to volatile declared global objects are never
optimized.

Example

  void main(int x) {

  

    f(x);

  

    x = 1; /* this assignment is dead and is

  

              removed if -Ou is active */

  

  }

  

7.2.3.1.83 -Pe: Do Not Preprocess Escape Sequences in Strings with
Absolute DOS Paths

Group

LANGUAGE

Scope

Compilation Unit

Syntax

  -Pe
  
  

Arguments

None
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Default

None

Defines

None

Pragmas

None

Description

The Compiler handles escape sequences in macros in an include directive, similar to the
way the Compiler handles escape sequences in a printf() instruction:

  #define STRING "C:\myfile.h"

  

  #include STRING

  

produces an error:

  >> Illegal escape sequence

  

and:

  printf(STRING);

  

produces a carriage return with line feed:

  C:

  

  myfile

  

Using the -Pe option, the Compiler ignores escape sequences in strings that contain a
DOS drive letter (° a° - ° z°, ° A° - ° Z°) followed by a colon ° :° and a backslash ° \°.

Enable the -Pe option to make the Compiler handle strings in include directives
differently from other strings. Escape sequences in include directive strings are not
evaluated.
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The following example:

  #include "C:\names.h"

  

results in exactly the same include filename as in the source file (" C:\names.h"). If the
filename appears in a macro, the Compiler does not distinguish between filename usage
and normal string usage with escape sequence. This occurs because the macro STRING has
to be the same for the include and the printf() call, as shown below:

  #define STRING "C:\n.h"

  

  #include STRING /* means: "C:\n.h" *

  

  void main(void) {

  

    printf(STRING);/* means: "C:", new line and ".h" */

  

  }

  

Use this option to use macros for include files. This prevents escape sequence scanning in
strings that start with a DOS drive letter (°a - °z°, °A° - °Z°) followed by a colon ° :° and a
backslash ° \°. With the option set, the above example includes the ° C:\n.h° file and calls
printf() with "C:\n.h").

Example

  -Pe
  
  

7.2.3.1.84 -Pio: Include Files Only Once

Group

INPUT

Scope
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Compilation Unit

Syntax

  -Pio 
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description

Includes every header file only once. Whenever the compiler reaches an #include
directive, the compiler checks the named file against the files already included. If the file
has already been read, the compiler ignores the #include directive. It is common practice
to protect header files from multiple inclusion by conditional compilation, as shown
below:

  /* Header file myfile.h */

  

  #ifndef _MY_FILE_H_

  

  #define _MY_FILE_H_

  

  /* .... content .... */

  

  #endif /* _MY_FILE_H_ */
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When #ifndef and #define directives are issued, the Compiler reads header file content
only once even when the header file is included several times. This solves many
problems as C-language protocol does not allow you to define structures (such as enums
or typedefs) more than once.

Using this option to protect all header files can safely accelerate compilation.

Do not use this option when a header file must be included twice, for example, the file
contains macros which are set differently at different inclusion times. In those instances,
use #pragma ONCE: Include Once to accelerate the inclusion of safe header files which
do not contain macros of that nature.

Example

  -Pio 
  

See also

#pragma ONCE: Include Once

7.2.3.1.85 -Prod: Specify Project File at Startup

Group

STARTUP

This option cannot be specified interactively.

Scope

None

Syntax
  -Prod=<file>   

Arguments

<file>: name of a project or project directory

Default

None

Defines

None

Pragmas
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None

Description

This option can only be specified at the command line while starting the application. It
cannot be specified in any other circumstances.

Use this option to make the application open the file as a configuration file. When <file>
names a directory instead of a file, the application appends the default name project.ini.
When loading fails, a message box appears.

Example
  compiler.exe -prod=project.ini   

(Use the compiler executable name instead of "compiler".)

See also

Local Configuration File

7.2.3.1.86 -Qvtp: Qualifier for Virtual Table Pointers

Group

CODE GENERATION

Scope

Application

Syntax

  -Qvtp(none|far|near)
  
  

Arguments

None

Default

  -Qvptnone
  
  

Defines

None
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Pragmas

None

Description

Using a virtual function in C++ requires an additional pointer to virtual function tables.
The Compiler cannot access the pointer and generates the pointer in every class object
when virtual function tables are associated.

NOTE
Specifying qualifiers not supported by the Backend or CPU has
no effect (refer Backend).

Example

  -QvtpFar
  
  

This sets the qualifier for virtual table pointers to __far, which enables placement of the
virtual tables into a __FAR_SEG segment (if the Backend or CPU supports __FAR_SEG
segments).

7.2.3.1.87 -Rp (-Rpe, -Rpt): Large Return Value Type

Group

OPTIMIZATIONS

Scope

Application

Syntax

  -Rp(t|e)
  
  

Arguments

t: Pass large return value by pointer, always with temporary

e: Pass large return value by pointer and temporary elimination

Default
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  -Rpe
  
  

Defines

None

Pragmas

None

Description

The Compiler supports this option even though returning a  large° return value may not
be as efficient as using an additional pointer. The Compiler introduces an additional
parameter for the return value if the return value cannot be passed in registers.

Consider the code in the following listing.

Listing: Example Code

typedef struct { int i[10]; } S;
S F(void);

S s;

void main(void) {

  s = F();

}

In the above case, with -Rpt, the code will appear as in the following listing.

Listing: Pass Large Return Value by Pointer

void main(void) {
  S tmp;

  F(&tmp);

  s = tmp; /* struct copy */

}

The above approach is always correct but not efficient. Instead, pass the destination
address directly to the callee. This makes it unnecessary to declare a temporary and a
struct copy in the caller (i.e., -Rpe), as shown in the following listing.

Listing: Pass Large Return Value by Pointer and Temporary Elimination

void main(void) {
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  F(&s);

}

The above example may produce incorrect results for rare cases (for example, if the F()
function returns something overlapping s). Because the Compiler does not detect such
rare cases, two options are provided: the -Rpt (always correct, but inefficient), or -Rpe
(efficient) options.

7.2.3.1.88 -T: Flexible Type Management

Group

LANGUAGE.

Scope

Application

Syntax

  -T<Type Format> 
  

Arguments

<Type Format>: See below

Default

Depends on target, see Compiler Backend

Defines

To deal with different type sizes, the Compiler predefines one of the following define
groups (refer the following listing).

Listing: Define Groups

__CHAR_IS_SIGNED__ 

__CHAR_IS_UNSIGNED__

__CHAR_IS_8BIT__

__CHAR_IS_16BIT__

__CHAR_IS_32BIT__

__CHAR_IS_64BIT__
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__SHORT_IS_8BIT__

__SHORT_IS_16BIT__

__SHORT_IS_32BIT__

__SHORT_IS_64BIT__

__INT_IS_8BIT__

__INT_IS_16BIT__

__INT_IS_32BIT__

__INT_IS_64BIT__

__ENUM_IS_8BIT__

__ENUM_IS_16BIT__

__ENUM_IS_32BIT__

__ENUM_IS_64BIT__

__ENUM_IS_SIGNED__ 

__ENUM_IS_UNSIGNED__

__PLAIN_BITFIELD_IS_SIGNED__ 

__PLAIN_BITFIELD_IS_UNSIGNED__

__LONG_IS_8BIT__

__LONG_IS_16BIT__

__LONG_IS_32BIT__

__LONG_IS_64BIT__

__LONG_LONG_IS_8BIT__

__LONG_LONG_IS_16BIT__

__LONG_LONG_IS_32BIT__
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__LONG_LONG_IS_64BIT__

__FLOAT_IS_IEEE32__

__FLOAT_IS_IEEE64__

__FLOAT_IS_DSP__

__DOUBLE_IS_IEEE32__

__DOUBLE_IS_IEEE64__

__DOUBLE_IS_DSP__

__LONG_DOUBLE_IS_IEEE32__

__LONG_DOUBLE_IS_IEEE64__

__LONG_DOUBLE_IS_DSP__

__LONG_LONG_DOUBLE_IS_IEEE32__

__LONG_LONG_DOUBLE_IS_IEEE64__

__LONG_LONG_DOUBLE_DSP__

__VTAB_DELTA_IS_8BIT__

__VTAB_DELTA_IS_16BIT__

__VTAB_DELTA_IS_32BIT__

__VTAB_DELTA_IS_64BIT__

__PTRMBR_OFFSET_IS_8BIT__

__PTRMBR_OFFSET_IS_16BIT__

__PTRMBR_OFFSET_IS_32BIT__

__PTRMBR_OFFSET_IS_64BIT__

Pragmas

None

Description
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This option allows configurable type settings. The syntax of the option is: -
T{<type><format>}

NOTE
Flexible type management does not support 8-bit int
definitions. When generating code, use minimal startup code
instead of ANSI startup code.

For <type>, specify one of the keys listed in the following table.

Table 7-10. Data Type Keys

Type Key

char °c°

short °s°

int °i°

long °L°

long long °LL°

float °f°

double °d°

long double °Ld°

long long double °LLd°

enum °e°

sign plain bitfield °b°

virtual table delta size °vtd°

pointer to member offset size °pmo°

NOTE
Keys are not case-sensitive, for example, both ° f° and ° F° may
be used for the type " float".

Change the sign of type char or of the enumeration type with a prefix placed before the
key for the char key. Refer the following table.

Table 7-11. Keys for Signed and Unsigned Prefixes

Sign Prefix Key

signed °s°

unsigned °u°

Change the sign of the plain bitfield type with the options shown in the following table.
Plain bitfields are bitfields defined or declared without an explicit signed or unsigned
qualifier, for example, int field:3. Using this option, you can specify whether to handle
the int in the previous example as signed int or as unsigned int.
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NOTE
This option may not be available on all targets. Also the default
setting may vary. For more information, refer to the topic Sign
of Plain Bitfields.

Table 7-12. Keys for Signed and Unsigned Bitfield Prefixes

Sign Prefix Key

plain signed bitfield °bs°

plain unsigned bitfield °bu°

For <format>, specify one of the keys in the following table.

Table 7-13. Data Format Specifier Keys

Format Key

8-bit integral °1°

16-bit integral °2°

24-bit integral °3°

32-bit integral °4°

64-bit integral °8°

IEEE32 floating °2°

IEEE64 floating °4°

DSP (32-bit) °0°

Not all formats may be available for a target. See Backend for supported formats.

NOTE
At least one type for each basic size (1, 2, 4 bytes) must be
available. You must set a size for all types, at least equal to one.
See Backend for default settings.

NOTE
Enumeration types have the type   signed int° by default for
ANSI-C compliance.

Use the -Tpmo option to change the pointer to a member offset value type. The default
setting is 16 bits. The Compiler uses the pointer to the member offset as a C++ pointer to
members only.

-Tsc sets Ñ charÑ to Ñ signed charÑ

and -Tuc sets Ñ charÑ to Ñ unsigned charÑ

Listing: Example
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-Tsc1s2i2L4LL4f2d4Ld4LLd4e2 denotes:
  signed char with 8 bits (sc1)

  short and int with 16 bits (s2i2)

  long,long long with 32 bits (L4LL4)

  float with IEEE32 (f2)

  double, long double and long long double with IEEE64 (d4Ld4LL4)

  enum with 16 bits (signed) (e2)

Listing: Restrictions

For integrity and ANSI compliance, the following rules must be true:
  sizeof(char)        <= sizeof(short)

  sizeof(short)       <= sizeof(int)

  sizeof(int)         <= sizeof(long)

  sizeof(long)        <= sizeof(long long)

  sizeof(float)       <= sizeof(double)

  sizeof(double)      <= sizeof(long double)

  sizeof(long double) <= sizeof(long long double)

NOTE
Do not set char to 16 bits and int to 8 bits.

Change type sizes with caution. Type sizes must be consistent over the whole application.
The libraries delivered with the Compiler are compiled with the standard type settings.

Use caution when changing type sizes for under or overflows (for example, assigning a
large value to a small object), as shown in the following example:

  int i; /* -Ti1 int has been set to 8 bits! */

  

  i = 0x1234; /* i will set to 0x34! */

  

Example

Setting the size of char to 16 bits:

  -Tc2

  

Setting the size of char to 16 bits and plain char is signed:
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  -Tsc2

  

Setting char to 8 bits and unsigned, int to 32 bits and long long to 32 bits:

  -Tuc1i4LL4

  

Setting float to IEEE32 and double to IEEE64:

  -Tf2d4

  

The -Tvtd option allows you to change the delta value type inside virtual function tables.
The default setting is 16 bits.

You can also set this option using the dialog box in the Graphical User Interface.

See also

Sign of Plain Bitfields

7.2.3.1.89 -V: Prints the Compiler Version

Group

VARIOUS

Scope

None

Syntax
  -V   

Arguments

None

Default

None

Defines

None

Pragmas
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None

Description

Prints the internal subversion numbers of the Compiler component parts and the location
of current directory.

NOTE
This option can determine the current directory of the
Compiler.

Example

-V produces the following list:
  Directory: \software\sources\c

  ANSI-C Front End, V5.0.1, Date Jan 01 2005

  Tree CSE Optimizer, V5.0.1, Date Jan 01 2005

  Back End V5.0.1, Date Jan 01 2005

7.2.3.1.90 -View: Application Standard Occurrence

Group

HOST

Scope

Compilation Unit

Syntax

  -View<kind>
  
  

Arguments

<kind> is one of:

Window: Application window has default window size

Min: Application window is minimized

Max: Application window is maximized

Hidden: Application window is not visible (only if arguments)

Default
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Application started with arguments: Minimized

Application started without arguments: Window

Defines

None

Pragmas

None

Description

If used with no arguments, this option starts the application as a normal window. If used
with arguments (for example, from the maker to compile or link a file), then the
application runs minimized to allow batch processing.

Use this option to specify application behavior. Use -ViewWindow to view the application
with its normal window. Use -ViewMin to view the application as an icon in the task bar.
Use - ViewMax to maximize the application (filling the whole screen). Use -ViewHidden to
process the application arguments (for example, files to be compiled or linked)
completely in the background (no window and no icon visible in the task bar). However,
if you use the -N option, a dialog box is still possible (refer -N: Show Notification Box in
Case of Errors).

Example

  C:\Freescale\linker.exe -ViewHidden fibo.prm
  
  

7.2.3.1.91 -WErrFile: Create "err.log" Error File

Group

MESSAGES

Scope

Compilation Unit

Syntax

  -WErrFile(On|Off) 
  

Arguments
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None

Default

-WErrFileOn

Defines

None

Pragmas

None

Description

Using this option, the Compiler uses a return code to report errors back to the tools.
When errors occur, 16-bit window environments use err.log files, containing a list of
error numbers, to report the errors. If no errors occur, the 16-bit window environments
delete the err.log file. Using UNIX or WIN32, the return code makes the err.log file
unnecessary when only UNIX or WIN32 applications are involved.

NOTE
If you use a 16-bit maker with this tool, you must create the
error file to signal any errors.

Example

  -WErrFileOn 
  

This creates or deletes the err.log file when the application finishes.

  -WErrFileOff 
  

The application does not modify the existing err.log file.

See also

-WStdout: Write to Standard Output

-WOutFile: Create Error Listing File

7.2.3.1.92 -Wmsg8x3: Cut Filenames in Microsoft Format to 8.3

Group

MESSAGES
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Scope

Compilation Unit

Syntax

  -Wmsg8x3 
  

Arguments

None

Default

None

Defines

None

Pragmas

None

Description

Some editors (early versions of WinEdit) expect the filename in Microsoft message
format (8.3 format). That means the filename can have up to eight characters and no more
than a three-character extension. Longer filenames are possible when you use Win95 or
WinNT. This option truncates the filename to the 8.3 format.

Example

  x:\mysourcefile.c(3): INFORMATION C2901: Unrolling loop 

  

Setting the -Wmsg8x3 option changes the above message to:

  x:\mysource.c(3): INFORMATION C2901: Unrolling loop

  

See also

-WmsgFi (-WmsgFiv, -WmsgFim): Set Message Format for Interactive Mode

-WmsgFb (-WmsgFbv, -WmsgFbm): Set Message File Format for Batch Mode
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7.2.3.1.93 -WmsgCE: RGB Color for Error Messages

Group

MESSAGES

Scope

Function

Syntax

  -WmsgCE<
  RGB>
  
  

Arguments

<RGB>: 24-bit RGB (red/green/blue) value

Default

  -WmsgCE16711680 (rFF g00 b00, red)
  
  

Defines

None

Pragmas

None

Description

This option changes the error message color. The specified value must be an RGB (Red/
Green/Blue) value and must be specified in decimal.

Example

-WmsgCE255 changes the error messages to blue

7.2.3.1.94 -WmsgCF: RGB Color for Fatal Messages

Group

MESSAGES
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Scope

Function

Syntax

  -WmsgCF<
  RGB>
  
  

Arguments

<RGB>: 24-bit RGB (red/green/blue) value

Default

  -WmsgCF8388608 (r80 g00 b00, dark red)
  
  

Defines

None

Pragmas

None

Description

This option changes the color of a fatal message. The specified value must be an RGB
(Red/Green/Blue) value and must be specified in decimal.

Example

-WmsgCF255 changes the fatal messages to blue

7.2.3.1.95 -WmsgCI: RGB Color for Information Messages

Group

MESSAGES

Scope

Function

Syntax
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  -WmsgCI<
  RGB>
  
  

Arguments

<RGB>: 24-bit RGB (red/green/blue) value

Default

  -WmsgCI32768 (r00 g80 b00, green)
  
  

Defines

None

Pragmas

None

Description

This option changes the color of an information message. The specified value must be an
RGB (Red/Green/Blue) value and must be specified in decimal.

Example

-WmsgCI255 changes the information messages to blue

7.2.3.1.96 -WmsgCU: RGB Color for User Messages

Group

MESSAGES

Scope

Function

Syntax

  -WmsgCU<
  RGB>
  
  

Arguments

<RGB>: 24-bit RGB (red/green/blue) value

Compiler Option Details

CodeWarrior Development Studio for Microcontrollers V10.x HC(S)08 Build Tools Reference Manual, Rev.
10.6, 01/2014

312 Freescale Semiconductor, Inc.



Default

  -WmsgCU0 (r00 g00 b00, black)
  
  

Defines

None

Pragmas

None

Description

This option changes the color of a user message. The specified value must be an RGB (Red/
Green/Blue) value and must be specified in decimal.

Example

-WmsgCU255 changes the user messages to blue

7.2.3.1.97 -WmsgCW: RGB Color for Warning Messages

Group

MESSAGES

Scope

Function

Syntax

  -WmsgCW<
  RGB>
  
  

Arguments

<RGB>: 24-bit RGB (red/green/blue) value

Default

  -WmsgCW255 (r00 g00 bFF, blue)
  
  

Defines
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None

Pragmas

None

Description

This option changes the color of a warning message. The specified value must be an RGB
(Red/Green/Blue) value and must be specified in decimal.

Example

-WmsgCW0 changes the warning messages to black

7.2.3.1.98 -WmsgFb (-WmsgFbv, -WmsgFbm): Set Message File Format
for Batch Mode

Group

MESSAGES

Scope

Compilation Unit

Syntax

  -WmsgFb[v|m] 
  

Arguments

v: Verbose format

m: Microsoft format

Default

  -WmsgFbm 
  

Defines

None

Pragmas

None

Description
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Use this option to start the Compiler with additional arguments (for example, files and
Compiler options). If you start the Compiler with arguments (for example, from the Make
Tool or with the  %f° argument from the CodeWright IDE), the Compiler compiles the
files in a batch mode. No Compiler window is visible and the Compiler terminates after
job completion.

When compiling in batch mode, the Compiler writes messages to a file instead of to the
screen. This file contains only the compiler messages (refer examples below).

In batch mode, the Compiler writes messages (errors, warnings, information messages)
using a Microsoft message format.

The v argument changes the default format from the Microsoft format (only line
information) to a more verbose error format with line, column, and source information.

NOTE
Using the verbose message format may slow down the
compilation.

Example

  void myfun(void) {

  

    int i, j;

  

    for(i=0;i<1;i++);

  

  }

  

The Compiler may produce the following file if it is running in batch mode (for example,
started from the Make tool):

  X:\C.C(3): INFORMATION C2901: Unrolling loop

  

  X:\C.C(2): INFORMATION C5702: j: declared in function 
  myfun but not referenced

  

Setting the format to verbose stores more information in the file:
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  -WmsgFbv 
  

  >> in "X:\C.C", line 3, col 2, pos 33

  

    int i, j;

  

    for(i=0;i<1;i++);

  

    ^

  

  INFORMATION C2901: Unrolling loop

  

  >> in "X:\C.C", line 2, col 10, pos 28

  

  void myfun(void) {

  

    int i, j;

  

            ^

  

  INFORMATION C5702: j: declared in function myfun but not 
  referenced

  

See also

ERRORFILE: Error Filename Specification environment variable

-WmsgFi (-WmsgFiv, -WmsgFim): Set Message Format for Interactive Mode
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7.2.3.1.99 -WmsgFi (-WmsgFiv, -WmsgFim): Set Message Format for
Interactive Mode

Group

MESSAGES

Scope

Compilation Unit

Syntax

  -WmsgFi[v|m] 
  

Arguments

v: Verbose format

m: Microsoft format

Default

  -WmsgFiv 
  

Defines

None

Pragmas

None

Description

This option sets the Compiler message format to interactive mode (that is, with a visible
window) if the Compiler starts without additional arguments (for example, files and
Compiler options).

The Compiler uses the verbose error file format to write the Compiler messages (errors,
warnings, information messages).

The m argument changes the format from the default verbose format (with source, line and
column information) to the Microsoft format (only line information).

NOTE
Using the Microsoft format may increase compilation speed.

Example
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  void myfun(void) {

  

    int i, j;

  

    for(i=0;i<1;i++);

  

  }

  

The Compiler may produce the following error output in the Compiler window if it is
running in interactive mode:

  Top: X:\C.C

  

  Object File: X:\C.O

  

  >> in "X:\C.C", line 3, col 2, pos 33

  

    int i, j;

  

    for(i=0;i<1;i++);

  

    ^

  

  INFORMATION C2901: Unrolling loop

  

Setting the format to Microsoft, less information is displayed:

  -WmsgFim 
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  Top: X:\C.C

  

  Object File: X:\C.O

  

  X:\C.C(3): INFORMATION C2901: Unrolling loop

  

See also

ERRORFILE: Error Filename Specification

-WmsgFb (-WmsgFbv, -WmsgFbm): Set Message File Format for Batch Mode

7.2.3.1.100 -WmsgFob: Message Format for Batch Mode

Group

MESSAGES

Scope

Function

Syntax

  -WmsgFob<string> 
  

Arguments

<string>: format string (see below).

Default

  -WmsgFob"%"%f%e%"(%l): %K %d: %m\n" 
  

Defines

None

Pragmas

None

Description
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This option modifies the default message format in batch mode. The following table lists
supported formats (assuming that the source file is X:\Freescale\mysourcefile.cpph):

Table 7-14. Message Format Specifiers

Format Description Example

%s Source Extract

%p Path X:\Freescale\

%f Path and name X:\Freescale\mysourcefile

%n filename mysourcefile

%e Extension .cpph

%N File (8 chars) mysource

%E Extension (3 chars) .cpp

%l Line 3

%c Column 47

%o Pos 1234

%K Uppercase kind ERROR

%k Lowercase kind error

%d Number C1815

%m Message text

%% Percent %

\n New line

%" A " if the filename, if the path or the
extension contains a space

%° A ° if the filename, the path or the
extension contains a space

Example

  -WmsgFob"%f%e(%l): %k %d: %m\n"

  

Produces a message in the following format:

  X:\C.C(3): information C2901: Unrolling loop

  

See also

ERRORFILE: Error Filename Specification

-WmsgFb (-WmsgFbv, -WmsgFbm): Set Message File Format for Batch Mode

-WmsgFi (-WmsgFiv, -WmsgFim): Set Message Format for Interactive Mode

-WmsgFonp: Message Format for No Position Information
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